Tr­êng THCS NguyÔn HuÖ 

Gi¸o ¸n tin häc 7


PhÇn 1: b¶ng tÝnh ®iÖn tö

Môc tiªu

* KiÕn thøc

- BiÕt vai trß vµ c¸c chøc n¨ng chung cña ch­¬ng tr×nh b¶ng tÝnh nh­ t¹o trang tÝnh vµ thùc hiÖn c¸c tÝnh to¸n trªn trang tÝnh, t¹o biÓu ®å, s¾p xÕp vµ läc d÷ liÖu.

- BiÕt ph©n biÖt mét sè lo¹i d÷ liÖu c¬ b¶n cã thÓ xö lý ®­îc b»ng ch­¬ng tr×nh b¶ng tÝnh.

- BiÕt mét sè chøc n¨ng c¬ b¶n nhÊt cña ch­¬ng tr×nh b¶ng tÝnh Microsoft Excel.

* Kü n¨ng

- T¹o ®­îc mét trang tÝnh theo khu«n d¹ng cho tr­íc,

- Thùc hiÖn ®­îc c¸c tÝnh to¸n b»ng c«ng thøc vµ mét sè hµm th«ng dông.

- T¹o ®­îc biÓu ®å tõ d÷ liÖu trªn trang tÝnh vµ thùc hiÖn ®­îc mét sè thao t¸c chØnh söa ®¬n gi¶n víi biÓu ®å.

* Th¸i ®é

- Häc sinh nhËn thøc ®­îc ­u ®iÓm cña ch­¬ng tr×nh b¶ng tÝnh trong viÖc thùc hiÖn c¸c ch­¬ng tr×nh b¶ng tÝnh, c¸c tÝnh to¸n, rÌn luyÖn t­ duy khoa häc, tÝnh chÝnh x¸c, thËn träng trong cong viÖc. M¹nh d¹n trong t×m tßi, nghiªn cøu, tù kh¸m ph¸, häc hái.

Ngµy so¹n: 14/8









TiÕt 1

Bµi 1: Ch­¬ng tr×nh b¶ng tÝnh lµ g×?

I. Môc tiªu

1. KiÕn thøc 

- HiÓu ®­îc kh¸i niÖm b¶ng tÝnh ®iÖn tö vµ vai trß cña b¶ng tÝnh ®iÖn tö trong cuéc sèng vµ häc tËp.

- BiÕt cÊu tróc cña mét b¶ng tÝnh ®iÖn tö: dßng, cét, ®Þa chØ «…

2. Kü N¨ng

- Quan s¸t, ph©n biÖt nh÷ng lo¹i d÷ liÖu ®­îc tr×nh bµy d­íi d¹ng b¶ng tÝnh.

3. Th¸i ®é

- TËp trung cao ®é, nghiªm tóc trong giê häc.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK

2. Häc sinh: SGK, vë ghi

III. Ph­¬ng ph¸p

- ThuyÕt tr×nh, gi¶ng gi¶i, vÊn ®¸p.

IV. TiÕn tr×nh bµi gi¶ng

1. æn ®Þnh líp (1’)                              

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña gv -hs
	Néi dung

	GV: Trong thùc tÕ em thÊy nh÷ng s÷ liªu nµo ®­îc tr×nh bµy d­íi d¹ng b¶ng?

HS: Nghe c©u hái vµ tr¶ lêi.

GV: Theo em t¹i sao mét sè tr­êng hîp th«ng tin l¹i ®­îc thÓ hiÖn d­íi d¹ng b¶ng?

HS: Tr¶ lêi vµ ghi chÐp.

GV: §­a ra vÝ dô: H×nh 1 SGK – Em thÊy g×?

HS: Quan s¸t h×nh vµ tr¶ lêi.

GV: Yªu cÇu häc sinh quan s¸t h×nh 2 – 4. Em thÊy c¸ch tr×nh bµy nh­ thÕ nµo?

HS: Quan s¸t c¸c h×nh vµ tr¶ lêi.

GV: §­a ra kÕt luËn còng lµ kh¸i niÖm vÒ Ch­¬ng tr×nh b¶ng tÝnh.

HS: L¾ng nghe vµ ghi chÐp

GV: Trong ch­¬ng tr×nh líp 6 chóng ta ®· häc Word, c¸c em nhí l¹i xem mµn h×nh cña Word gån nh÷ng thµnh phÇn g×?

HS: tr¶ lêi

GV: Giíi thiÖu mµn h×nh lµm viÖc cña Excel vµ c¸c thµnh phÇn cã trªn ®ã.

HS: quan s¸t, ghi l¹i

GV: Giíi thiÖu vÒ d÷ liÖu.

HS: quan s¸t, ghi l¹i

GV: Giíi thiÖu vÒ kh¶ n¨ng tÝnh to¸n vµ sö dông hµm hµm cã s½n.

HS: quan s¸t, ghi l¹i

GV: Giíi thiÖu vÒ kh¶ n¨ng s¾p xÕp vµ läc d÷ liÖu cña ch­¬ng tr×nh.

GV: Ngoµi ra ch­¬ng tr×nh b¶ng tÝnh cßn cã kh¶ n¨ng t¹o c¸c biÓu ®å.

HS: quan s¸t SGK, ghi l¹i
	1. B¶ng tÝnh vµ nhu cÇu xö lÝ th«ng tin d¹ng b¶ng

- Th«ng tin thÓ hiÖn d­íi d¹ng b¶ng ®Ó tiÖn cho viÖc theo dâi, s¾p xÕp, tÝnh to¸n, so s¸nh…

- Ch­¬ng tr×nh b¶ng tÝnh lµ phÇn mÒm ®­îc thiÕt kÕ gióp ghi l¹i vµ tr×nh bµy th«ng tin d­íi d¹ng b¶ng, thùc hiÖn c¸c tÝnh to¸n còng nh­ x©y dùng c¸c biÓu ®å biÓu diÔn mét c¸ch trùc quan c¸c sè liÖu cã trong b¶ng

2. Ch­¬ng tr×nh b¶ng tÝnh

a) Mµn h×nh lµm viÖc

- C¸c b¶ng chän.

- C¸c thanh c«ng cô.

- C¸c nót lÖnh.

- Cöa sæ lµm viÖc chÝnh.

b) D÷ liÖu

- D÷ liÖu sè vµ d÷ liÖu v¨n b¶n.

c) Kh¶ n¨ng tÝnh to¸n vµ sö dông hµm cã s½n

- TÝnh to¸n tù ®éng.

- Tù ®éng cËp nhËt kÕt qu¶.

- C¸c hµm cã s½n.

d) S¾p xÕp vµ läc d÷ liÖu

- S¾p xÕp theo c¸c tiªu chuÈn kh¸c nhau.

- Läc riªng ®­îc c¸c nhãm d÷ liÖu theo ý muèn.

e) T¹o biÓu ®å

- Ch­¬ng tr×nh b¶ng tÝnh cã c¸c c«ng cô t¹o biÓu ®å phong phó.


4. Cñng cè (3’)
-  Nh¾c l¹i mét sè ®Æc tr­ng cña ch­¬ng tr×nh b¶ng tÝnh.

-  LÊy thªm mét vµi vÝ dô vÒ th«ng tin d­íi d¹ng b¶ng tÝnh.

- ?Nh¾c l¹i c¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña Excel.

5. H­íng dÉn vÒ nhµ (1’)
- Häc lý thuyÕt, ®äc tr­íc phÇn thùc hµnh.

V. Rót Kinh NghiÖm

………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

Ngµy so¹n: 14/8









TiÕt 2

Bµi 1: Ch­¬ng tr×nh b¶ng tÝnh lµ g×?

I - Môc tiªu

1. KiÕn thøc 

- NhËn biÕt ®­îc c¸c thµnh phÇn c¬ b¶n cña mµn h×nh trang tÝnh.

- HiÓu râ c¸c kh¸i niÖm hµng, cét, ®Þa chØ « tÝnh.

- BiÕt c¸ch nhËp, söa, xo¸ d÷ liÖu.

- BiÕt c¸ch di chuyÓn trªn trang tÝnh.

2. Kü N¨ng

- Thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- TËp trung cao ®é, nghiªm tóc trong giê häc.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, m¸y tÝnh.

2. Häc sinh:  SGK, vë ghi.

III - Ph­¬ng ph¸p

- ThuyÕt tr×nh, gi¶ng gi¶i, vÊn ®¸p.

IV - TiÕn tr×nh bµi gi¶ng

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV - Hs
	Néi dung

	GV: giíi thiÖu mµn h×nh lµm viÖc cña ch­¬ng tr×nh b¶ng tÝnh.

- ChØ ra c¸c thµnh phÇn chÝnh trªn mµn h×nh lµm viÖc: thanh c«ng thøc, c¸c b¶ng chän, trang tÝnh, « tÝnh

HS: Quan s¸t vµ ghi chÐp.

GV: Giíi thiÖu vµ h­íng dÉn häc sinh c¸c c¸ch nhËp vµ söa s÷ liÖu trªn trang tÝnh.

HS: Thùc hµnh thao t¸c trªn m¸y tÝnh

GV: Giíi thiÖu 2 c¸ch di chuyÓn trªn trang tÝnh.

H­íng dÉn häc sinh thùc hµnh c¸c thao t¸c trªn m¸y tÝnh.

HS: Thùc hµnh thao t¸c trªn m¸y tÝnh
	3. Mµn h×nh lµm viÖc cña ch­¬ng tr×nh b¶ng tÝnh

- Thanh c«ng thøc: NhËp, hiÓn thÞ d÷ liÖu hoÆc c«ng thøc trong « tÝnh.

- B¶ng chän Data: C¸c lÖnh ®Ó xö lÝ d÷ liÖu.

- Trang tÝnh: C¸c cét vµ hµng lµm nhiÖm vô chÝnh cña b¶ng tÝnh.

+ ¤ tÝnh: Vïng giao nhau gi÷a cét vµ hµng.

4. NhËp d÷ liÖu vµo trang tÝnh
a) NhËp vµ söa d÷ liÖu

- NhËp: Nh¸y chuét chän « vµ nhËp d÷ liÖu vµo tõ bµn phÝm.

- Söa: Nh¸y ®óp chuét vµo « cÇn söa vµ thùc hiÖn thao t¸c söa nh­ víi Word.

b) Di chuyÓn trªn trang tÝnh

- Sö dông c¸c phÝm mòi tªn trªn bµn phÝm.

- Sö dông chuét vµ c¸c thanh cuèn.



4. Cñng cè (3’)
- Nh¾c l¹i c¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña Excel.

5. H­íng dÉn vÒ nhµ (1’)
- Häc lý thuyÕt, chuÈn bÞ tr­íc cho bµi thùc hµnh.

V - Rót Kinh NghiÖm

………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

Ngµy so¹n:
18/8







                     TiÕt 3 


Bµi thùc hµnh 1


Lµm quen víi ch­¬ng tr×nh b¶ng tÝnh excel

I - Môc tiªu

1. KiÕn thøc 

- BiÕt khëi ®éng vµ tho¹t khái Excel.

- NhËn biÕt c¸c «, hµng, cét trªn trang tÝnh Excel.

2. Kü N¨ng

- Thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- Tù chñ trong häc tËp, ho¹t ®éng hiÖu qu¶ theo nhãm.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, sgk, phßng m¸y tÝnh.

2. Häc sinh:  s¸ch gi¸o khoa.

III - Ph­¬ng ph¸p

- Ho¹t ®éng nhãm, ho¹t ®éng c¸ nh©n.

IV - TiÕn tr×nh bµi gi¶ng

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5')

 - Ch­¬ng tr×nh b¶ng tÝnh lµ g×? §Æc ®iÓm?

3. Bµi gi¶ng míi (35')

	Ho¹t ®éng cña gv - hs
	Néi dung

	GV: Yªu cÇu häc sinh khëi ®éng m¸y, më ch­¬ng tr×nh Excel.

- H­íng dÉn häc sinh c¸c c¸ch khëi ®éng Excel.

HS: Khëi ®éng m¸y tÝnh c¸ nh©n.

- Lµm theo h­íng dÉn, khëi ®éng Excel.

GV: §Ó l­u kÕt qu¶ trªn Word ta lµm ntn? -> C¸ch l­u kÕt qu¶ trªn Excel t­¬ng tù.

HS: Ghi chÐp vµ thùc hµnh trªn m¸y tÝnh.


	1. Khëi ®éng, l­u kÕt qu¶ vµ tho¸t khái Excel

a) Khëi ®éng

- C1: Start -> Program -> Microsoft Excel.

- C2: Nh¸y ®óp vµo biÓu t­îng cña Excel trªn mµn h×nh nÒn.

b) L­u kÕt qu¶

- C1: File -> Save

- C2: Nh¸y chuét vµo biÓu t­îng Save trªn thanh c«ng cô.

c) Tho¸t khái Excel

- C1: Nh¸y chuét vµo nót « vu«ng (g¹ch chÐo ë gi÷a).

- C2: File -> Exit



4. Cñng cè (3')
- NhËn xÐt giê thùc hµnh theo tõng nhãm, cho ®iÓm mét sè nhãm.

5. H­íng dÉn vÒ nhµ (1')
- §äc tr­íc chuÈn bÞ cho bµi thùc hµnh tiÕp

V - Rót Kinh NghiÖm

………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

Ngµy so¹n:
18/8







                     TiÕt 4 

Bµi thùc hµnh 1

Lµm quen víi ch­¬ng tr×nh b¶ng tÝnh excel

I - Môc tiªu

1. KiÕn thøc 

- BiÕt khëi ®éng vµ tho¹t khái Excel.

- NhËn biÕt c¸c «, hµng, cét trªn trang tÝnh Excel.

2. Kü N¨ng

- Thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- Tù chñ trong häc tËp, ho¹t ®éng hiÖu qu¶ theo nhãm.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, sgk, phßng m¸y tÝnh.

2. Häc sinh:  s¸ch gi¸o khoa.

III - Ph­¬ng ph¸p

- Ho¹t ®éng nhãm, ho¹t ®éng c¸ nh©n.

IV - TiÕn tr×nh bµi gi¶ng

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5')

 C¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña Excel.

3. Bµi gi¶ng míi (35')

	Ho¹t ®éng cña gv - hs
	Néi dung

	GV: Ra bµi tËp yªu cÇu häc sinh lµm trªn m¸y.

HS: NhËn bµi vµ thùc hµnh
	2. Bµi tËp 

a) Bµi tËp 1:  Khëi ®éng Excel

-  LiÖt kª c¸c ®iÓm gièng vµ kh¸c nhau gi÷a mµn h×nh Word vµ Excel.

-  Më c¸c b¶ng chän vµ quan s¸t c¸c lÖnh trong c¸c b¶ng chän ®ã.

-  KÝch ho¹t mét « tÝnh vµ thùc hiÖn di chuyÓn trªn trang tÝnh b»ng chuét vµ bµn phÝm. Quan s¸t sù thay ®æi c¸c nót tªn hµng vµ tªn cét. 


4. Cñng cè (3')
- NhËn xÐt giê thùc hµnh theo tõng nhãm, cho ®iÓm mét sè nhãm.

5. H­íng dÉn vÒ nhµ (1')
- §äc tr­íc chuÈn bÞ cho bµi thùc hµnh tiÕp

V - Rót Kinh NghiÖm

Ngµy so¹n: 4/9






                     

TiÕt 5

bµi 2: c¸c thµnh phÇn chÝnh

vµ d÷ liÖu trªn trang tÝnh

I - Môc tiªu

1. KiÕn thøc 

- BiÕt c¸c thµnh phÇn chÝnh cña trang tÝnh.

- HiÓu ®­îc vai trß cña thanh c«ng thøc.

-  BiÕt ®­îc c¸c ®èi t­îng trªn trang tÝnh.

- HiÓu ®­îc d÷ liÖu sè vµ d÷ liÖu kÝ tù.

2. Kü N¨ng

- Thµnh th¹o c¸ch chän mét trang tÝnh, mét «, mét khèi.

3. Th¸i ®é

- TËp trung, quan s¸t tèt.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, Gi¸o ¸n, 

2. Häc sinh: SGK, vë ghi, 

III - Ph­¬ng ph¸p

- ThuyÕt tr×nh, minh ho¹, diÔn gi¶i…

IV - TiÕn tr×nh bµi gi¶ng

1. æn ®Þnh líp (1’)

2.  KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	ho¹t ®éng cña GV-HS
	néi dung

	GV: Giíi thiÖu vÒ b¶ng tÝnh, c¸c trang tÝnh trong b¶ng tÝnh vµ khi nµo th× mét trang tÝnh lµ ®ang ®­îc kÝch ho¹t.

HS: Quan s¸t vµ ghi chÐp néi dung.

GV: Giíi thiÖu c¸c thµnh phÇn chÝnh trªn mét trang tÝnh: ¤, khèi, cét, hµng, thanh c«ng thøc…

HS : Ghi chÐp.

-  Gi¶i thÝch chøc n¨ng cña tõng thµnh phÇn.


	1. B¶ng tÝnh

-  Mét b¶ng tÝnh gåm nhiÒu trang tÝnh.

-  Trang tÝnh ®­îc kÝch ho¹t cã nh·n mµu tr¾ng, tªn viÕt b»ng ch÷ ®Ëm.

-  §Ó kÝch ho¹t mét trang tÝnh ta nh¸y chuét vµo tªn trang t­¬ng øng.

2. C¸c thµnh phÇn chÝnh trªn trang tÝnh

-  Mét trang tÝnh gåm cã c¸c hµng, c¸c cét, c¸c « tÝnh ngoµi ra cßn cã Hép tªn, Khèi «, Thanh c«ng thøc…

+ Hép tªn: ¤ ë gãc trªn, bªn tr¸i trang tÝnh, hiÓn thÞ ®Þa chØ « ®­îc chän.

+ Khèi: C¸c « liÒn kÒ nhau t¹o thµnh h×nh ch÷ nhËt.

+ Thanh c«ng thøc: Cho biÕt néi dung « ®ang ®­îc chän.



4. Cñng cè (3’)
- Nh¾c l¹i c¸c thao t¸c ®· häc.

-  Hai lo¹i d÷ liÖu c¬ b¶n trong trang tÝnh.

5. H­íng dÉn vÒ nhµ (1’)
- Tr¶ lêi c©u hái trong SGK.

-  ChuÈn bÞ cho bµi thùc hµnh sè 2.

V - Rót Kinh NghiÖm

..................................................................................................................................................................................................................................................................................................................................................................................................................

Ngµy so¹n:  4/9                                                                                                                                                  TiÕt  6

bµi 2: c¸c thµnh phÇn chÝnh

vµ d÷ liÖu trªn trang tÝnh

I - Môc tiªu

1. KiÕn thøc 

- BiÕt c¸c thµnh phÇn chÝnh cña trang tÝnh.

- HiÓu ®­îc vai trß cña thanh c«ng thøc.

-  BiÕt ®­îc c¸c ®èi t­îng trªn trang tÝnh.

- HiÓu ®­îc d÷ liÖu sè vµ d÷ liÖu kÝ tù.

2. Kü N¨ng

- Thµnh th¹o c¸ch chän mét trang tÝnh, mét «, mét khèi.

3. Th¸i ®é

- TËp trung, quan s¸t tèt.

II. ChuÈn bÞ

1. Gi¸o viªn: S¸ch gi¸o khoa, Gi¸o ¸n, PhÊn, B¶ng...

2. Häc sinh: KiÕn thøc, s¸ch gi¸o khoa, vë ghi, bót..

III - Ph­¬ng ph¸p

- ThuyÕt tr×nh, minh ho¹, diÔn gi¶i

IV - TiÕn tr×nh bµi gi¶ng

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña gv- hs
	Néi dung

	GV: Giíi thiÖu vµ h­íng dÉn häc sinh c¸c thao t¸c ®Ó chän c¸c ®èi t­îng trªn mét trang tÝnh.

HS : Quan s¸t vµ ghi chÐp.

GV: Tr×nh bµy vÒ c¸c d÷ liÖu mµ ch­¬ng tr×nh b¶ng tÝnh cã thÓ xö lÝ ®­îc.

HS: Quan s¸t vµ ghi chÐp


	3. Chän c¸c ®èi t­îng trªn trang tÝnh

- Chän mét «: §­a chuét tíi « ®ã vµ nh¸y chuét.

- Chän mét hµng: Nh¸y chuét t¹i nót tªn hµng.

- Chän mét cét: Nh¸y chuét t¹i nót tªn cét.

- Chän mét khèi: KÐo th¶ chuét tõ mét « gãc ®Õn « gãc ®èi diÖn.

4. D÷ liÖu trªn trang tÝnh

a) D÷ liÖu sè

- C¸c sè : 0, 1, 2, 3..., 9, +1, -6...

- NgÇm ®Þnh : D÷ liÖu sè ®­îc c¨n th¼ng lÒ ph¶i trong « tÝnh.

b) D÷ liÖu kÝ tù

-  C¸c ch÷ c¸i.

-  C¸c ch÷ sè.

-  C¸c kÝ hiÖu.

- NgÇm ®Þnh: D÷ liÖu sè ®­îc c¨n th¼ng lÒ ph¶i trong « tÝnh.


4. Cñng cè (3’)
- Nh¾c l¹i c¸c thao t¸c ®· häc.

-  Hai lo¹i d÷ liÖu c¬ b¶n trong trang tÝnh.

5. H­íng dÉn vÒ nhµ (1’)
- Häc bµi cò

-  ChuÈn bÞ cho bµi thùc hµnh sè 2.

v. RótKinhNghiÖm

..................................................................................................................................................................................................................................................................................................................................................................................................................

Ngµy so¹n:  8/9









TiÕt 7                   

Bµi thùc hµnh sè 2

lµm quen víi c¸c kiÓu d÷ liÖu trªn trang tÝnh

I - Môc tiªu

1. KiÕn thøc 

- Ph©n biÖt ®­îc b¶ng tÝnh, trang tÝnh vµ c¸c thµnh phÇn trªn trang tÝnh.

- Chän c¸c ®èi t­îng trªnt rang tÝnh.

- Më vµ l­u b¶ng tÝnh trªn m¸y tÝnh.

2. Kü N¨ng

- Thµnh th¹o thao t¸c chän mét trang tÝnh, më vµ l­u trang tÝnh, chän c¸c ®èi t­îng

trªn trang tÝnh.

3. Th¸i ®é

- Tù gi¸c, ham häc hái.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y tÝnh.

2. Häc sinh: KiÕn thøc, s¸ch gi¸o khoa.

III - Ph­¬ng ph¸p

- Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

IV - TiÕn tr×nh giê d¹y - gi¸o dôc

1 - æn ®Þnh líp (1’)

2 - KiÓm tra bµi cò 

3 - Bµi gi¶ng míi (40’)
	H§ cña GV
	Ghi b¶ng

	GV: Yªu cÇu häc sinh nh¾c l¹i c¸c thao t¸c ®Ó më mét b¶ng tÝnh.

HS: Thùc hiÖn theo yªu cÇu

GV: Em cã thÓ më mét b¶ng tÝnh míi hoÆc b¶ng tÝnh ®· l­u trªn m¸y.

-  H­íng dÉn häc sinh thao t¸c trªn m¸y tÝnh.

HS: Nghe h­íng dÉn vµ lµm theo.

GV: Giíi thiÖu c¸ch l­u l¹i trang tÝnh víi mét tªn kh¸c mµ vÉn cßn trang tÝhn ban ®Çu.

HS: Quan s¸t thao t¸c vµ lµm theo.


	1. Më vµ l­u b¶ng tÝnh víi mét tªn kh¸c

a) Më mét b¶ng tÝnh

-  Më b¶ng tÝnh míi:

Nh¸y nót lÖnh New trªn thanh c«ng cô trong ch­¬ng tr×nh b¶ng tÝnh.

-  Më b¶ng tÝnh ®· l­u:

Më th­ môc chøa tÖp vµ nh¸y ®óp chuét trªn biÓu t­îng cña tÖp.

b) L­u b¶ng tÝnh víi mét tªn kh¸c

Ta cã thÓ l­u mét b¶ng tÝnh ®· ®­îc l­u tr­íc ®ã víi mét tªn kh¸c mµ kh«ng mÊt ®i b¶ng tÝnh ban ®Çu:

-  File - > Save as



4 - Cñng cè (3’)
- Nh¾c l¹i c¸c thao t¸c ®· häc.

5 - H­íng dÉn vÒ nhµ (1’)
- Thùc hµnh l¹i c¸c thao t¸c nÕu cã ®iÒu kiÖn.

V - Rót Kinh NghiÖm

.......................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................................

Ngµy so¹n:  8/9









TiÕt  8                   

Bµi thùc hµnh sè 2

lµm quen víi c¸c kiÓu d÷ liÖu trªn trang tÝnh

I - Môc tiªu

1. KiÕn thøc 

- Ph©n biÖt ®­îc b¶ng tÝnh, trang tÝnh vµ c¸c thµnh phÇn trªn trang tÝnh.

- Chän c¸c ®èi t­îng trªnt rang tÝnh.

- Më vµ l­u b¶ng tÝnh trªn m¸y tÝnh.

2. Kü N¨ng

- Thµnh th¹o thao t¸c chän mét trang tÝnh, më vµ l­u trang tÝnh, chän c¸c ®èi t­îng

trªn trang tÝnh.

3. Th¸i ®é

- Tù gi¸c, ham häc hái.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y tÝnh.

2. Häc sinh: KiÕn thøc, s¸ch gi¸o khoa.

III - Ph­¬ng ph¸p

- Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

IV - TiÕn tr×nh giê d¹y - gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò 

3. Bµi gi¶ng míi (40’) 

	Ho¹t ®éng cña GV-hs
	Néi dung

	GV: Cñng cè l¹i mét sè thao t¸c vµ giao bµi tËp cho häc sinh.

BT1. T×m hiÓu c¸c thµnh phÇn chÝnh cña trang tÝnh.

HS: Chó ý l¾ng nghe h­íng dÉn cña gi¸o viªn vµ lµm bµi thùc hµnh.

GV: H­íng dÉn häc sinh c¸ch thùc hµnh víi c¸c bµi tËp cßn l¹i trong SGK.

HS: Chó ý l¾ng nghe h­íng dÉn cña gi¸o viªn vµ lµm bµi thùc hµnh.


	2. Bµi tËp

a) Bµi tËp 1

-  Khëi ®éng Excel, nhËn biÕt c¸c thµnhphÇn chÝnh.

-  KÝch ho¹t c¸c « kh¸c nhau, quan s¸t sù thay ®æi néi dung trong «.

-  NhËp d÷ liÖu vµo «, quan s¸t sù thay ®æi néi dung trªn thanh c«ng thøc.

-  Gâ = 5 + 7 vµ 1 « vµ nhÊn Enter. Chän l¹i « ®ã vµ so s¸nh näi dung d÷ liÖu trong « ®ã vµ trªn thanh c«ng thøc.

b) Bµi tËp 2

Chän c¸c ®èi t­îng trªn trang tÝnh.

SGK trang 20.

c) Bµi tËp 3

Më b¶ng tÝnh

SGK trang 21

d) Bµi tËp 4

NhËp d÷ liÖu vµo trang tÝnh

SGK trang 21.


4. Cñng cè (3’)
- Nh¾c l¹i c¸c thao t¸c ®· häc.

5. H­íng dÉn vÒ nhµ (1’)
- Thùc hµnh l¹i c¸c thao t¸c nÕu cã ®iÒu kiÖn.

V - Rót Kinh NghiÖm

..................................................................................................................................................................................................................................................................................................................................................................................................................

PhÇn 2: phÇn mÒm häc tËp

môc tiªu

* KiÕn thøc 

- Häc sinh hiÓu vµ biÕt c¸ch thùc hµnh víi c¸c phÇn mÒm häc tËp.

-  Häc sinh hiÓu ®­îc ý nghÜa cña c¸c phÇn mÒm m¸y tÝnh øng dông trong c¸c lÜnh vùc kh¸c nhau.

* Kü N¨ng

- Häc sinh cã kü n¨ng sö dông vµ khai th¸c c¸c phÇn mÒm häc tËp.

-RÌn kh¶ n¨ng thao t¸c nhanh víi vµn phÝm vµ chuét m¸y tÝnh.

* Th¸i ®é

- ý thøc trong viÖc sö dông m¸y tÝnh ®ung môc ®Ých.

*****

Ngµy so¹n:15/9








           TiÕt 9 

luyÖn gâ bµn phÝm b»ng Typing test

I - Môc tiªu

1. KiÕn thøc 

- Häc sinh hiÓu c«ng dông vµ ý nghÜa cña phÇn mÒm.

- Tù khëi ®éng, më ®­îc c¸c bµi vµ ch¬i trß ch¬i.

- Thao t¸c tho¸t khái phÇn mÒm.

2. Kü N¨ng

- Thµnh th¹o thao t¸c gâ phÝm nhanh, thuéc bµn phÝm.

3. Th¸i ®é

- Tù gi¸c, ham häc hái.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: KiÕn thøc, s¸ch gi¸o khoa.

III - Ph­¬ng ph¸p

- Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

IV - TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40')

	Ho¹t ®éng cña gv-hs
	Néi dung

	GV: giíi thiÖu phÇn mÒm. HS: nghe, quan s¸t

GV: Nªu nh÷ng thuËn lîi vµ khã kh¨n trong viÖc häc gâ 10 ngãn víi phÇn mÒm

GV: Gi¶i ®¸p vµ chØ cho häc sinh thÊy thÕ nµo lµ ch¬i mµ häc.

GV: h·y nªu c¸ch khëi ®éng cña phÇn mÒm Typing Test.

HS: tr¶ lêi.

GV: h­íng dÉn c¸ch khëi ®éng.

HS: Quan s¸t, thùc hµnh, ghi chÐp

GV: H­íng dÉn c¸c thao t¸c khi vµo ch¬i.

- Giíi thiÖu 4 trß ch¬i: §¸m m©y, Bong bãng, Gâ tõ nhanh vµ B¶ng ch÷ c¸i.

GV: Giíi thiÖu c¸ch vµo trß ch¬i Bubbles.

HS: Quan s¸t vµ ghi chÐp. 

GV: Gi¶i thÝch c¸c tõ TiÕng Anh trong trß ch¬i.
	1. Giíi thiÖu phÇn mÒm

- Lµ phÇn mÒm dïng ®Ó luyÖn gâ 10 ngãn th«ng qua mét sè trß ch¬i ®¬n gi¶n nh­ng rÊt hÊp dÉn.

2. Khëi ®éng

C1: Nh¸y ®óp chuét vµo biÓu t­îng cña Typing Test trªn mµn h×nh nÒn.

C2: Start -> Prorgam -> Fre Typing Test.

-  Gâ tªn vµo « Enter your name -> Next.

-  Warm up games ®Ó vµo cöa sæ c¸c trß ch¬i.

-  §Ó b¾t ®Çu ch¬i mét trß ch¬i ta chän chß tr¬i ®ã vµ nh¸y chuét vµo nót >

3. Trß ch¬i Bubbles

-  Gâ chÝnh x¸c c¸c ch÷ c¸i cã trong bong bãng bät khÝ næi tõ d­íi lªn.

-  Bät khÝ chuyÓn ®éng dÇn lªn trªn, gâ ®óng th× míi ®­îc ®iÓm.

-  Score: §iÓm sè cña em, Missed: sè ch÷ ®· bá qua (kh«ng gâ kÞp).



4. Cñng cè (4')
- Nh¾c l¹i c¸c thao t¸c, c¸ch vµo vµ c¸ch ch¬i bèn trß ch¬i.

5. H­íng dÉn vÒ nhµ 
V - Rót Kinh NghiÖm

.................................................................................................................................................................................................................................................................

...........................................................................................................................................................................................

Ngµy so¹n:15/9








         TiÕt 10 

luyÖn gâ bµn phÝm b»ng Typing test

I - Môc tiªu

1. KiÕn thøc 

- Häc sinh hiÓu c«ng dông vµ ý nghÜa cña phÇn mÒm.

- Tù khëi ®éng, më ®­îc c¸c bµi vµ ch¬i trß ch¬i.

- Thao t¸c tho¸t khái phÇn mÒm.

2. Kü N¨ng

- Thµnh th¹o thao t¸c gâ phÝm nhanh, thuéc bµn phÝm.

3. Th¸i ®é

- Tù gi¸c, ham häc hái.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: KiÕn thøc, s¸ch gi¸o khoa.

III - Ph­¬ng ph¸p

- Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

IV - TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40')

	HO¹T §éNG  CñA GV - HS
	NéI  DUNG

	GV: Giíi thiÖu c¸ch vµo trß ch¬i ABC.

-  H­íng dÉn c¸c thao t¸c ch¬i.

HS: quan s¸t, thùc hµnh

GV : Giíi thiÖu trß ch¬i Clouds.

-  H­íng dÉn ho¹t ®éng cña trß ch¬i vµ c¸c thao t¸c ch¬i.

GV : Giíi thiÖu trß ch¬i Wordtris

GV: Giíi thiÖu c¸c ch÷ TA cã trong trß ch¬i.

GV: Giíi thiÖu c¸ch vµo trß ch¬i.

-  ChØ dÉn c¸ch ch¬i.
	4. Trß ch¬i ABC
-  C¸ch vµo trß ch¬i t­¬ng tù nh­ trß Bubbles.

-  Gâ c¸c kÝ tù xuÊt hiÖn trong vßng cung, b¾t ®Çu tõ kÝ tù cã mµu s¸ng.

5. Trß ch¬i Clouds (®¸m m©y)

-  Trªn mµn h×nh xuÊt hiÖn c¸c ®¸m m©y, chóng chuyÓn ®éng tõ ph¶i sang tr¸i. Cã 1 ®¸m m©y ®ãng khung, ®ã lµ vÞ trÝ lµm viÖc hiÖn thêi.

-  Khi cã ch÷ xuÊt hiÖn t¹i vÞ trÝ ®¸m m©y ®ãng khung, ta gâ ch÷, nÕu gâ ch÷ ®óng th× ®¸m m©y biÕn mÊt vµ ta ®­îc ®iÓm.

-  Khi gâ sai ch÷ trong ®¸m m©y, muèn quai l¹i ®¸m m©y ta dïng phÝm Backspace.

-  Score: §iÓm cña trß ch¬i, Missed: Sè tõ bÞ bá qua.

6. Trß ch¬i Wordtris (gâ tõ nhanh)

-  Gâ ®óng tõ xuÊt hiÖn trªn thanh gç, gâ xong Ên phÝm Space.

-  NÕu gâ ®óng thanh gç biÕt mÊt, nÕu gâ sai hoÆc chËm thanh gç r¬i xuèng.



4. Cñng cè (4')
- Nh¾c l¹i c¸c thao t¸c, c¸ch vµo vµ c¸ch ch¬i bèn trß ch¬i.

5. H­íng dÉn vÒ nhµ 
V - Rót Kinh NghiÖm

.................................................................................................................................................................................................................................................................

Ngµy so¹n:  29/9








               TiÕt 11

luyÖn gâ bµn phÝm b»ng Typing test

I - Môc tiªu

1. KiÕn thøc 

-  BiÕt c¸ch khëi ®éng vµ ra khái phÇn mÒm Fre Typing Test.

-  BiÕt ®­îc ý nghÜa, c«ng dông cña c¸c trß ch¬i trong Fre Typing Test.

2. Kü N¨ng

-  BiÕt sö dông ch­¬ng tr×nh phÇn mÒm.

-  BiÕt c¸ch lùa chän ch­¬ng tr×nh phï hîp tõ dÔ ®Õn khã.

3. Th¸i ®é

- H×nh thµnh tÝnh kiªn nhÉn, chÞu khã ë c¸c em.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: KiÕn thøc.

III - Ph­¬ng ph¸p

- Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

IV - TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh 

2. KiÓm tra bµi cò 




3. Bµi míi 

	Ho¹t ®éng cña gv- hs
	Néi dung

	GV: Yªu cÇu häc sinh bËt m¸y tÝnh sau ®ã khëi ®éng phÇn mÒm Free Typing Test b»ng 2 c¸ch.

-  Khi xuÊt hiÖn mµn h×nh ®¨ng nhËp h­íng dÉn häc sinh nhËp tªn cña m×nh vµo vµ c¸c thao t¸c tiÕp theo.

HS: Thùc hiÖn theo yªu cÇu cña gi¸o viªn.

GV: L­u ý cho häc sinh.

GV: yªu cÇu häc sinh vµo trß ch¬i vµ nh¾c l¹i c¸ch ch¬i. 

HS: Thùc hiÖn theo yªu cÇu cña gi¸o viªn.

GV: H­íng dÉn häc sinh c¸ch chän kiÓu hiÖn d·y ký tù trong môc With Keys.


	1. Trß ch¬i Bubbles

-  NhËp tªn cña m×nh vµo « I am a new user (tªn kh«ng cã dÊu).

-  Nh¸y Next, chän Warm up Games chän trß ch¬i Bubbles.

* Chó ý: 
Cè g¾ng gâ hÕt nh÷ng bong bãng cã mµu s¾c chuyÓn ®éng nhanh. NÕu bá qua 6 bong bãng th× trß ch¬i kÕt thóc vµ xem kÕt qu¶.

2. Trß ch¬i b¶ng ch÷ c¸i ABC
-  Gâ c¸c kÝ tù xuÊt hiÖn trong vßng cung, b¾t ®Çu tõ kÝ tù cã mµu s¸ng.

*  Chó ý: Ph©n biÖt ch÷ hoa vµ ch÷ th­êng.

-  Ch¬i sau 5 phót trß ch¬i kÕt thóc vµ xem diÓm t¹i môc Score.





4. Cñng cè 
- NhËn xÐt giê thùc hµnh cña häc sinh vµ ý thøc lµm bµi cña tõng m¸y.

5. H­íng dÉn vÒ nhµ 

- Xem  l¹i c¸c thao t¸c ®· thùc hiÖn

- Xem tr­íc bµi cho giê sau

V - Rót Kinh NghiÖm

……………………………………………………………………………………….……………………………………………………………………………………….……………………………………………………………………………………….
Ngµy so¹n:  29/9








               TiÕt 12

luyÖn gâ bµn phÝm b»ng Typing test

I - Môc tiªu

1. KiÕn thøc 

-  BiÕt c¸ch khëi ®éng vµ ra khái phÇn mÒm Fre Typing Test.

-  BiÕt ®­îc ý nghÜa, c«ng dông cña c¸c trß ch¬i trong Fre Typing Test.

2. Kü N¨ng

-  BiÕt sö dông ch­¬ng tr×nh phÇn mÒm.

-  BiÕt c¸ch lùa chän ch­¬ng tr×nh phï hîp tõ dÔ ®Õn khã.

3. Th¸i ®é

- H×nh thµnh tÝnh kiªn nhÉn, chÞu khã ë c¸c em.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: KiÕn thøc.

III - Ph­¬ng ph¸p

- Thùc hµnh trùc tiÕp trªn m¸y tÝnh.

IV - TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò 




3. Bµi míi (40')

	Ho¹t ®éng cña gv- hs
	Néi dung

	GV: Yªu cÇu häc sinh vµo trß ch¬i Clouds vµ nh¾c l¹i c¸ch ch¬i. 

HS : Thùc hiÖn thao t¸c vµ tr¶ lêi.

GV: H­íng dÉn l¹i c¸ch ch¬i.

GV: Yªu cÇu häc sinh vµo trß ch¬i Wordtris vµ nh¾c l¹i c¸ch ch¬i. 

HS: Thùc hiÖn theo yªu cÇu cña gi¸o viªn.

GV: H­íng dÉn l¹i c¸ch ch¬i.
	3. Trß ch¬i Clouds

-  Khi gâ xong mét tõ dïng Enter hoÆc Space ®Ó chuyÓn sang ®·m m©y kh¸c.

-  C¸c ®·m m©y h×nh mÆt trêi sÏ cã ®iÓm sè cao h¬n.

-  NÕu bá qua 6 ®¸m m©y th× trß ch¬i kÕt thóc.

-  Xem ®iÓm ë môc Score.

4. Trß ch¬i Wordtris

- Gâ nhanh, chÝnh x¸c c¸c tõ cã trong thanh gç.

- Gâ xong mét tõ cÇn nhÊn phÝm Space ®Ó chuyÓn sang tõ tiÕp theo.

-  Xem ®iÓm t¹i môc Score.


4. Cñng cè (3')
- NhËn xÐt giê thùc hµnh cña häc sinh vµ ý thøc lµm bµi cña tõng m¸y.

5. H­íng dÉn vÒ nhµ (1')

- Xem  l¹i c¸c thao t¸c ®· thùc hiÖn

- Xem tr­íc bµi cho giê sau

V - Rót Kinh NghiÖm

………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

Ngµy  so¹n:
   5/10                                                                                                                                            TiÕt 13 

Bµi 3: Thùc hiÖn tÝnh to¸n trªn trang tÝnh

I - Môc tiªu

1. KiÕn thøc 

- Cung cÊp cho HS c¸ch ®Æt c¸c phÐp tÝnh ®¬n gi¶n trªn b¶ng tÝnh.

- HS hiÓu kh¸i niÖm «, Khèi «, ®Þa chØ «.

2. Kü N¨ng

- HS biÕt sö dông c¸c phÐp tÝnh céng, trõ, nh©n, chia, n©ng lªn luü thõa, phÇn tr¨m trong tÝnh to¸n trªn b¶ng EXEL ®¬n gi¶n.

- HS biÕt c¸ch nhËp c«ng thøc trong « tÝnh.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, Phßng m¸y.

2. Häc sinh: SGK, vë ghi

III - Ph­¬ng ph¸p

-  ThuyÕt tr×nh, vÊn đ¸p, thùc hµnh.

IV - TiÕn tr×nh giê d¹y - gi¸o dôc

1. æn ®Þnh(1')

2. KiÓm tra bµi cò(5') 

3. Bµi míi (35')

	H§ cña GV - HS
	néi dung

	H§ 1: C¸ch nhËp vµ sö dông c«ng thøc tÝnh to¸n (35')

GV: Ch­¬ng tr×nh b¶ng tÝnh cã kh¶ n¨ng rÊt ­u viÖt ®ã lµ tÝnh to¸n.

- Trong b¶ng tÝnh ta cã thÓ dïng c¸c c«ng thøc ®Ó thùc hiÖn c¸c phÐp tÝnh.

HS: Nghe, quan s¸t GV lµm mÉu vµ ghi chÐp

GV: LÊy VD: 3 + 5

GV: Giíi thiÖu c¸c phÐp to¸n. Mçi phÐp to¸n GV lÊy 1 VD vµ l­u ý cho HS c¸c ký hiÖu phÐp to¸n.

+ VÞ trÝ cña c¸c phÐp to¸n trªn bµn phÝm.

GV: LÊy VD: {(12 + 5)-8}*2

GV: Yªu cÇu HS quan s¸t H22 trong SGK.

HS: quan s¸t H22 SGK vµ quan s¸t trªn b¶ng

GV: Yªu cÇu HS thùc hµnh:

+ Më m¸y

+ Ch¹y ch­¬ng tr×nh EXCEL

+ Më 1 File míi

+ Gâ C«ng thøc sau:

(40 - 12)/ 7+ ( 58+24)*6

GV: KiÓm tra c¸c b­íc thùc hiÖn trªn m¸y cña HS

GV: §­a ra chó ý cho HS:

NÕu chän 1 « kh«ng cã c«ng thøc vµ quan s¸t Thanh c«ng thøc, em sÏ thÊy néi dung trªn thanh c«ng thøc gièng víi d÷ liÖu trong «. Tuy nhiªn, nÕu trong « ®ã cã c«ng thøc, c¸c néi dung nµy sÏ kh¸c nhau. VD c¸c em quan s¸t H23 SGK
	1. Sö dông c«ng thøc ®Ó tÝnh to¸n.

- Trong b¶ng tÝnh cã thÓ sö dông c¸c phÐp tÝnh +, - , *, /, ^, % ®Ó tÝnh to¸n.

- Trong b¶ng tÝnh còng cÇn ph¶i thùc hiÖn thø tù phÐp tÝnh:

+ Víi biÓu thøc cã dÊu ngoÆc: NgoÆc ( ), { } ngoÆc nhän.

+ C¸c phÐp to¸n luü thõa, phÐp nh©n, phÐp chia, phÐp céng, phÐp trõ.

2. NhËp c«ng thøc

- §Ó nhËp c«ng thøc vµo 1 « cÇn lµm nh­ sau:

+ Chän « cÇn nhËp c«ng thøc

+ Gâ dÊu =

+ NhËp c«ng thøc

+ NhÊn Enter chÊp nhËn





4. Cñng cè (3')
- §Ó nhËp mét c«ng thøc vµo 1 « ta ph¶i chó ý ®Õn ®iÒu g× ®Çu tiªn?


(§¸nh dÊu = tr­íc c«ng thøc)

- H·y nhËp mét c«ng thøc gåm c¸c biÓu thøc cã chøa phÐp to¸n céng, trõ, nh©n chia vµo 1 «. sau ®ã nhÊn Enter ®Ó hoµn tÊt. Sau ®ã quan s¸t trªn thanh c«ng thøc vµ so víi d÷ liÖu trong « vïa nhËp.

- Sö dông ®Þa chØ « trong c«ng thøc.

5. H­íng dÉn vÒ nhµ (1') 
- LuyÖn tËp ë nhµ nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

..................................................................................................................................................................................................................................................................................................................................................................................................................

Ngµy so¹n: 
5/10








TiÕt 14

Bµi 3: Thùc hiÖn tÝnh to¸n trªn trang tÝnh

I - Môc tiªu

1. KiÕn thøc 

- Cung cÊp cho HS c¸ch ®Æt c¸c phÐp tÝnh ®¬n gi¶n trªn b¶ng tÝnh.

- HS hiÓu kh¸i niÖm «, Khèi «, ®Þa chØ «.

2. Kü N¨ng

- HS biÕt sö dông c¸c phÐp tÝnh céng, trõ, nh©n, chia, n©ng lªn luü thõa, phÇn tr¨m trong tÝnh to¸n trªn b¶ng EXEL ®¬n gi¶n.

- HS biÕt c¸ch nhËp c«ng thøc trong « tÝnh.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, Phßng m¸y.

2. Häc sinh: SGK, vë ghi

III - Ph­¬ng ph¸p

-  ThuyÕt tr×nh, vÊn đ¸p, thùc hµnh.

IV - TiÕn tr×nh giê d¹y - gi¸o dôc

1. æn ®Þnh(1')

2. KiÓm tra bµi cò

3. Bµi míi (40')

	h® cña gv - hs
	néi dung

	GV: Trªn thanh c«ng thøc hiÓn thÞ A1, em hiÓu c«ng thøc ®ã cã nghÜa g×?

GV: Yªu cÇu thùc hµnh:

NhËp c¸c d÷ liÖu: A2=20; B3=18; TÝnh trung b×nh céng t¹i « C3 = (20+18)/2.

HS: Thùc hµnh theo cÆp trªn m¸y tÝnh.

GV: NÕu thay ®æi d÷ liÖu « A2, th× kÕt qu¶ t¹i « C3 nh­ thÕ nµo?

( Nh­ vËy, nÕu d÷ liÖu trong « A2 thay ®æi th× ta ph¶i nhËp l¹i c«ng thøc tÝnh ë « C3.

- Cã 1 c¸ch thay cho c«ng thøc = ( 20+18)/2 em chØ cÇn nhËp c«ng thøc = ( A2+B3)/2 vµo « C3, néi dung cña « C3 sÏ ®­îc cËp nhËt mçi khi néi dung c¸c « A2 vµ B3 thay ®æi.

- Yªu cÇu HS thùc hµnh theo néi dung trªn.

HS: Thùc hµnh t¹i chç trªn m¸y tÝnh cña m×nh.
	3. Sö dông ®Þa chØ trong c«ng thøc

VÝ dô:

     A2 = 20

     B3 = 18

Trung b×nh céng t¹i C3:

C«ng thøc: = ( A2+ C3)/2

* Chó ý

- NÕu gi¸ trÞ ë c¸c « A2 hoÆc B3 thay ®æi th× kÕt qu¶ ë « C3 còng thay ®æi theo.


4. Cñng cè (3')
- Sö dông ®Þa chØ « trong c«ng thøc.

5. H­íng dÉn vÒ nhµ (1') 
- §äc th«ng tin h­íng dÉn  SGK

- Chó ý c¸c b­íc GV ®· h­íng dÉn.

- LuyÖn tËp ë nhµ nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

..................................................................................................................................................................................................................................................................................................................................................................................................................

Ngµy so¹n: 13/10







TiÕt 15
Bµi thùc hµnh 3. B¶ng ®iÓm cña em

I - Môc tiªu
1. KiÕn thøc

- Häc sinh sö dông c«ng thøc trªn trang tÝnh.

2. KÜ n¨ng

- Häc sinh biÕt nhËp vµ sö dông thµnh th¹o c¸c c«ng thøc tÝnh to¸n ®¬n gi¶n trªn trang tÝnh.

3. Th¸i ®é

- Nghiªm tóc khi sö dông phong m¸y, cã th¸i ®é ®óng ®¾n trong nhËn thøc vÒ bé m«n.

II - ChuÈn bÞ

1. Gi¸o viªn: Phßng m¸y, gi¸o tr×nh.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III - Ph­¬ng ph¸p 

 - Thùc hµnh.

IV - TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5')

3. Bµi gi¶ng míi (35')
	ho¹t ®éng cña GV - hs
	néi dung

	GV: Chó ý cho HS: HS: nghe vµ ghi chÐp l¹i

GV: Yªu cÇu HS më b¶ng tÝnh Excel vµ sö dông c«ng thøc ®Ó tÝnh c¸c gi¸ trÞ sau trªn trang tÝnh

HS: thùc hiÖn yªu cÇu

GV: Quan s¸t qu¸ tr×nh thùc hiÖn cña HS vµ uèn n¾n.

- Më trang tÝnh vµ nhËp d÷ liÖu theo b¶ng sau:

a

b

c

d

e

1

5

2

8

3

4

12

5

6

GV: H­íng dÉn HS lËp c«ng thøc tÝnh.

HS: thùc hµnh

GV: Y/c HS: Më b¶ng tÝnh míi vµ lËp b¶ng ®iÓm cña em nh­ b¶ng d­íi ®©y.

LËp c«ng thøc ®Ó tÝnh ®iÓm tæng kÕt cña em theo tõng m«n häc vµo c¸c « t­¬ng øng trong cét G. (Chó ý ®iÓm tæng kÕt lµ trung b×nh céng cña c¸c ®iÓm kiÓm tra sau khi ®· nh©n hÖ sè).

HS: Më trang tÝnh míi vµ thùc hµn  
	- NÕu ®é réng cña cét qu¸ nhá, kh«ng hiÓn thÞ hÕt d·y sè qu¸ dµi, em sÏ thÊy ký hiÖu ## trong «. Khi ®ã cÇn t¨ng ®é réng cña «.

1. Bµi 1

a. 20+ 5; 20 - 15; 20 x 15; 20/15.

b.  20 = 15 x 4; ( 20  + 15 ) x 4; 20 + (15 x 4 ).

c. `144/6 - 3 x 5; 144/6 - ( 3x 5 );

d. 152/4; ( 2+72)/7

2. Bµi 2. 

T¹o trang tÝnh vµ nhËp c«ng thøc

E

F

G

     H

I

1

=A1+5

=A1*5

= A1+B2

=A1*B2

=(A1+B2)*C4

2

=A1*C4

=B2-A1

=(A1+B2)-C4

=(A1+B2)/C4

=B2^A1-C4

3

=B2*C4

=(C4-A1)/B2

=(A1+B2)/2

=(B2+C4)/2

=(A1+B2*C4)/3

3. Bµi 3

Thùc hµnh lËp vµ sö dông c«ng thøc

a

b

c

d

e

1

2

TiÒn göi

5000000

Th¸ng

TiÒn trong sæ

3

1

4

2

5

3

6

4

7

5

8

6

9

7

10

8

11

9

12

10

13

11

14

12




4. Cñng cè (3')

- C¸ch nhËp c«ng thøc?

- C¸ch tÝnh ®iÓm TB m«n häc.

5. H­íng dÉn vÒ nhµ (1')

- Xem l¹i c¸ch nhËp c¸c b¶ng tÝnh.

- Thùc hµnh ( nÕu cã ®iÒu kiÖn )

- Xem tr­íc bµi míi.

V - Rót Kinh NghiÖm

............................................................................................................................................................................................................................................................................

Ngµy so¹n:  13/10








TiÕt 16 
Bµi thùc hµnh 3. B¶ng ®iÓm cña em

I - Môc tiªu
1. KiÕn thøc

- Häc sinh sö dông c«ng thøc trªn trang tÝnh.

2. KÜ n¨ng

- Häc sinh biÕt nhËp vµ sö dông thµnh th¹o c¸c c«ng thøc tÝnh to¸n ®¬n gi¶n trªn trang tÝnh.

3. Th¸i ®é

- Nghiªm tóc khi sö dông phong m¸y, cã th¸i ®é ®óng ®¾n trong nhËn thøc vÒ bé m«n.

II - ChuÈn bÞ

1. Gi¸o viªn: Phßng m¸y, gi¸o tr×nh.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III - Ph­¬ng ph¸p 

 - Thùc hµnh.

IV - TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5')

3. Bµi gi¶ng míi (35')
	ho¹t ®éng cña GV - hs
	Néi dung

	GV: Y/c HS: Më b¶ng tÝnh míi vµ lËp b¶ng ®iÓm cña em nh­ b¶ng d­íi ®©y.

LËp c«ng thøc ®Ó tÝnh ®iÓm tæng kÕt cña em theo tõng m«n häc vµo c¸c « t­¬ng øng trong cét G. (Chó ý ®iÓm tæng kÕt lµ trung b×nh céng cña c¸c ®iÓm kiÓm tra sau khi ®· nh©n hÖ sè).

HS: thùc hµnh


	4. Bµi tËp 4

Thùc hµnh lËp b¶ng tÝnh vµ sö dông c«ng thøc

a

b

c

d

e

f

g

B¶ng ®iÓm cña em

2

STT

M«n häc

KT 15’

KT 1 tiÕt lÇn 1

KT 1 tiÕt lÇn 2

KT HK

DTK

3

1

To¸n

8

7

9

10

4

2

V.Lý

8

8

9

9

5

3

L.Sö

8

8

9

7

6

4

Sinh

9

10

9

10

7

5

C.N

8

6

8

8

8

6

Tin

8

9

9

9

9

7

V¨n

7

6

8

8

10

8

GDCD

8

9

9

9




4. Cñng cè (3')

- C¸ch nhËp c«ng thøc?

- C¸ch tÝnh ®iÓm TB m«n häc.

5. H­íng dÉn vÒ nhµ (1')

- Xem l¹i c¸ch nhËp c¸c b¶ng tÝnh.

- Thùc hµnh ( nÕu cã ®iÒu kiÖn )

- Xem tr­íc bµi míi.

V - Rót Kinh NghiÖm

............................................................................................................................................................................................................................................................................

Ngµy so¹n:  20/10
TiÕt 17

Bµi 4: sö dông c¸c hµm ®Ó tÝnh to¸n
I - Môc tiªu
1. KiÕn thøc
- HS hiÓu ®­îc hµm lµ c«ng thøc ®­îc ®Þnh nghÜa tõ tr­íc, ®ång thêi hiÓu ®­îc t¸c dông cña hµm trong qu¸ tr×nh tÝnh to¸n.

2. Kü n¨ng

- HS biÕt sö dông mét sè hµm ®¬n gi¶n (SUM) ®Ó tÝnh to¸n trªn trang tÝnh.

3. Th¸i ®é

- Nghiªm tóc khi sö dông phong m¸y, cã th¸i ®é ®óng ®¾n trong nhËn thøc vÒ bé m«n.

II - ChuÈn bÞ

1. Gi¸o viªn: Phßng m¸y, SGK, gi¸o ¸n

2. Häc sinh: SGK, vë ghi

III - Ph­¬ng ph¸p

Tr×nh bµy trùc quan - VÊn ®¸p - Thùc hµnh.

IV - TiÕn tr×nh bµi gi¶ng - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5') 


3. Bµi gi¶ng míi (35')
	Ho¹t ®éng cña gv - hs
	Néi dung

	GV: Giíi thiÖu vÒ chøc n¨ng cña Hµm cho HS hiÓu

HS: l¾ng nghe, ghi l¹i

GV: Chó ý cho HS c¸ch nhËp hµm nh­ nhËp c«ng thøc trªn b¶ng tÝnh.

(DÊu = lµ ký tù b¾t buéc)

HS: l¾ng nghe, ghi nhí

GV: Thao t¸c trªn m¸y chiÕu cho HS quan s¸t.

HS: quan s¸t

GV: Giíi thiÖu tªn hµm vµ c¸ch thøc nhËp hµm

- Giíi thiÖu vÒ c¸c biÕn a,b,c trong c¸c tr­êng hîp.

HS: l¾ng nghe, ghi l¹i

GV: lÊy VD vÒ c¸ch tÝnh tæng b»ng c«ng thøc vµ tÝnh tæng b»ng sö dông hµm cho thÊy sù kh¸c nhau gi÷a 2 c¸ch tÝnh.

HS: quan s¸t, ghi l¹i
	1. Hµm trong ch­¬ng tr×nh b¶ng tÝnh

- Hµm lµ c«ng thøc ®­îc ®Þnh nghÜa tõ tr­íc.

- Hµm ®­îc sö dông ®Ó thùc hiÖn tÝnh to¸n theo c«ng thøc.

 VÝ dô1: TÝnh trung b×nh céng cña: 3 ,4, 5.

C1: TÝnh theo c«ng thøc th«ng th­êng:  =(3+4+5)/3

C2: Dïng hµm  ®Ó tÝnh:  =AVERAGE(3,4,5)

VD2: TÝnh trung b×nh céng cña 3 sè trong c¸c « A1, A5, A6:

=AVERAGE(A1,A5,A6)

2. C¸ch sö dông hµm

- Chän « cÇn nhËp

- Gâ dÊu =

- Gâ hµm theo ®óng có ph¸p 

- Gâ Enter.
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3. Mét sè hµm trong ch­¬ng tr×nh b¶ng tÝnh

a. Hµm tÝnh tæng

- Tªn hµm:   SUM 

- C¸ch nhËp:

=SUM(a,b,c,…..)

Trong ®ã a,b,c,.. lµ c¸c biÕn cã thÓ lµ c¸c sè, cã thÓ lµ ®Þa chØ « tÝnh. ( sè l­îng c¸c biÕn kh«ng h¹n chÕ ).

VD1: =SUM(5,7,8) cho kÕt qu¶ lµ: 20.

VD2: Gi¶ sö « A2 chøa sè 5, « B8 chøa sè 27, khi ®ã:

=SUM(A2,B8) ®­îc KQ: 32

=SUM(A2,B8,5) ®­îc KQ: 37

VD3: Cã thÓ sö dông c¸c khèi « trong c«ng thøc tÝnh.

=SUM(B1,B3,C6:C12)=  B1+B3+C6+C7+….+C12


4. Cñng cè (3')

Nªu c¸ch sö dông hµm ®óng.

Trong c¸ch sö dông hµm cã g× gièng víi nhËp c«ng thøc trªn trang tÝnh?

5. H­íng dÉn vÒ nhµ (1')

- Thùc hµnh (nÕu cã ®iÒu kiÖn)

V - Rót Kinh NghiÖm

......................................................................................................................................

......................................................................................................................................

......................................................................................................................................

Ngµy so¹n:
20/10








TiÕt 18

Bµi 4: sö dông c¸c hµm ®Ó tÝnh to¸n
I - Môc tiªu
1. KiÕn thøc
- HS hiÓu ®­îc hµm lµ c«ng thøc ®­îc ®Þnh nghÜa tõ tr­íc, ®ång thêi hiÓu ®­îc t¸c dông cña hµm trong qu¸ tr×nh tÝnh to¸n.

2. Kü n¨ng

- HS biÕt sö dông mét sè hµm ®¬n gi¶n (AVERAGE, SUM, MIN, MAX) ®Ó tÝnh to¸n trªn trang tÝnh.

3. Th¸i ®é

- Nghiªm tóc khi sö dông phong m¸y, cã th¸i ®é ®óng ®¾n trong nhËn thøc vÒ bé m«n.

II - ChuÈn bÞ

1. Gi¸o viªn: Phßng m¸y, gi¸o tr×nh.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III - Ph­¬ng ph¸p

Tr×nh bµy trùc quan - VÊn ®¸p - Thùc hµnh.

IV - TiÕn tr×nh bµi gi¶ng - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò 


3. Bµi gi¶ng míi (40') 
	ho¹t ®éng cña gv - hs
	néi dung

	GV Giíi thiÖu tªn hµm vµ c¸ch thøc nhËp hµm

HS: nghe, ghi l¹i

GV: LÊy VD minh ho¹ vµ thùc hµnh trªn mµn chiÕu 

HS: quan s¸t, ghi nhí

GV: Yªu cÇu HS tù lÊy VD ®Ó thùc hµnh.

HS: thùc hiÖn lÊy VD

GV Giíi thiÖu tªn hµm vµ c¸ch thøc nhËp hµm

HS: nghe, ghi nhí

GV: lÊy VD minh häa

HS: quan s¸t, ghi nhí

GV Giíi thiÖu tªn hµm vµ c¸ch thøc nhËp hµm

HS: nghe, ghi nhí

GV: lÊy VD minh häa

HS: quan s¸t, ghi nhí
	b. Hµm tÝnh trung b×nh céng

- Tªn hµm: AVERAGE

- C¸ch nhËp:

=AVERAGE(a,b,c,….)

Trong ®ã a,b,c,.. lµ c¸c biÕn cã thÓ lµ c¸c sè, cã thÓ lµ ®Þa chØ « tÝnh. ( sè l­îng c¸c biÕn kh«ng h¹n chÕ ).

VD1: =AVERGE(15,23,45) cho kÕt qu¶ lµ: ( 15 + 23+ 45)/3.

VD2: Cã thÓ tÝnh trung b×nh céng theo  ®Þa chØ «. =AVERAGE(B1,B4,C3)

VD3: Cã thÓ kÕt hîp

=AVERAGE(B2,5,C3)

VD4: Cã thÓ tÝnh theo khèi «:

=AVERAGE(A1:A5,B6)= (A1+A2+A3+A4+A5+B6)/6

c. Hµm x¸c ®Þnh gi¸ trÞ lín nhÊt

- Môc ®Ých: T×m gi¸ trÞ lín nhÊt trong mét d·y sè.

- Tªn hµm: MAX

- C¸ch nhËp:

=MAX(a,b,c,…)

d. Hµm x¸c ®Þnh gi¸ trÞ nhá nhÊt:

- Môc ®Ých: T×m gi¸ trÞ nhá nhÊt trong mét d·y sè.

- Tªn hµm: MIN

- C¸ch nhËp: 

=MIN(a,b,c,…)


4. Cñng cè (3')

Trong c¸ch sö dông hµm cã g× gièng víi nhËp c«ng thøc trªn trang tÝnh?

5. H­íng dÉn vÒ nhµ (1')

- Thùc hµnh (nÕu cã ®iÒu kiÖn)

V - Rót Kinh NghiÖm

..................................................................................................................................................................................................................................................................................................................................................................................................................

Ngµy so¹n:  27/10                






             TiÕt 19

Bµi thùc hµnh 4

B¶ng ®iÓm líp em
I - Môc tiªu

1. KiÕn thøc
- Dïng c¸c hµm SUM, AVERAGE,MAX,MIN ®Ó tÝnh to¸n

2. Kü N¨ng
- Sö dông thµnh th¹o 4 hµm ®· nªu trªn.

3. Th¸i ®é
- Nghiªm tóc trong buæi thùc hµnh.

II - ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, b¶ng phô.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III - Ph­¬ng ph¸p

Thùc hµnh  theo nhãm trªn m¸y 

IV - TiÕn tr×nh bµi d¹y - gi¸o dôc

1.  æn ®Þnh líp (1')


2. KiÓm tra bµi cò  

3. Bµi gi¶ng míi (40') 
	Ho¹t ®éng cña gv - hs
	Néi dung

	GV: §­a néi dung yªu cÇu trªn b¶ng mµn chiÕu

HS: Quan s¸t trªn b¶ng phô.

GV: Yªu cÇu häc sinh më b¶ng tÝnh Sæ theo dâi thÓ lùc  ®· ®­îc l­u trong bµi tËp 4 cña bµi thùc hµnh 2 vµ tÝnh chiÒu cao trung b×nh, c©n nÆng trung b×nh cña c¸c b¹n trong líp em.

HS: Më l¹i bµi thùc hµnh sè 2 ®· l­u trong m¸y.


	1. Bµi 1

LËp trang tÝnh vµ sö dông c«ng thøc
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a) NhËp ®iÓm thi c¸c m«n cña líp t­¬ng tù nh­ h×nh trªn b¶ng phô.

b) Sö dông c«ng thøc thÝch hîp ®Ó tÝnh ®iÓm trung b×nh cña c¸c b¹n líp em trong cét ®iÓm trung b×nh.

c) TÝnh ®iÓm trung b×nh cña c¶ líp vµ ghi vµo « d­íi cïng cña cét ®iÓm trung b×nh.

d) L­u b¶ng tÝnh víi tªn b¶ng ®iÓm cña líp em.

2. Bµi 2

a) H·y sö dông hµm thÝch hîp ®Ó tÝnh l¹o c¸c kÕt qu¶ ®· tÝnh trong bµi tËp 1 vµ so s¸nh víi c¸ch tÝnh b»ng c«ng thøc.

b) Sö dông hµm AVERAGE ®Ó tÝnh ®iÓm trung b×nh tong m«n häc cña c¶ líp trong dßng ®iÓm trung b×nh

c. Sö dông hµm MAX, MIN ®Ó x¸c ®Þnh ®iÓm trung b×nh cao nhÊt vµ ®iÓm trung b×nh thÊp nhÊt.


4. Cñng cè (3')

 §Ó tÝnh gi¸ trÞ trung b×nh ta cã nh÷ng c¸ch nµo ®Ó tÝnh? ViÕt b»ng c«ng thøc cô thÓ?

 5. H­íng dÉn vÒ nhµ (1)

- VÒ «n l¹i 4 hµm ®· häc, vµ thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

V. Rót Kinh NghiÖm

Ngµy so¹n:  27/10







             TiÕt 20

Bµi thùc hµnh 4

B¶ng ®iÓm líp em
I - Môc tiªu

1. KiÕn thøc
- Dïng c¸c hµm SUM, AVERAGE,MAX,MIN ®Ó tÝnh to¸n

2. Kü N¨ng
- Sö dông thµnh th¹o 4 hµm ®· nªu trªn.

3. Th¸i ®é
- Nghiªm tóc trong buæi thùc hµnh.

II - ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, b¶ng phô.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III - Ph­¬ng ph¸p

Thùc hµnh  theo nhãm trªn m¸y 

IV - TiÕn tr×nh bµi d¹y - gi¸o dôc

1.  æn ®Þnh líp (1')


2. KiÓm tra bµi cò  

3. Bµi gi¶ng míi (40') 
	Ho¹t ®éng cña GV - HS
	Néi dung

	GV: Sö dông hµm thÝch hîp ®Ó tÝnh tæng gi¸ trÞ s¶n xuÊt cña tõng vïng ®ã theo n¨m vµo cét bªn ph¶i vµ tÝnh gi¸ trÞ s¶n xuÊt trung b×nh theo s¸u n¨m theo tõng ngµnh s¶n xuÊt.

- L­u b¶ng tÝnh v¬Ý tªn Gia tri san xuat
	3. Bµi 3

S ö dô n g hµ m AVERAGE, MAX, MIN

= AVERAGE(a,b,c,….)

= MAX( a,b,c,….)

= MIN( a,b,c,….)

Bµi 4. LËp trang tÝnh vµ sö dông hµm SUM
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4. Cñng cè (3')

 Nªu c«ng thøc t×m gi¸ trÞ lín nhÊt, nhá nhÊt cña mét d·y sè?

 Nªu c«ng thøc tÝnh tæng?

5. H­íng dÉn vÒ nhµ (1)

- VÒ «n l¹i 4 hµm ®· häc, vµ thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

V. Rót Kinh NghiÖm

Ngµy so¹n:
27/10








TiÕt 21

Bµi tËp
I - Môc tiªu

1. KiÕn thøc
- Dïng c¸c hµm SUM, AVERAGE,MAX,MIN ®Ó tÝnh to¸n

2. Kü N¨ng
- Sö dông thµnh th¹o 4 hµm ®· nªu trªn

3. Th¸i ®é
- Nghiªm tóc trong buæi thùc hµnh

II - ChuÈn bÞ

1. Gi¸o viªn: Bµi tËp thùc hµnh, Phßng m¸y.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III - Ph­¬ng ph¸p

Thùc hµnh  theo nhãm trªn m¸y 

IV - TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1') 

2.  KiÓm tra bµi cò 
3. Bµi gi¶ng míi  (40')
	Ho¹t ®éng cña GV-HS
	Néi dung

	GV: §­a néi dung yªu cÇu trªn b¶ng mµn chiÕu.

HS quan s¸t trªn mµn chiÕu.

GV: Yªu cÇu häc sinh sö dông b¶ng tÝnh trong bµi tËp 1.

GV: LÇn l­ît kiÓm tra c¸c nhãm thùc hµnh trªn m¸y vµ söa ch÷a chç sai nÕu cã.
	1. Bµi 1

 LËp trang tÝnh vµ sö dông c«ng thøc
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a) NhËp ®iÓm thi c¸c m«n cña líp t­¬ng tù nh­ h×nh trªn mµn chiÕu ( LËp danh s¸ch 15 HS ).

- Sö dông c«ng thøc tÝnh trùc tiÕp ®Ó tÝnh cét ®iÓm trung b×nh

-  Sö dông hµm AVERAGE ®Ó tÝnh cét ®iÓm trung b×nh

- So s¸nh kÕt qu¶ cña hai c¸ch tÝnh

- L­u b¶ng tÝnh víi tªn b¶ng ®iÓm cña líp em.

2. Bµi 2
[image: image5.png]B3 Microsoft Excel - Book1

Fle Edt Vew Inset Fomet Took Data Wndow Hep Type aquestion for e < = B X

DEER oG @ an a8 we B 2o ac P
ZIN 2
A B © D E | F T & H I J K L M N

T [Bing de Jop en

2 |STT Hovaten Toan  VatLy NgiVan Diém trung binh

3| 1 Dioh Van Hotng AN 8 8 8

4|  2LeThiHaia 9 7 7

5|  3LeTnalAu 7 9 8

6| 4 PhamNuraw 5 5 7

7| svivierAs 5 7 H

8| 6 PhamThash Bk 5 8 7

5| 7 TmaQuocBian 5 9 B

0] 8 Nauyku Linh Chi 5 s s

11 9 ViXuan Coong 5 7 8

12| 10 Tran Quoc Dat 5 8 2

13| 11 Nguyén Ant Duy 5 9 8

14| 12 Nguyén Trung Ding 5 s s

15| 13 Trin Hotng H 5 7 8

B

pE]
24
%
%
277
)
2
30
Ell
2
EE)
34

£
1045 i\ sheet1 {Shestz { Sheet3 / < ] >
Ready wn





a) (Thay cét §iÓm trung b×nh = cét tæng ®iÓm)

+ TÝnh tæng ®iÓm 3 m«n to¸n + Lý + Ng÷ v¨n cña tõng häc sinh

b) Thªm cét ®iÓm lín nhÊt vµ cét ®iÓm nhá nhÊt: Sö dông hµm MAX, MIN ®Ó t×m ®iÓm lín nhÊt vµ ®iÓm nhá nhÊt


4.  Cñng cè (3')

- Nªu l¹i c¸c hµm vµ c«ng thøc tÝnh

5. H­íng dÉn vÒ nhµ (1')

- VÒ «n l¹i 4 hµm ®· häc, vµ thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

- TiÕt sau KiÓm tra 1 tiÕt
V - Rót Kinh NghiÖm

Ngµy so¹n:  27/10








TiÕt 22

KiÓm tra 45'

I. môc tiªu

1. KiÕn thøc.

- §¸nh gi¸ kiÕn thøc  kü n¨ng cña häc sinh vÒ c¸c thµnh phÇn c¬ b¶n trªn b¶ng tÝnh Excel, c¸ch thiÕt lËp c¸c biÓu thøc tÝnh to¸n, c¸ch sö dông hµm.

2. Kü n¨ng.

- BiÕt c¸ch sö dông c«ng thøc, hµm vµo trong tÝnh to¸n b¶ng tÝnh

- VËn dông lµm bµi kiÓm tra

3. Th¸i ®é.

- Lµm bµi nghiªm tóc

II. ChuÈn bÞ

1. Gi¸o viªn: §Ò kiÓm tra , ®¸p ¸n

2. Häc sinh: häc bµi cò 

IV. Ph­¬ng ph¸p

- KiÓm tra tr¸c nghiÖm, tù luËn, ®¸nh gi¸ n¨ng lùc häc sinh

IV. TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò 

3. Bµi gi¶ng míi (43')

KiÓm tra 45
I. Tr¾C NghiÖm 

c©u 1: Muèn khëi ®éng b¶ng tÝnh Excel em cã thÓ chän mét trong c¸c tr­êng hîp sau:


A. Chän Start, Program vµ nh¸y vµo Microsoft Excel.


B. Chän biÓu t­îng [image: image6.png]Admin  Unikey.
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  trªn mµn h×nh


C. KÝch ho¹t phÝm t¾t (short cut) cña Excel cã trªn mµn h×nh


D. TÊt c¶ c¸c c©u trªn ®óng.

C©u 2: Th«ng tin ®­îc l­u d­íi d¹ng b¶ng biÓu cã ­u ®iÓm g×?


A. DÔ theo dâi


C. TÝnh to¸n nhanh chãng


B. DÔ s¾p xÕp


D. TÊt c¶ ®Òu ®óng.

C©u 3: C©u nµo sau ®©y lµ sai:


A. MiÒn lµm viÖc chÝnh cña b¶ng tÝnh gåm c¸c cét vµ c¸c dßng


B. Vïng giao nhau gi÷a cét vµ dßng lµ « tÝnh dïng ®Ó l­u chøa d÷ liÖu


C. §Þa chØ cña mét « tÝnh lµ cÆp tªn cét vµ tªn hµng n»m trªn ®ã


D. TÊt c¶ ®Òu sai.

C©u 4: Khi viÕt sai tªn hµm trong tÝnh to¸n, ch­¬ng tr×nh b¸o lçi


A. #VALUE!


C. #DIV/0!


B. #NAME!



D. #N/A!

C©u 5: Khèi lµ mét nhãm « liÒn kÒ nhau t¹o thµnh h×nh ch÷ nhËt, nh­ vËy khèi cã thÓ lµ


A. Mét «



C. Mét cét


B. Mét dßng



D. TÊt c¶ ®óng

C©u 6: Hµng lµ tËp hîp c¸c « trong b¶ng tÝnh theo chiÒu ngang, kÝ hiÖu nµo nãi vÒ hµng nµo sau ®©y ®óng:


A. C2


B. A


C. 16384

D. A1

II. Tù luËn 

C©u 7. Em h·y ®iÒn vµo nh÷ng « trèng.


Hµm lµ c«ng thøc ®­îc ®Þnh nghÜa tõ tr­íc, hµm tÝnh tæng cã tªn lµ ............., hµm Averager dïng ®Ó tÝnh ..................., hµm x¸c ®Þnh gi¸ trÞ lín nhÊt lµ ................, hµm  ............... ®­îc dïng ®Ó x¸c ®Þnh gi¸ trÞ nhá nhÊt.

C©u 8: BiÕt trong « C1 cã hµm tÝnh lµ =AVERAGER(A1:B1), c¸c « C2, C3 ®­îc sao chÐp tõ « C1. Hái hµm tÝnh trong « C2, C3 lµ g×? KÕt qu¶ trong c¸c « nµy lµ bao nhiªu?

	[image: image7.png]



	C«ng thøc
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C©u 9: H·y cho biÕt ý nghÜa cña c¸c nót lÖnh trªn thanh c«ng cô cña Excel.
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§¸p ¸n biÓu ®iÓm

	C©u
	§¸p ¸n
	§iÓm

	1
	             1 - D

             2 - D

             3 - D

             4 - C

             5 - D

             6 - C
	0.5®

0.5®

0.5®

0.5®

0.5®

0.5®

	2
	Sum

Trung b×nh céng

Max

Min
	0.5®

0.5®

0.5®

0.5®

	3
	C«ng thøc

KÕt qu¶

C2

AVERAGER(A2:B2)

6

C3

AVERAGER(A3:B3)

6.5


	1®

1®

	4
	1 – Më b¶ng tÝnh míi

2 – Më b¶ng tÝnh ®· l­u trong m¸y

3 – L­u b¶ng tÝnh

4 – Chän font ch÷

5 – Chän cì ch÷

6 – Chän kiÓu ch÷
	0.5®

0.5®

0.5®

0.5®

0.5®

0.5®


4. Cñng cè 

5. H­íng dÉn vÒ nhµ

V. rót kinh nghiÖm

Ngµy so¹n:  3/11                                                                                                                                              TiÕt 23

kh¸m ph¸ thÕ giíi víi phÇn mÒm

earth explorer 
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu ®­îc ý nghÜa vµ mét sè chøc n¨ng chÝnh cña phÇn mÒm.

2. Kü N¨ng
-  Thao t¸c ®­íc c¸c thao t¸c: xem, di chuyÓn b¶n ®å, phãng to, thu nhá.

3. Th¸i ®é
-  Th¸i ®é tËp trung, høng thó häc tËp.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: T×m hiÓu tr­íc vÒ phÇn mÒm.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò 

3. Bµi gi¶ng míi (40')

	H§ cña GV - hs
	néi dung

	GV : Giíi thiÖu phÇn mÒm Earth Explorer lµ mét phÇn mÒm chuyªn dïng ®Ó tra cøu b¶n ®å thÕ giíi. 

HS: Chó ý l¾ng nghe 

GV: §Ó khëi ®éng 1 ch­¬ng tr×nh ta lµm nh­ thÕ nµo?

HS: Tr¶ lêi.

Vµ khëi ®éng phÇn mÒm.

GV: C¸c em thÊy g× trªn mµn h×nh?

HS: tr¶ lêi

GV: Giíi thiÖu c¸c thµnh phÇn cã trong cöa sæ cña mµn h×nh Earth Explorer

GV: Giíi thiÖu vµ h­íng dÉn häc sinh víi c¸c nót lÖnh ®Ó ®iÒu khiÓn tr¸i ®Êt trong phÇn mÒm quay theo c¸c h­íng qui ®Þnh.

GV: Giíi thiÖu vµ h­íng dÉn häc sinh víi c¸c nót lÖnh ®Ó phãng to, thu nhá vµ di chuyÓn b¶n ®å trong phÇn mÒm.
	1. Giíi thiÖu vÒ phÇn mÒm

-  PhÇn mÒm sÏ cung cÊp cho chóng ta b¶n ®å tr¸i ®Êt cïng toµn bé 250 quèc gia vµ vïng l·nh thæ trªn toµn thÕ giíi. PhÇn mÒm nµy cã rÊt nhiÒu th«ng tin h÷u Ých ®Ó xem, duyÖt vµ t×m kiÕm th«ng tin b¶n ®å theo nhiÒu chñ ®Ò kh¸c nhau.

2. Khëi ®éng phÇn mÒm

-  Thanh b¶ng chän.

-  Thanh c«ng cô.

- H×nh ¶nh tr¸i ®Êt víi b¶n ®å ®Þa h×nh chi tiÕt n»m gi÷a mµn h×nh.

-  Thanh tr¹ng th¸i.

- B¶ng th«ng tin c¸c quèc gia trªn thÕ giíi.

3. Quan s¸t b¶n ®å b»ng c¸ch cho tr¸i ®Êt tù quay

-  Xoay tõ  tr¸i sang ph¶i.

-  Xoay tõ ph¶i sang tr¸i.

-  Xoay tõ trªn xuèng d­íi.

-  Xoay tõ d­íi lªn trªn.

-  Dõng xoay.

4. Phãng to, thu nhá vµ dÞch chuyÓn b¶n ®å
(H×nh c¸c nót lÖnh xem trùc tiÕp trªn m¸y tÝnh)


4.  Cñng cè (3')

-  C¸c thao t¸c chÝnh ®Ó quan s¸t b¶n ®å.

5. H­íng dÉn vÒ nhµ (1')

-  Thao t¸c l¹i trªn m¸y tÝnh nÕu cã ®iÒu kiÖn.

-  ChuÈn bÞ cho giê thùc hµnh tiÕp theo.

V - Rót Kinh NghiÖm

Ngµy so¹n:3/11








TiÕt 24

kh¸m ph¸ thÕ giíi víi phÇn mÒm

earth explorer
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu ®­îc ý nghÜa vµ mét sè chøc n¨ng chÝnh cña phÇn mÒm.

2. Kü N¨ng
-  Thao t¸c ®­íc c¸c thao t¸c: xem, di chuyÓn b¶n ®å, phãng to, thu nhá, thay ®æi th«ng tin trªn b¶n ®å.

3. Th¸i ®é
-  Th¸i ®é tËp trung, høng thó häc tËp.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: T×m hiÓu tr­íc vÒ phÇn mÒm.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò  

3. Bµi gi¶ng míi (40')

	H§ cña GV
	Ghi B¶ng

	GV: Yªu cÇu häc sinh khëi ®éng phÇn mÒm.

HS: Chó ý l¾ng nghe, quan s¸t, lµm c¸c thao t¸c thùc hµnh theo yªu cÇu cña gi¸o viªn

GV: Yªu cÇu häc sinh dïng lÖnh ®Ó di chuyÓn b¶n ®å (thao t¸c kÐo th¶ chuét).

GV: H­íng dÉn häc sinh thao t¸c ®Ó dÞch chuyÓn nhanh tíi mét quèc gia.

HS: Chó ý l¾ng nghe, quan s¸t, lµm c¸c thao t¸c thùc hµnh theo yªu cÇu cña gi¸o viªn
	1. Quan s¸t 

-  Giíi thiÖu cho häc sinh c¸c nót lÖnh trªn thanh b¶ng chän.

-  Yªu cÇu häc sinh sö dông c¸c nót lÖnh cho tr¸i ®Êt tù xoay tõ tr¸i sang ph¶i, tõ ph¶i sang tr¸i, tõ trªn xuèng d­íi, tõ d­íi lªn trªn.

-  Yªu cÇu häc sinh chän n­íc ViÖt Nam vµ sö dông nót phãng to, thu nhá ®Ó quan s¸t.

-  Lµm Èn, hiÖn c¸c quÇn ®¶o, nói, ®­êng s«ng, ®­êng biªn giíi cña ViÖt Nam vµ cho nhËn xÐt.

2. Di chuyÓn 

-  Yªu cÇu häc sinh lùa chän c¸c quèc gia ë khu vùc §«ng Nam ¸. 

-  T×m thñ ®« vµ thµnh phè cña c¸c n­íc vµ ®äc tªn.

-  Phãng to b¶n ®å tõng quèc gia ®Ó quan s¸t cô thÓ h¬n.


4.  Cñng cè 

-  Gi¸o viªn nhËn xÐt giê thùc hµnh, ®¸nh gi¸ ý thø lµm bµi cña tõng m¸y.

5. H­íng dÉn vÒ nhµ 

-  Thao t¸c l¹i trªn m¸y tÝnh nÕu cã ®iÒu kiÖn.

-  ChuÈn bÞ cho giê thùc hµnh tiÕp theo.

V - Rót Kinh NghiÖm

Ngµy so¹n:   10/11                                                                                                                                          TiÕt 25
kh¸m ph¸ thÕ giíi víi phÇn mÒm

earth explorer
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu ®­îc ý nghÜa vµ mét sè chøc n¨ng chÝnh cña phÇn mÒm.

2. Kü N¨ng
-  Thao t¸c ®­íc c¸c thao t¸c: xem, di chuyÓn b¶n ®å, phãng to, thu nhá, thay ®æi th«ng tin trªn b¶n ®å, ®o kho¶ng c¸ch gi÷a 2 ®Þa ®iÓm vµ t×m kiÕm th«ng tin trªn b¶n ®å.

3. Th¸i ®é
-  Th¸i ®é tËp trung, høng thó häc tËp.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: T×m hiÓu tr­íc vÒ phÇn mÒm.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp (1') 

2.  KiÓm tra bµi cò 

3.  Bµi gi¶ng míi (40')

	H§ cña GV
	Ghi B¶ng

	GV: Giíi thiÖu trªn b¶n ®å ®Þa h×nh chóng ta cã thÓ xem c¸c th«ng 

HS: Chó ý l¾ng nghe, quan s¸t, lµm c¸c thao t¸c thùc hµnh theo yªu cÇu cña gi¸o viªn.

GV: Giíi thiÖu cho häc sinh c¸ch ®Æt c¸c chÕ ®é thÓ hiÖn trªn b¶n ®å cña c¸ ®­êng biªn giíi, c¸c con s«ng, c¸cbê biÓn.

GV: Giíi thiÖu häc sinh thao t¸c ®Ó tÝnh kho¶ng c¸ch gi÷a hai vÞ trÝ trªn b¶n ®å.

HS: Chó ý l¾ng nghe, quan s¸t, lµm c¸c thao t¸c thùc hµnh theo yªu cÇu cña gi¸o viªn.

GV: Khi ta chän 2 ®Þa ®iÓm cÇn ®o th× trªn b¶n ®å sÏ xuÊt hiÖn g×?

- Cho häc sinh lµm vÝ dô trªn m¸y víi viÖc ®o kho¶ng c¸ch tõ Qu¶ng Ninh ®Õn Hµ Néi.

GV: §­a ra mét sè yªu cÇu cho häc sinh thùc hµnh víi c¸c thao t¸c.

- §Ó c¸c em so s¸nh víi nhau.

- NhËn xÐt vµ ®­a ra kÕt qu¶ ®óng nhÊt.
	1. Xem th«ng tin trªn b¶n ®å

Giíi thiÖu trªn b¶n ®å ®Þa h×nh chóng ta cã thÓ xem c¸c th«ng tin nh­ tªn c¸c quèc gia, c¸c thµnh phè, c¸c hßc ®¶o trªn biÓn.

2.  TÝnh kho¶ng c¸ch gi÷a 2 vÞ trÝ trªn b¶n ®å

- XuÊt hiÖn b¶ng th«ng b¸o kÕt qu¶ kho¶ng c¸ch t­¬ng ®èi gi÷a hai vÞ trÝ trªnb ¶n ®å.

* Chó ý: Kho¶ng c¸ch ®o ®­îc lµ kho¶ng c¸ch tÝnh theo ®­êng chim bay vµ chØ lµ kho¶ng c¸ch t­¬ng ®èi.


4. Cñng cè (3')

-  Gi¸o viªn nhËn xÐt giê thùc hµnh, ®¸nh gi¸ ý thø lµm bµi cña tõng m¸y.

5. H­íng dÉn vÒ nhµ (1')

-  Thao t¸c l¹i trªn m¸y tÝnh nÕu cã ®iÒu kiÖn.

-  ChuÈn bÞ cho giê thùc hµnh tiÕp theo.

V - Rót Kinh NghiÖm

Ngµy so¹n:  10/11








TiÕt 26

kh¸m ph¸ thÕ giíi víi phÇn mÒm

earth explorer
I -  Môc tiªu

1. KiÕn thøc
-  N¾m ®­îc c¸c th«ng ti chi tiÕt trªn b¶n ®å.

2. Kü N¨ng
-  Thµn th¹o c¸c thao t¸c: C¸ch ®o kho¶ng c¸ch gi÷a hai ®iÓm trªn b¶n ®å vµ t×m kiÕm th«ng tin trªn b¶n ®å.

3. Th¸i ®é
-  Th¸i ®é tËp trung, høng thó häc tËp.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, phÇn mÒm.

2. Häc sinh: T×m hiÓu tr­íc vÒ phÇn mÒm.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y

1.   æn ®Þnh líp (1')

2.  KiÓm tra bµi cò
3.  Bµi gi¶ng míi (40')

	H§ cña GV
	Ghi B¶ng

	GV: Yªu cÇu häc sinh bËt m¸y tÝnh vµ khëi ®éng phÇn mÒm Earth Explorer.

- Yªu cÇu häc sinh thÓ hiÖn ë b¶n ®å c¸c n­íc Ch©u ¸.

HS: Chó ý l¾ng nghe, quan s¸t

GV: Yªu cÇu häc sinh xem th«ng tin chi tiÕt cña n­íc ViÖt Nam.

GV: §Ó chän ®­îc vÞ trÝ cña n­íc ViÖt Nam ta lµm nh­ thÕ nµo?

GV: H­íng dÉn häc sinh xem c¸c th«ng tin vÒ diÖn tÝch, d©n sè cña mét n­íc.

HS: quan s¸t thùc hµnh theo

GV: §Ó tÝnh kho¶ng c¸ch gi÷a Hµ Néi vµ B¾c Kinh ta lµm nh­ thÕ nµo?

§­a ra thªm mét sè cÆp ®Þa danh ®Ó häc sinh thùc hµnh viÖc ®o kho¶ng c¸ch gi÷a 2 ®Þa ®iÓm.
	1. Thùc hµnh xem b¶n ®å

- HiÖn tªn c¸c n­íc Ch©u ¸ 
- Th«ng tin chi tiÕt cña n­íc ViÖt Nam.

- Chän vÞ trÝ cña n­íc ViÖt Nam

2. §o  kho¶ng c¸ch

- Di chuyÓn chuét ®Õn vïng cÇn ®o.

-  Nh¸y chuét nót Measure.

- Di chuyÓn ®Õn vÞ trÝ thø 1.

- KÐo th¶ chuét ®Õn vÞ trÝ thø 2.


4.  Cñng cè (3')

-  Nh¾c l¹i tÊt c¶ c¸c thao t¸c víi Earth Explorer.

-   NhËn xÐt hk¶ n¨ng tiÕp thu vµ thùc hµnh hiÖu qu¶ cña häc sinh.

5. H­íng dÉn vÒ nhµ (1')

-  Thao t¸c l¹i trªn m¸y tÝnh nÕu cã ®iÒu kiÖn.

-  ChuÈn bÞ ®äc tr­íc cho bµi 5.

V - Rót Kinh NghiÖm

Ngµy so¹n:  17/11                                                                                             TiÕt 27

Bµi 5: thao t¸c víi b¶ng tÝnh
I -  Môc tiªu

1. KiÕn thøc
-  H­íng dÉn cho HS c¸ch ®iÒu chØnh ®é réng cña cét vµ chiÒu cao cña hµng, ®ång thêi giíi thiÖu khi nµo th×  thªm cét, thªm hµng hoÆc xo¸ cét, xo¸ hµng.

2. Kü N¨ng
-  HS biÕt c¸ch ®iÒu chØnh ®é réng cña cét vµ chiÒu cao cña hµng vµ biÕt thªm cét, thªm hµng hoÆc xo¸ cét, xo¸ hµng.

-  HS biÕt lµm vµ lµm tèt c¸c thao t¸c ®èi víi c¸c kiÕn thøc trªn.

3. Th¸i ®é
-  ThÊy ®­îc t¸c dông cña cña b¶ng tÝnh trong trong cuéc sèng.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, phßng m¸y

2. Häc sinh: SGK, vë ghi

III -  Ph­¬ng ph¸p

– GV gi¶i ®¸p, h­íng dÉn. HS thùc hµnh theo nhãm 

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40')
	ho¹t ®éng cña gv - hs
	néi dung

	GV: §­a t×nh huèng: khi nhËp vµo trang tÝnh xuÊt hiÖn c¸c tr­êng hîp nh­ h×nh minh ho¹. 

  + Cét Hä Tªn vµ cét ®iÓm trung b×nh qu¸ hÑp.

+ Dßng qu¸ hÑp

- HS quan s¸t trªn mµn chiÕu

- GV thao t¸c c¸c t×nh huèng võa ®­a ra vµ c¸ch gi¶i quyÕt.

- Yªu cÇu HS tù t¹o ra t×nh huèng vµ thao t¸c nhiÒu lÇn.

- HS quan s¸t, ghi chÐp vµ thùc hµnh trªn m¸y.

- GV ®­a ra t×nh huèng cÇn ph¶i chÌn thªm cét hoÆc hµng trªn mµn chiÕu. (ChÌn thªm cét Giíi tÝnh bªn c¹nh cét Hä tªn)

- ChÌn thªm mét hµnh ®Ó t¹o kho¶ng c¸ch nh­ h×nh minh ho¹.

- GV giíi thiÖu c¸ch lµm b»ng menu lÖnh hoÆc dïng chuét, hoÆc dïng bµn phÝm.

HS: chó ý quan s¸t thùc hµnh

GV: Khi xo¸ cét hoÆc xo¸ hµng, c¸c cét bªn ph¶i ®­îc ®Èy sang tr¸i, c¸c hµng phÝa d­íi ®­îc ®Èy lªn trªn.

HS: l¾ng nghe, quan s¸t, thùc hµnh
	1. §iÒu chØnh ®é réng cña cét vµ ®é cao cña hµng
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- §­a con trá vµo v¹ch ng¨n c¸ch 2 cét hoÆc hai dßng.

- KÐo th¶ sang ph¶i, tr¸i/lªn, xuèng ®Ó më réng hoÆc thu hÑp ®é réng hoÆc chiÒu cao theo ý muèn.

* Chó ý: Nh¸y ®óp chuét trªn v¹ch ph©n c¸ch cét hoÆc hµng sÏ ®iÒu chØnh ®é réng cét, ®é cao hµng võa khÝt víi d÷ liÖu cã trong cét vµ hµng ®ã.

2. ChÌn thªm hoÆc xo¸ cét vµ hµng

a) ChÌn thªm cét hoÆc hµng
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+ §Ó chÌn thªm cét:

- Chän mét cét

- Insert(Columns
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+ §Ó chÌn thªm hµng:

- Chän mét hµng

- Insert( Rows

b) Xo¸ cét hoÆc hµng

- Chän cét hoÆc hµng cÇn xo¸

- Edit ( Delete





4. Cñng cè (3')

- Nh¾c l¹i c¸ch chÌn thªm cét, dßng

- C¸ch xãa cét, dßng

5. H­íng dÉn vÒ nhµ (1')

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

Ngµy so¹n: 17/11                                                                                              TiÕt 28

Bµi 5: thao t¸c víi b¶ng tÝnh
I -  Môc tiªu

1. KiÕn thøc
-  H­íng dÉn cho HS c¸ch ®iÒu chØnh ®é réng cña cét vµ chiÒu cao cña hµng, ®ång thêi giíi thiÖu khi nµo th×  thªm cét, thªm hµng hoÆc xo¸ cét, xo¸ hµng.

-  H­íng dÉn cho HS c¸ch sao chÐp vµ di chuyÓn d÷ liÖu, sao chÐp c«ng thøc.

2. Kü N¨ng
-  HS biÕt c¸ch ®iÒu chØnh ®é réng cña cét vµ chiÒu cao cña hµng vµ biÕt thªm cét, thªm hµng hoÆc xo¸ cét, xo¸ hµng.

-  HS biÕt lµm vµ lµm tèt c¸c thao t¸c ®èi víi c¸c kiÕn thøc trªn.

3. Th¸i ®é
-  ThÊy ®­îc t¸c dông cña cña b¶ng tÝnh trong trong cuéc sèng.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, phßng m¸y

2. Häc sinh: SGK, vë ghi

III -  Ph­¬ng ph¸p

– GV gi¶i ®¸p, h­íng dÉn. HS thùc hµnh theo nhãm 

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40')
	Ho¹t ®éng cña gv - hs
	néi dung

	GV: §­a t×nh huèng cÇn sao chÐp d÷ liÖu trong mét « hoÆc mét khèi «. 
- GV thao t¸c cô thÓ c¸ch sao chÐp nhiÒu lÇn cho HS quan s¸t.

HS: quan s¸t

- GV giíi thiÖu c¸ch lµm b»ng menu lÖnh hoÆc dïng chuét, hoÆc dïng bµn phÝm.

HS: quan s¸t

GV: Di chuyÓn néi dung cña « tÝnh kh¸c víi sao chÐp néi dung cña « tÝnh ( GV lÊy VD cho HS quan s¸t sù kh¸c nhau) ( Khi di chuyÓn néi dung th× ®Õn « tÝnh kh¸c th× néi dung ë « ban ®Çu sÏ bÞ xo¸

GV: yªu cÇu HS thao t¸c nhiÒu lÇn viÖc sao chÐp vµ di chuyÓn trªn b¶ng tÝnh.

- Chó ý: Khi xo¸ cét hoÆc xo¸ hµng, c¸c cét bªn ph¶i ®­îc ®Èy sang tr¸i, c¸c hµng phÝa d­íi ®­îc ®Èy lªn trªn.

- XÐt VD: (GV minh ho¹ trªn mµn chiÕu t­¬ng tù nh­ h×nh bªn)

¤ A5 cã sè 200

¤ D1 cã sè 150

B3 cã c«ng thøc = A5+D1

-> NÕu sao chÐp c«ng thøc ë « B3 vµ d¸n vµo « C6 ta thÊy trong « C6 cã c«ng th­c = B8+E4 ( Tøc lµ c«ng thøc ®· bÞ ®iÒu chØnh)

Nh­ vËy: 

+ ë h×nh 1, A1 vµ D5 ®­îc x¸c ®Þnh quan hÖ t­¬ng ®èi vÒ vÞ trÝ cña c¸c ®Þa chØ trong c«ng thøc so víi « B3

+ Trong h×nh 2, ë « ®Ých C6, sau khi sao chÐp, quan hÖ t­¬ng ®èi vÒ vÞ trÝ nµy ®­îc gi÷ nguyªn b»ng viÖc ®iÒu chØnh A5 thµnh B8 vµ D1 thµnh E4.
	3. Sao chÐp vµ di chuyÓn d÷ liÖu
a) Sao chÐp néi dung « tÝnh

(Sö dông c¸c nót lÖnh: Copy, Cut, Paste)

- Chän « hoÆc khèi « cã th«ng tin cÇn sao chÐp.

- Nh¸y nót Copy trªn thanh c«ng cô.

- Chän « cÇn ®­a th«ng tin ®­îc sao chÐp vµo.

- Nh¸y nót Paste trªn thanh c«ng cô.

b) Di chuyÓn néi dung « tÝnh

- Chän « hoÆc c¸c « th«ng tin cÇn chuyÓn.

- Nh¸y nót Cut trªn thanh c«ng cô

- Chän « cÇn ®­a th«ng tin di chuyÓn ®Õn.

- Nh¸y nót Paste trªn thanh c«ng cô.

4. Sao chÐp c«ng thøc

a) sao chÐp néi dung c¸c « cã c«ng thøc
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- Khi sao chÐp mét « cã néi dung lµ c«ng thøc chøa ®Þa chØ, c¸c ®Þa chØ ®­îc ®iÒu chØnh ®Ó gi÷ nguyªn quan hÖ t­¬ng ®èi vÒ vÞ trÝ so víi « ®Ých.

b) Di chuyÓn néi dung c¸c « cã c«ng thøc

- Ta cã thÓ di chuyÓn b»ng c¸c nót lÖnh Cut vµ Paste vµ c¸c ®Þa chØ trong c«ng thøc kh«ng bÞ ®iÒu chØnh (c«ng thøc ®­îc sao chÐp y nguyªn).



4. Cñng cè (3')

- Nh¾c l¹i c¸ch chÌn thªm cét, dßng

- C¸ch xãa cét, dßng

- Sao chÐp vµ di chuyÓn d÷ liÖu

- Sao chÐp c«ng thøc

5. H­íng dÉn vÒ nhµ (1')

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

Ngµy so¹n:24/11








        TiÕt 29

bµi tËp
I -  Môc tiªu

1. KiÕn thøc
-  KiÓm tra viÖc n¾m b¾nt kiÕn thøc cña häc sinh vµ viÖc sö dông c¸c hµm ®Ó tÝnh to¸n.

2. Kü N¨ng
-  Thùc hiÖn ®­îc c¸c phÐp to¸n b»ng c¸ch sö dông hµm, c«ng thøc.

3. Th¸i ®é
-  Häc sinh thÊy ®­îc lîi Ých cña viÖc sö dông hµm vµ c«ng thøc trong tÝnh to¸n.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, phßng m¸y

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

- Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh giê d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40')

	ho¹t ®éng cña gv - hs
	néi dung

	GV: Ra yªu cÇu ®Ò bµi.

HS : Ghi chÐp.

GV : Gäi 1 häc sinh lªn b¶ng, chuyÓn c¸c c«gn thøc sang d¹ng b¶ng tÝnh.

- Yªu cÇu häc sinh më m¸y vµ lµm bµi.

HS : Lµm bµi tËp trªn m¸y.

GV: §­a ra kÕt qu¶:

a) 56.12

b) 11.57

c) -706

d) 4425.143 

GV: Ra yªu cÇu bµi 2

- H­íng dÉn häc sinh c¸c c¸ch lµm cña tõng phÇn yªu cÇu.

HS: thùc hiÖn yªu cÇu theo tõng phÇn

* Gîi ý:

HS sö dông c¸c hµm sau:

SUM 

AVERAGE

MAX

MIN
	1. Bµi 1 (10')

Sö dông c«ng thøc tÝnh c¸c gi¸ trÞ sau

a) 152 :4

b) (2 + 7)2: 7

c) (32 -   7)2 -  (6 + 5)3

d) (188 -   122) :7

2. Bµi 2 (30')

Cho b¶ng d÷ liÖu:

B¶ng ®iÓm líp 7A

2

Stt

Hä tªn

To¸n

Tin

NV

T§

§TB

3

1

An

8

7

8

?

?

4

2

B×nh

10

9

9

?

?

5

3

Kh¸nh

8

6

8

?

?

6

4

V©n

7

8

6

?

?

7

5

Hoa

9

9

9

?

?

a) Sö dông c¸c hµm ®Ó tÝnh T§, §TB cña c¸c häc sinh trªn.

b) Sö dông hµm Max, Min ®Ó tÝnh T§, §TB lín nhÊt, nhá nhÊt.

c) §iÒu chØnh ®é réng cña hµng vµ cét cho phï hîp.

d) Thª cét Lý vµ cho ®iÓm vµo. NhËn xÐt g× vÒ kÕt qu¶ tæng ®iÓm?



D -   Cñng cè ( 3’ )

-  Nh¾c l¹i c¸c b­íc sö dông c«ng thøc.

-  NhËn xÐt giê thùc hµnh cña häc sinh.


E - H­íng dÉn vÒ nhµ ( 1’ )

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn.

- ChuÈn bÞ cho bµi kiÓm tra thùc hµnh.

V - Rót Kinh NghiÖm

Ngµy so¹n:24/11








   TiÕt 30, 31

kiÓm tra thùc hµnh
I -  Môc tiªu

1. KiÕn thøc
-  KiÓm tra chÊt l­¬ng c¸c thao t¸c tõ bµi 1 ®Õn bµi 5

2. Kü N¨ng
-  C¸c thao t¸c c¬ b¶n ban ®Çu khi lµm viÖc víi trang tÝnh.

3. Th¸i ®é
-  Th¸i ®é häc tËp nghiªm tóc, thùc hµnh hiÖu qu¶.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, ®Ò bµi, phßng m¸y.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

KiÓm tra thù hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp 

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi         KiÓm tra thùc hµnh

§Ò bµi

Bµi 1

Khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel. NhËp trang tÝnh víi néi dung nh­ sau:

	
	A
	B
	C
	D
	E
	F

	1
	Stt
	Hä vµ tªn
	To¸n
	Lý
	V¨n
	§TB

	2
	1
	§inh Hoµng An
	8
	7
	8
	

	3
	2
	Lª Hoµi An
	9
	10
	10
	

	4
	3
	Ph¹m Nh­ Anh
	8
	6
	8
	

	5
	4
	Ph¹m Thanh B×nh
	8
	8
	9
	

	6
	5
	NguyÔn Linh Chi
	7
	6
	8
	

	7
	6
	Vò Xu©n C­¬ng
	10
	9
	9
	

	8
	7
	TrÇn Quèc §¹t
	8
	8
	9
	

	9
	8
	NguyÔn Anh Duy
	8
	9
	9
	

	
	9
	NguyÔn Trung Dòng
	8
	8
	7
	

	
	10
	TrÇn Hoµng Hµ
	8
	7
	8
	


(H1)

a) NhËp ®iÓm thi c¸c m«n nh­ minh ho¹ trong h×nh.

b) TÝnh ®iÓm trung b×nh b»ng c«ng thøc thÝch hîp vµo cét §TB.

c) Sö dông hµm Max, Min x¸c ®Þnh ®iÓm trung b×nh cao nhÊt vµ ®iÓm trung b×nh thÊp nhÊt.

d) L­u b¶ng tÝnh víi tªn Bang diem cua em

e) ChÌn thªm mét cét trèng vµo tr­íc cét D (Lý) ®Ó nhËp m«n Tin nh­ h×nh d­íi.

f) ChÌn c¸c hµng trèng vµ thùc hiÖn c¸c thao t¸c ®iÒu chØnh ®é réng cét, ®é cao hµng ®Ó cã trang tÝnh nh­ h×nh H2.

	
	A
	B
	C
	D
	E
	F
	G

	1
	Stt
	Hä vµ tªn
	To¸n
	Tin
	Lý
	V¨n
	§TB

	2
	1
	§inh Hoµng An
	8
	8
	7
	8
	7.7

	3
	
	
	
	
	
	
	

	4
	2
	Lª Hoµi An
	9
	10
	10
	10
	9.7

	5
	3
	Ph¹m Nh­ Anh
	8
	8
	6
	8
	7.3

	6
	4
	Ph¹m Thanh B×nh
	8
	9
	8
	9
	8.5

	7
	5
	NguyÔn Linh Chi
	7
	9
	6
	8
	7.5

	8
	6
	Vò Xu©n C­¬ng
	10
	10
	9
	9
	9.5

	9
	7
	TrÇn Quèc §¹t
	8
	9
	8
	9
	8.5

	10
	
	
	
	
	
	
	

	11
	8
	NguyÔn Anh Duy
	8
	7
	9
	6
	7.5

	12
	9
	NguyÔn Trung Dòng
	8
	9
	8
	7
	7.7

	13
	10
	TrÇn Hoµng Hµ
	8
	7
	7
	8
	7.5


(H2)

§¸p ¸n – BiÓu ®iÓm

	C©u
	Néi dung
	§iÓm

	a
	LËp ®­îc trang tÝnh nh­ trong h×nh
	2đ

	b.
	TÝnh ®­îc ®iÓm TB
	2đ

	c.
	Sử dụng hàm Max, Min tìm ra giá trị lớn nhất, nhỏ nhất
	2đ

	d.
	L­u bµi theo yªu cÇu
	1đ

	e
	Chèn thêm cột như trong hình 
	1đ

	f
	Chèn thêm hàng trống và thực hiện được các thao tác điểu chỉnh cột và hàng
	2đ


4. Cñng cè

5. H­íng dÉn vÒ nhµ

- ¤n l¹i c¸c kiÕn thøc ®· häc, vµ thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn.

V - Rót Kinh NghiÖm

Ngµy so¹n:24/11







                  TiÕt 32

¤n tËp
I -  Môc tiªu

1. KiÕn thøc
-  KiÓm tra viÖc n¾m b¾nt kiÕn thøc cña häc sinh tõ ®Çu n¨m häc.

- §iÒu chØnh viÖc häc cña häc sinh còng nh­ viÖc d¹y cña gi¸o viªn.

2. Kü N¨ng
-  H×nh thµnh cho häc sinh kü n¨ng quan s¸t, ph©n tÝch, t­ duy tæng hîp.

3. Th¸i ®é
-  Nghiªm tóc, tËp trung, chó ý.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, phßng m¸y

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

- Quan s¸t, ph©n tÝch tæng hîp.

IV -  TiÕn tr×nh bµi d¹y -gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40')

	ho¹t ®éng cña gv -hs
	néi dung

	GV: ®­a ra c¸c chñ ®Ò kiÕn thøc lý thuyÕt c¬ b¶n ®· häc trong ch­¬ng tr×nh häc kú I.

HS: Quan s¸t vµ ghi chÐp.

GV: Yªu cÇu häc sinh theo c¸ nh©n lÇn l­ît gi¶i ®¸p c¸c chñ ®Ò lý thuyÕt ®ã.

HS: Quan s¸t, nghe h­íng dÉn vµ lµm bµi.

-  So s¸nh víi c¸c m¸y xung quanh.

GV: Ra bµi tËp vµ h­íng dÉn häc sinh lµm bµi.

HS: Quan s¸t bµi tËp.

-  Nghe h­ìng dÉn vµ thùc hµnh lµm bµi.-  §Ó häc sinh lµm bµi.

GV: §­a ra ®¸p ¸n.

-1, 2, -6, 1, 1, 1.

GV: §­a ra bµi tËp 2 (phat phiÕu häc tËp cho häc sinh).

-  H­íng dÉn häc sinh lµm.


	1. Lý thuyÕt(10')

- C¸c thao t¸c khëi ®éng Excel

- C¸c thµnh phÇn trªn cöa sæ cña Excel

- C¸c b­íc nhËp c«ng thøc

- Có ph¸p cña c¸c hµm

      SUM

      AVERAGE

      MAX

      MIN

2. Bµi tËp

a) Bµi 1(15')

Gi¶ sö trong « A1, B1 lÇn l­ît lµ c¸c sè -4, 3. Em h·y cho biÕt kÕt qu¶ cña c¸c phÐp tÝnh:

=SUM(A1,B1)

=SUM(A1,B1,B1)

=SUM(A1,B1,-5)

=SUM(A1,B1,2)

b) Bµi tËp 2(15')

- Sö dông c¸c hµm: SUM tÝnh Tæng, MAX, MIN tÝnh cét Tæng, AVERAGE tÝnh cét N«ng nghiÖp, C«ng nghiÖp, DÞch vô.

1

N¨m

NNghiÖp

CNghiÖp

DVô

Tæng

2

2001

164031

542155

104945

?

3

2002

170366

70499

126381

?

4

2003

174927

136165

139721

?

5

2004

188045

159752

157753

?

6

GTTB

?

?

?

?

7

GTLN

?

8

GTNN

?

- L­u b¶ng víi tªn Gia tri san xuat.


4. Cñng cè ( 3’ )

-  Nh¾c l¹i c¸c b­íc sö dông hµm ®Ó tÝnh to¸n.

5. H­íng dÉn vÒ nhµ ( 1’ )

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn.

V - Rót Kinh NghiÖm

Ngµy so¹n:1/12








         TiÕt 33

kiÓm tra häc k× i 

phÇn thùc hµnh
I -  Môc tiªu


1. KiÕn thøc
- C¸c thµnh phÇn trong b¶ng tÝnh
- C¸c c«ng thøc vµ hµm tÝnh trong b¶ng tÝnh
2. Kü N¨ng
-  C¸c thao t¸c c¬ b¶n víi trang tÝnh 

- BiÕt sö dông c¸c c«ng thøc vµ hµm ®Ó tÝnh to¸n

3. Th¸i ®é
-  Thùc hµnh lµm bµi nghiªm tóc

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o án, ®Ò bµi.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

- KiÓm tra thùc hµnh

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (44')

KIỂM THỰC HÀNH

Đề bài: 

Khởi động chương trình bảng tính và thực hiện:

[image: image15.png]Téng gid tri sin xuat
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a.Nhập trang tính và chỉnh sửa theo mẫu.

b. Tính tổng giá trị sản xuất từng năm của các ngành.

c. Tính giá trị sản xuất trung bình của từng ngành, sử dụng hàm để tính. 

d. Tính giá trị sản xuất lớn nhất từng ngành trong các năm. 

e. Tính giá trị sản xuất nhỏ nhất từng ngành trong các năm.

Lưa bảng điểm với tên em và tên lớp

HƯỚNG DẪN CHẤM KIỂM TRA THỰC HÀNH MÔN TIN 7

	Câu
	Đáp án
	Biểu điểm

	a

b

c

d

e
	Nhập trang tính và chỉnh sửa theo mẫu 

Tính tổng giá trị sản xuất từng năm của các ngành.

Tính giá trị sản xuất trung bình của từng ngành, sử dụng hàm để tính. 

Tính giá trị sản xuất lớn nhất từng ngành trong các năm. 

Tính giá trị sản xuất nhỏ nhất từng ngành trong các năm. 


	4đ

1.5đ

1.5đ

1.5đ

1.5đ


4. Cñng cè 

5. H­íng dÉn vÒ nhµ

V - Rót Kinh NghiÖm

Ngµy so¹n: 1/12








    TiÕt 34





kiÓm tra häc k× i 

phÇn lý thuyÕt
I -  Môc tiªu

1. KiÕn thøc
-  C¸c thµnh phÇn trong trang tÝnh.

-  C¸c kh¸i niÖm ®¬n gi¶n ban ®Çu cña trang tÝnh. 

2. Kü N¨ng
-  C¸c thao t¸c c¬ b¶n ban ®Çu khi lµm viÖc víi trang tÝnh.

3. Th¸i ®é
-  H×nh thµnh th¸i ®é trung thùc, nghiªm tóc khi lµm bµi.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, ®Ò bµi.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

Thi viÕt trªn giÊy.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (44')

kiÓm tra häc k× i 

phÇn lý thuyÕt
Phần 1(6đ): Học sinh khoanh vào đáp án đúng nhất

Câu 1: Muốn sửa dữ liệu trong một ô tính mà không cần nhập lại ta thực hiện thao tác nào?
A. Nháy chuột trên ô tính và sửa dữ liệu.
          B. Nháy chuột trên thanh công cụ.

C. Nháy đúp chuột trên ô tính và sửa dữ liệu.
D. Cả 3 câu trên đều đúng.

Câu 2: Tính toán với địa chỉ ô:  Khi dữ liệu ban đầu thay đổi thì kết quả tính toán sẽ:

A. Không thay đổi





B. Cần phải tính toán lại


C. Cập nhật tự động




D. Cả 3 câu trên đều sai

Câu 3: Để chỉnh độ rộng của cột vừa khít với dữ liệu  trong cột thực hiện thao tác nào?
A. Nháy chuột trên vạch phân cách cột.

           B. Nháy đúp chuột trên vạch phân cách cột.
C. Nháy chuột trên vạch phân cách dòng.
           D. Cả 3 câu trên đều sai.

Câu 4: Khối dữ liệu có dữ liệu nằm các ô E10 và B5 thì địa chỉ của khối đó là:

A. E10:B5

B. B5:E10

C. B10:E5

D. B5:E5

Câu 5: Thanh công thức cho ta biết nội dung của ô đang được chọn

A. Đúng
B. Sai

Câu 6: Nếu chọn đồng thời nhiều khối ô khác nhau, ta chọn khối đầu tiên và nhấn phím nào để lần lượt chọn các khối ô tiếp theo?
A. Alt

B. Ctrl
C. Shift
D. Phím nào cũng được

Câu 7: Hãy chỉ ra công thức tính đúng:

A. =(7+9)/2                       B. =(15+5)\3                      C. = ‘( 9 - 3)/3            D. Tất cả đều đúng

Câu 8: Giả sử cần tính tổng giá trị trong ô B2  và D2 công thức nào đúng?
A. =B2*D2              B. =B2+D2               C. B2+D2           D. =B2/D2
Câu 9: Cho giá trị ô A1 = 8, B1 = 4. Hãy chọn kết quả của công thức =A1*2 + B1*3
A. 13


B. 28


     C. 34
           D. 24

Câu 10: Các kí hiệu đúng dùng để kí hiệu các phép toán trong Excel?
A. ^ / : x -  
B. + -  .  : ^
C. + - * / ^

D. + -  ^ \ *

Câu 11: Câu phát biểu nào đúng?

A. Mỗi ô có thể có nhiều địa chỉ khác nhau  

       

 B. Dấu = là dấu cuối cùng cần gõ khi nhập công thức

C. Thanh công thức và ô tính bao giờ cũng giống nhau
       

D. Tất cả đều sai
Câu 12: Để tính giá trị trung bình của ô A1 , B1, C1,  cách tính nào sau đâu là đúng? 

A. Average(A1,B1,C1)



B. =(A1+ B1+ C1)/3


C. =Sum(A1+B1+C1)



D. Cả A, B, C đều đúng

Phần 2 (4đ). cho bảng điểm như hình sau

[image: image16.png]1

2

3 [Toan 3 3 9 92

4 [van 9 9 9 8[2

5 [Anh 10| 3 9 702

6 [sinh 7 3 3 8[2

7 [sw 6 3 7 8[2

8 [Pia 3 3 3 92

9 [Tin 9 3 3 8[2 L
10 [TD 3 3 3 8[2 1
1| Diém trung binh ca ki|? |

12 Mbn hoc c6 DTB cao nhat 2

13 Mén hoc c6 DTB thap nhat 2

14

15

16

17

18

19 I
20

21 2

W < » W)\ Sheet1 { Sheet2 [ Sheets
Draw> I | AutoShapes~ \ N O] O &1 4l £

)

) Information R
Voujust plugged a deviceino the sudio jack.

v3 e 916PM




a. Viết công thức tính ĐTB của các môn học biết rằng điểm miệng và điểm 15 phút nhân hệ số 1, điểm một 1 tiết nhân hệ số 2, điểm học kì nhân hệ số 3.

b. Viết công thức tính ĐTB cả kì biết rằng môn Toán và Văn nhân hệ số 2, các môn khác nhân hệ số 1.

c. Sử dụng hàm tìm ra môn học có ĐTB cao nhất

d. Sử dụng hàm tìm ra môn học có ĐTB thấp nhất
Lưu ý: Tất cả sử dụng địa chỉ của ô tính để tính

Đáp án biểu điểm kiểm tra kì I môn tin học 7
Năm học 2011 - 2012
	Câu
	Đáp án
	Biểu điểm

	        Phần 1
	Câu 1: C
	0.5

	
	Câu 2: C
	0.5

	
	Câu 3: B
	0.5

	
	Câu 4: B
	0.5

	
	Câu 5: A
	0.5

	
	Câu 6: B
	0.5

	
	Câu 7: A
	0.5

	
	Câu 8: B
	0.5

	
	Câu 9: B
	0.5

	
	Câu 10: C
	0.5

	
	Câu 11: D
	0.5

	
	Câu 12: B
	0.5

	Phần 2
	a. Tính đúng ĐTB của các môn

=(B3+C3+D3*2+E3*3)/7

b. Tính đúng ĐTB cả kì

=(F3*2+F4*2+F5+F6+F7+F8+F9+F10)/10

c. Tìm ra môn học có ĐTB cao nhất

=MAX(F3:F10)

d. Tìm ra môn học có ĐTB thấp nhất

=MIN(F3:F10)
	1đ

1đ

1đ

1đ


4. Cñng cè

5. H­íng dÉn vÒ nhµ

v. rót kinh nghiÖm

Ngµy so¹n: 1/12









TiÕt 35

Bµi thùc hµnh 5
chØnh söa trang tÝnh cña em

I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh ®­îc thao t¸c ®Ó ®iÓu chØnh ®é réng cña cét vµ chiÒu cao cña hµng; c¸c thao t¸c vÒ hµng vµ cét trªn mét trang tÝnh; Thùc hiÖn c¸c thao t¸c sao chÐp vµ di chuyÓn d÷ liÖu.

2. Kü N¨ng
-  HS biÕt lµm vµ lµm tèt c¸c thao t¸c ®èi víi c¸c kiÕn thøc trªn.

3. Th¸i ®é
-  Häc sinh thÊy ®­îc øng dông cña b¶ng biÓu trong sö dông tin häc.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, phßng m¸y

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5') 
- Nªu c¸ch ®iÒu chØnh ®é réng cña cét vµ chiÒu cao cña hµng? Thao t¸c cô thÓ trªn m¸y tÝnh.

3. Bµi gi¶ng míi (35')
	H§ cña GV
	Ghi B¶ng

	GV: Yªu cÇu häc sinh khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel vµ më b¶ng tÝnh Bang diem lop em ®· ®­îc l­u trong bµi thùc hµnh 4.

HS: ThùchiÖn theo yªu cÇu.

GV: ChÌn thªm cét trèng vµo tr­íc cét D (VËt Lý) ®Ó nhËp ®iÓm m«n Tin häc nh­ minh ho¹ b¶ng phô.

HS quan s¸t, ghi chÐp vµ thùc hµnh trªn m¸y.

GV: ChÌn thªm c¸c hµng trèng vµ thùc hiÖn c¸c thao t¸c ®iÒu chØnh ®é réng cña cét, ®é cao cña hµng ®Ó cã trang tÝnh t­¬ng tù nh­ h×nh 48a (B¶ng phô).

HS ghi chÐp vµ thao t¸c trªn m¸y tÝnh cña m×nh.

GV: Trong c¸c « cña cét G (Diem trung binh) cã c«ng thøc tÝnh ®iÓm trung b×nh cña häc sinh. H·y kiÓm tra c«ng thøc trong c¸c « ®ã ®Ó biÕt sau khi chÌn thªm mét cét, c«ng thøc cã cßn ®óng kh«ng? ®iÒu chØnh l¹i c«ng thøc cho ®óng.

HS thùc hµnh theo h­íng dÉn cña GV

GV: Di chuyÓn d÷ liÖu trong c¸c « cét thÝch hîp ®Ó cã trang tÝnh nh­ h×nh 48b. L­u b¶ng tÝnh cña em.

HS: Thùc hµnh

GV: TiÕp tôc sö dông b¶ng tÝnh Bang diem lop em
GV: Di chuyÓn d÷ liÖu trong cét D (Tin hoc) t¹m thêi sang cét kh¸c vµ xo¸ cét D. 

- Sö dông hµm thÝch hîp ®Ó tÝnh ®iÓm trung b×nh ba m«n häc (to¸n, VËt lý, Ng÷ V¨n) cña b¹n ®Çu tiªn trong « F5 vµ sao sao chÐp c«ng thøc ®Ó tÝnh ®iÓm trung b×nh cña c¸c b¹n cßn l¹i.

HS: thùc hµnh
	1. Bµi (15')

§iÒu chØnh ®é réng cña cét, ®é cao hµng, chÌn thªm hµng vµ cét, sao chÐp vµ di chuyÓn d÷ liÖu.
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2. Bµi 2 (20')

T×m hiÓu c¸c tr­êng hîp tù ®iÒu chØnh cña c«ng thøc khi chÌn, thªm cét míi
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§ãng b¶ng tÝnh nh­ng kh«ng l­u.



4.   Cñng cè (3')

- Nªu l¹i c¸ch ®iÒu chØnh ®é réng cña cét vµ chiÒu cao cña hµng

-  Nªu c¸ch thªm, bít 1 cét hoÆc 1 hµng


5. H­íng dÉn vÒ nhµ (1')

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

Ngµy so¹n:  15/12








TiÕt 36

Bµi thùc hµnh 5
chØnh söa trang tÝnh cña em

I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh ®­îc thao t¸c ®Ó ®iÓu chØnh ®é réng cña cét vµ chiÒu cao cña hµng; c¸c thao t¸c vÒ hµng vµ cét trªn mét trang tÝnh; Thùc hiÖn c¸c thao t¸c sao chÐp vµ di chuyÓn d÷ liÖu.

2. Kü N¨ng
-  HS biÕt lµm vµ lµm tèt c¸c thao t¸c ®èi víi c¸c kiÕn thøc trªn.

3. Th¸i ®é
-  Häc sinh thÊy ®­îc øng dông cña b¶ng biÓu trong sö dông tin häc.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, phßng m¸y

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5') 
- Nªu c¸ch thªm, bít 1 cét hoÆc 1 hµng? Thao t¸c cô thÓ trªn m¸y tÝnh.

- Nªu c¸c thao t¸c chÝnh ®Ó sao chÐp vµ thao t¸c ®Ó di chuyÓn d÷ liÖu trong b¶ng tÝnh?

3. Bµi gi¶ng míi (35')
	
	

	GV:  ChÌn thªm cét míi vµo cét E (Ng÷ v¨n) vµ sao chÐp d÷ liÖu tõ cét l­u t¹m thêi (®iÓm Tin hoc) vµo cét míi ®­îc chÌn thªm. 

KiÓm tra c«ng thøc trong cét §iÓm trung b×nh cã cßn ®óng kh«ng? Tõ ®ã rót ra kÕt luËn thªm vÒ ­u ®iÓm cña viÖc sö dông hµm thay v× sö dông c«ng thøc.

HS: thùc hµnh

GV: ChÌn thªm cét míi vµo cét §iÓm trung b×nh vµ nhËp d÷ liÖu ®Ó cã trang tÝnh nh­ h×nh 49. 

HS: thùc hµnh

GV: T¹o trang tÝnh míi víi néi dung nh­ h×nh 50.

HS: thùc hµnh

GV: Sö dông hµmh hoÆc c«ng thøc thÝch hîp trong « D1 ®Ó tÝnh tæng c¸c sè trong c¸c « A1, B1 vµ C1

HS: thùc hµnh

GV: Sao chÐp c«ng thøc trong « D1 vµo c¸c «: D2; E1; E2 vµ E3.

- Quan s¸t c¸c kÕt qu¶ nhËn ®­îc vµ gi¶i thÝch?

- Di chuyÓn c«ng thøc trong « D1 vµo « G1 vµ c«ng thøc trong « D2 vµo « G2 ( Quan s¸t kÕt qu¶ nhËn ®­îc vµ rót ra nhËn xÐt cña em.

GV: Ta nãi r»ng sao chÐp néi dung cña mét « (Hay mét khèi «) vµo mét khèi cã nghÜa r»ng sau khi chän c¸c « vµ nh¸y nót copy, ta chän khèi ®Ých tr­íc khi nh¸y nót Paste.

- Sao chÐp néi dung « A1 vµo khèi H1:J4

- Sao chÐp khèi A1:A2 vµo c¸c khèi sau: A5:A7; B5:B8; C5:C9.

GV: Quan s¸t c¸c kÕt qu¶ nhËn ®­îc vµ rót ra nhËn xÐt cña em.
	3. Bµi 3 (15')

Thùc hµnh sao chÐp vµ di chuyÓn c«ng thøc vµ d÷ liÖu

T¹o trang tÝnh
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4. Bµi 4 (20')

Thùc hµnh chÌn vµ ®iÒu chØnh ®é réng cña cét, chiÒu cao cña hµng.
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4.   Cñng cè (3')

- Nªu c¸ch chÌn thªm cét míi, c¸ch xãa


5. H­íng dÉn vÒ nhµ (1')

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

Ngµy so¹n:









       TiÕt 37

bµi 6: ®Þnh d¹ng trang tÝnh
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu thÕ nµo lµ ®Þnh d¹ng mét trang tÝnh: Thay ®æi ph«ng ch÷, cì ch÷ vµ kiÓu ch÷; c¨n lÒ « tÝnh, t« mµu nÒn, t« mµu v¨n b¶n...

2. Kü N¨ng
-  HS biÕt c¸ch ®Þnh d¹ng mét trang tÝnh theo c¸c néi dung trªn.

3. Th¸i ®é
-  Yªu thÝch bé m«n tin häc vµ thÊy ®­îc tÇm quan träng cña tin häc trong ®êi sèng.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, phßng m¸y

2. Häc sinh: SGK, vë ghi

III -  Ph­¬ng ph¸p

- Gi¸o viªn h­íng dÉn, häc sinh thùc hµnh theo nhãm 

IV -  TiÕn tr×nh bµi d¹y - gi¸o dôc

1. æn ®Þnh líp  (1’)

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40’)
	ho¹t ®éng cña gv - hs
	néi dung

	GV : ThuyÕt tr×nh vµ gi¶i thÝch cho häc sinh hiÓu thÕ nµo lµ ®Þnh d¹ng trong trang tÝnh.

HS: Chó ý l¾ng nghe

GV: Giíi thiÖu c¸c nót lÖnh trªn thanh c«ng cô dïng ®Ó dÞnh d¹ng ph«ng ch÷, cì ch÷ vµ kiÓu ch÷.

HS: Quan s¸t vµ ghi chÐp.

GV: tr×nh bµy c¸c b­íc ®Ó thay ®æi ph«ng ch÷ trong Excel.

HS : Quan s¸t vµ ghi chÐp.

GV: tr×nh bµy c¸c b­íc ®Ó thay ®æi cì ch÷ trong Excel.

HS : Quan s¸t vµ ghi chÐp.

GV: tr×nh bµy c¸c b­íc ®Ó thay ®æi cì ch÷ trong Excel.

HS : Quan s¸t vµ ghi chÐp.

GV: Giíi thiÖu c¸ch chän mµu ph«ng.

HS : Quan s¸t vµ ghi chÐp.

GV: Giíi thiÖu c¸ch c¨n lÒ trong « tÝnh.

HS : Quan s¸t vµ ghi chÐp.
	1. §Þnh d¹ng ph«ng ch÷, cì ch÷ vµ kiÓu ch÷ (25')
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.Vntime: Chän ph«ng ch÷.

12: Chän cì c÷.

B: Chän ch÷ ®Ëm

I: chän ch÷ nghiªng.

U: Chän ch÷ g¹ch ch©n.

a) Thay ®æi ph«ng ch÷

-  B­íc 1: Chän « hoÆc c¸c « cÇn ®Þnh d¹ng.

-  B­íc 2: Nh¸y mòi tªn ë « Font

-  B­íc 3 : Chän ph«ng ch÷ thÝch hîp.

b) Thay ®æi cì ch÷

- B­íc 1: Chän « hoÆc c¸c « cÇn ®Þnh d¹ng.

-  B­íc 2: Nh¸y mòi tªn ë « Size.

-  B­íc 3 : Chän cì ch÷ thÝch hîp.

c) Thay ®æi kiÓu ch÷

- B­íc 1: Chän « hoÆc c¸c « cÇn ®Þnh d¹ng.

-  B­íc 2: Nh¸y nót Bold ®Ó chän ch÷ ®Ëm, nót I ®Ó chän ch÷ nghiªng, nót U ®Ó chän ch÷ g¹ch ch©n.

* Chó ý : Cã thÓ sö dông ®ång thêi c¸c nót ®Ó cã c¸c kiÓu ch÷ thÝch hîp.

2. Chän mµu ph«ng (7')

- B­íc 1: Chän « hoÆc c¸c « cÇn ®Þnh d¹ng.

-  B­íc 2: Nh¸y nót Font Color.

-  B­íc 3 : Chän mµu ch÷ thÝch hîp.

3. C¨n lÒ trong « tÝnh (8')

- B­íc 1: Chän « hoÆc c¸c « cÇn ®Þnh d¹ng.

-  B­íc 2: Nh¸y nót Center ®Ó c¨n th¼ng gi÷a « tÝnh, nót Right ®Ó c¨n lÒ ph¶i, nót Left ®Ó c¨n lÒ tr¸i cho « tÝnh.


4. Cñng cè ( 3’ )

-  C¸ch chän mµu cho ph«ng ch÷ trong trang tÝnh.

-  C¸c thao t¸c c¨n lÒ trong « tÝnh.


5. H­íng dÉn vÒ nhµ ( 1’ )

- Học lại bài cũ.

- Thùc hµnh trªn m¸y nÕu cã ®iÒu kiÖn

- Chuẩn bị bài mới.
V - Rót Kinh NghiÖm

Ngµy so¹n:
22/ 12








        TiÕt 38

bµi 6: ®Þnh d¹ng trang tÝnh
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu ®­îc tÇm quan träng cña tÝnh to¸n trong trang tÝnh.

-  T¸c dông cña viÖc trang trÝ phï hîp cho mét trang tÝnh.

2. Kü N¨ng
-  HS biÕt c¸ch t¨ng hoÆc gi¶m sè ch÷ sè thËp ph©n, t« mµu nÒn vµ kÎ ®­êng biªn cña c¸c « tÝnh.

3. Th¸i ®é
-  Yªu thÝch bé m«n tin häc vµ thÊy ®­îc tÇm quan träng cña tin häc trong ®êi sèng.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y.

2. Häc sinh: Häc vµ chuÈn bÞ bµi ë nhµ.

III -  Ph­¬ng ph¸p

- GV gi¶i ®¸p, h­íng dÉn, häc sinh thùc hµnh theo nhãm

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò ( 5’ )

- C¸ch chän mµu cho ph«ng ch÷ trong trang tÝnh?

- C¸c thao t¸c c¨n lÒ trong « tÝnh.

 TL: Chän mµu: Chän trang tÝnh ( chän nót lÖn Font color trªn  nót lÖnh.

C¨n lÒ: Chän « hoÆc khèi « cÇn c¨n lÒ ( chän 1 trong 3 nót c¨n lÒ trªn thanh nót lÖnh.

3. Bµi gi¶ng míi ( 35’ )
	ho¹t ®éng cña gv-hs
	néi dung

	GV: Giíi thiÖu víi HS mét sè tr­êng hîp cÇn sö dông ch÷ sè thËp ph©n trong trang tÝnh.

GV: Giíi thiÖu 2 nót lÖnh ®Ó t¨ng vµ gi¶m sè ch÷ sè thËp ph©n trong trang tÝnh.

HS: quan s¸t, ghi nhí

GV: §­a ra c¸c b­íc ®Ó t¨ng hoÆc gi¶m sè ch÷ sè thËp ph©n cña d÷ liÖu sè trong trang tÝnh.

HS: quan s¸t

GV: Treo mét bøc tranh cã b¶ng tÝnh Excel ®· ®­îc trang trÝ mµu nÒn vµ ®­êng biªn ®Ó häc sinh quan s¸t vµ hái häc sinh so s¸nh khi quan s¸t víi mét trang tÝnh ch­a ®­îc trang trÝ nh­ vËy.

HS: quan s¸t

GV: §­a ra c¸c b­íc t« mµu nÒn trong trang tÝnh.

HS: quan s¸t, ghi nhí

GV : §­a ra c¸c b­íc kÎ ®­êng biªn trong trang tÝnh.

HS: quan s¸t, ghi nhí
	4. T¨ng hoÆc gi¶m sè ch÷ sè thËp ph©n cña d÷ liÖu sè

· T¨ng thªm mét ch÷ sè thËp ph©n.

· Gi¶m bít mét ch÷ sè thËp ph©n.

* Chó ý

Khi gi¶m bít mét ch÷ sè thËp ph©n, ch­¬ng tr×nh sÏ thùc hiÖn quy t¾c lµm trßn sè. 

-  B­íc 1: Chän « (hoÆc c¸c «) cÇn gi¶m hoÆc t¨ng ch÷ sè thËp ph©n.

-  B­íc 2: Nh¸y vµ nót [image: image19.png]


 ®Ó gi¶m sè ch÷ sè thËp ph©n hoÆc nót [image: image20.png]


 ®Ó t¨ng sè ch÷ sè thËp ph©n.

5. T« mµu nÒn vµ kÎ ®­êng biªn cña c¸c « tÝnh

-  Mµu nÒn cña c¸c « tÝnh gióp ta dÔ dµng ph©n biÖt vµ so s¸nh c¸c miÒn d÷ liÖu kh¸c nhau trªn trang tÝnh.

* C¸c b­íc t« mµu nÒn

- B­íc 1: Chän « hoÆc c¸c « cÇn t« mµu nÒn.

- B­íc 2: Nh¸y vµo nót Fill Colors ®Ó chon mµu nÒn.

- B­íc 3 : Nh¸y chän mµu nÒn.

* C¸c b­íc kÎ ®­êng biªn

- B­íc 1: Chän c¸c « cÇn kÎ ®­êng biªn.

- B­íc 2: Nh¸y nót Border ®Ó chän kiÓu vÏ ®­êng biªn.

- B­íc 3: Nh¸y chän kiÓu kÎ ®­êng biªn. 


4. Cñng cè ( 3’ )

-  C¸ch t¨ng, gi¶m sè ch÷ sè thËp ph©n trong trang tÝnh.

-  C¸ch t« mµu nÒn vµ kÎ ®­êng biªn cho c¸c « tÝnh trong trang tÝnh.


5. H­íng dÉn vÒ nhµ ( 1’)

- Thùc hµnh trªn m¸y .

- Học lại bài cũ và chuẩn bị kiến thức của bài mới.
V - Rót Kinh NghiÖm

Ngµy so¹n: 









      TiÕt 39

Bµi thùc hµnh 6

§Þnh d¹ng trang tÝnh
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu ®­îc tÇm quan träng cña tÝnh to¸n trong trang tÝnh.

-  T¸c dông cña viÖc trang trÝ phï hîp cho mét trang tÝnh.

2. Kü N¨ng
-  HS thùc hiÖn ®­îc c¸c thao t¸c c¨n chØnh d÷ liÖu vµ ®Þnh d¹ng trang tÝnh.

3. Th¸i ®é
-  Th¸i ®é häc tËp nghiªm tóc, thùc hµnh hiÖu qu¶.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y.

2. Häc sinh: §äc tr­íc bµi ë nhµ.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5')

-  C¸ch t¨ng, gi¶m sè ch÷ sè thËp ph©n trong trang tÝnh.

3. Bµi gi¶ng míi (35')
	ho¹t ®éng cña gv-hs
	néi dung

	GV: Ra yªu cÇu bµi thùc hµnh.

HS: thùc hiÖn yªu cÇu

GV : KiÓm tra vµ lÊy ®iÓm.


	TiÕt 1

Bµi 1. Thùc hµnh ®Þnh d¹ng v¨n b¶n vµ sè, c¨n chØnh d÷ liÖu, t« mµu v¨n b¶n, kÎ ®­êng biªn vµ t« mµu nÒn.

- Më b¶ng tÝnh B¶ng ®iÓm líp em ®· ®­îc l­u trong bµi thùc hµnh 4. Thùc hiÖn c¸c ®iÒu chØnh vµ ®Þnh d¹ng thÝch hîp ®Ó cã trang tÝnh nh­ h×nh d­íi ®©y. Cuèi cïng l­u b¶ng tÝnh.
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Yªu cÇu: Thùc hÞªn ®Þnh d¹ng víi ph«ng ch÷, cì ch÷, mµu s¾c kh¸c nhau; d÷ liÖu sè ®­îc c¨n gi÷a.

- Hµng 1 cã c¸c « tõ A1 ®Õn G1 ®­îc gép thµnh m« « vµ néi dung ®­îc c¨n gi÷a b¶ng.

C¸c cét vµ c¸c hµng ®­îc t« c¸c mµu nÒn vµ kÎ ®­êng biªn ®Ó dÔ ph©n biÖt.


4. Cñng cè (3')

-  HÖ thèng l¹i c¸c thao t¸c ®· lµm trong bµi thùc hµnh.


5. H­íng dÉn vÒ nhµ (1’)

- Thùc hµnh l¹i trªn m¸y tính.
- Chuẩn bị kiến thức của bài mới.
V - Rót Kinh NghiÖm

Ngµy so¹n: 









      TiÕt 40

Bµi thùc hµnh 6

§Þnh d¹ng trang tÝnh
I -  Môc tiªu

1. KiÕn thøc
-  Häc sinh hiÓu ®­îc tÇm quan träng cña tÝnh to¸n trong trang tÝnh.

-  T¸c dông cña viÖc trang trÝ phï hîp cho mét trang tÝnh.

2. Kü N¨ng
-  HS thùc hiÖn ®­îc c¸c thao t¸c c¨n chØnh d÷ liÖu vµ ®Þnh d¹ng trang tÝnh.

3. Th¸i ®é
-  Th¸i ®é häc tËp nghiªm tóc, thùc hµnh hiÖu qu¶.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y.

2. Häc sinh: §äc tr­íc bµi ë nhµ.

III -  Ph­¬ng ph¸p

Thùc hµnh theo nhãm – GV gi¶i ®¸p, h­íng dÉn.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh líp (1')

2. KiÓm tra bµi cò (5')

- C¸ch t« mµu nÒn vµ kÎ ®­êng biªn cho c¸c « tÝnh trong trang tÝnh.

3. Bµi gi¶ng míi (35')
	ho¹t ®éng cña gv-hs
	néi dung

	GV: Ra yªu cÇu bµi thùc hµnh.

HS: thùc hiÖn yªu cÇu

GV : KiÓm tra vµ lÊy ®iÓm.


	TiÕt 2

Bµi 2( 35 phut)

Thùc hµnh lËp trang tÝnh, sö dông c«ng thøc, ®Þnh d¹ng, c¨n chØnh d÷ liÖu « vµ t« mµu.

Khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel.

a) LËp trang tÝnh víi  d÷ liÖu c¸c n­íc trong khu vùc §«ng Nam  ¸ nh­ h×nh d­íi ®©y (Tªn c¸c n­íc trong c«t B ®­îc nhËp theo thø tù b¶ng ch÷ c¸i)
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b) LËp c«ng thøc ®Ó tÝnh mËt ®é d©n sè (ng­êi/Km2) cña Bru – n©y trong « E5. Sao chÐp c«ng thøc vµo c¸c « t­¬ng øng cña cét E ®Ó tÝnh mËt ®é d©n sè cña c¸c n­íc cßn l¹i.

c) ChÌn thªm c¸c hµng trèng cÇn thiÕt, ®iÒu chØnh hµng, cét vµ thùc hiÖn c¸c thao t¸c ®Þnh d¹ng v¨n b¶n, ®Þnh d¹ng sè ®Ó cã trang tÝnh t­¬ng tù nh­ h×nh d­íi ®©y.


4. Cñng cè (3')

-  HÖ thèng l¹i c¸c thao t¸c ®· lµm trong bµi thùc hµnh.


5. H­íng dÉn vÒ nhµ (1’)

- Thùc hµnh l¹i trªn m¸y .

- Chuẩn bị kiến thức của bài mới.

V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 41

tr×nh bµy vµ in trang tÝnh
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh ®­îc häc vµ sö dông lÖnh xem tr­íc khi in trang tÝnh, häc c¸c thao t¸c ®Þnh d¹ng trang in, giÊy in..

2. Kü N¨ng

- Häc sinh biÕt c¸ch ®Þnh d¹ng trang in, biÕt xem trang in tr­íc khi cho in ra m¸y.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh, vÊn ®¸p

IV -  TiÕn tr×nh bµi d¹y
1.  æn ®Þnh líp (1’)

2.  KiÓm tra bµi cò (5’)

Thùc hµnh trªn m¸y c¸c yªu cÇu sau:

- §Þnh d¹ng ph«ng ch÷ trong c¸c « tÝnh.

- T« mµu nÒn cho c¸c « tÝnh

- KÎ ®­êng biªn cña c¸c « tÝnh.

3. Bµi gi¶ng míi (35')
§Æt vÊn ®Ò: Trong qu¸ tr×nh thùc hiÖn in Ên v¨n b¶n, tr­íc khi thùc hiÖn in chóng ta cÇn ph¶i tr×nh bµy trang v¨n b¶n cña m×nh b»ng lÖnh xem tr­íc khi in.

	ho¹t ®éng cña gv-hs
	néi dung

	GV: ThuyÕt tr×nh vµ minh ho¹ b»ng tranh cho häc sinh thÊy h×nh ¶nh xem tr­íc khi in.

HS: quan s¸t

GV: Giíi thiÖu 1 vµi nót lÖnh chuyªn dông. (Next, Previous..)

HS: quan s¸t, l¾ng nghe

GV: Ch­¬ng tr×nh b¶ng tù ®éng ph©n trang tuú theo kÝch cì cña trang tÝnh.

GV: §Ó tù ®iÒu chØnh c¸ch ng¾t trang theo ý m×nh ta lµm nh­ sau:

- C¸c ®­êng viÒn xanh lµ c¸c dÊu ng¾t trang. Chóng cho biÕt c¸c trang in ®­îcph©n chia nh­ thÕ nµo.
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HS: quan s¸t, ghi nhí

GV: Thao t¸c trªn m¸y chiÕu cho häc sinh quan s¸t.

HS: quan s¸t, ghi nhí
	1. Xem tr­íc khi in

- Nh¸y vµo nót Print Preview (xem tr­íc khi in) trªn thanh c«ng cô.

2. §iÒu chØnh ng¾t trang

- §Ó §iÒu chØnh ng¾t trang ta sö dông lÖnh Page Break Preview (xem ng¾t trang) trong b¶ng chän View.


- HiÓn thÞ trang tÝnh trong  chÕ ®é

Page Break Preview

- §­a con trá vµo ®­êng kÎ xanh ®Ó ph©n chia.

- kÐo th¶ ®­êng xanh ®Õn vÞ trÝ tuú ý muèn.




4.  Cñng cè (3’)

- §Ó thùc hiÖn xem trang in ta lµm nh­ thÕ nµo?

- Yªu cÇu häc sinh thùc hiÖn c¸c thao t¸c ®· giíi thiÖu trªn m¸y tÝnh c¸ nh©n.

- Tr¶ lêi c©u hái 1, 2 sgk

5.  H­íng dÉn vÒ nhµ (1’)

- Häc vµ ®äc theo néi dung SGK

- Thùc hµnh nÕu cã ®iÒu kiÖn.

V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 42

tr×nh bµy vµ in trang tÝnh
I - Môc tiªu

1. KiÕn thøc

- Häc sinh ®­îc häc vµ sö dông lÖnh xem tr­íc khi in trang tÝnh, häc c¸c thao t¸c ®Þnh d¹ng trang in, giÊy in..

2. Kü N¨ng

- Häc sinh biÕt c¸ch ®Þnh d¹ng trang in, biÕt xem trang in tr­íc khi cho in ra m¸y.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p

- VÊn §¸p; Thùc hµnh.

IV -  TiÕn tr×nh bµi d¹y

1. æn ®Þnh (1’)

2.  KiÓm tra bµi cò (5’)

- Nªu t¸c dông cña lÖnh Print Preview? Thao t¸c trªn m¸y tÝnh?


3.  Bµi gi¶ng míi (35’)

	H§ cña GV
	Ghi b¶ng

	GV: Th«ng th­êng c¸c trang in ®­îc ®Æt kÝch th­íc lÒ mÆc ®Þnh vµ h­íng giÊy in lµ h­íng ®øng.
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HS: l¾ng nghe

GV: Ta cã thÓ thùc hiÖn viÖc thay ®æi c¸c lÒ vµ h­íng giÊy in cho phï hîp víi yªu cÇu cña m×nh.

HS: l¾ng nghe

GV: H­íng dÉn häc sinh c¸ch ®Ó in mét trang tÝnh ra giÊy. Lµm mÉu trùc tiÕp trªn m¸y. 

HS: quan s¸t, ghi nhí
	3. §Æt lÒ vµ h­íng giÊy in

- nh¸y chuét t¹i b¶ng chän File -> Page Setup (h×nh vÏ)


- Nh¸y chuét ®Ó më trang Margins. C¸c lÒ hiÖn t¹i ®­îc liÖt kª trong c¸c « Top, Bottom. Right, Left.

- Thay ®æi c¸c th«ng s« trong c¸c « Top, Bottom. Right, Left  ®Ó thiÕt ®Æt lÒ.

* §Ó thay ®æi h­íng giÊy:

- Nh¸y chuét më trang Page 
- Chän Potrait cho h­íng giÊy ®øng hoÆc Landscape cho h­íng giÊy n»m.


4. In trang tÝnh

- Nh¸y chuét vµo nót Print  trªn thanh c«ng cô ®Ó in trang tÝnh. (hoÆc sö dông b¶ng chän)


4.  Cñng cè (3’)

- §Ó thùc hiÖn xem trang in ta lµm nh­ thÕ nµo?

- Yªu cÇu häc sinh thùc hiÖn c¸c thao t¸c ®· giíi thiÖu trªn m¸y tÝnh c¸ nh©n.

- Tr¶ lêi c©u hái 3, 4 sgk

5.  H­íng dÉn vÒ nhµ (1’)

- Häc vµ ®äc theo néi dung SGK.

- Thùc hµnh lại bài cũ.

V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 43

Bµi thùc hµnh 7

Danh s¸ch líp em
I - Môc tiªu

1. KiÕn thøc

- Häc sinh biÕt vËn dông lÖnh xem tr­íc khi in trang tÝnh, c¸c thao t¸c ®Þnh d¹ng trang in, giÊy in..

2. Kü N¨ng

- BiÕt kiÓm tra trang tÝnh tr­íc khi in.

- ThiÕt lËp lÒ vµ h­íng giÊy cho trang in

- BiÕt ®iÒu chØnh c¸c dÊu ng¾t trang phï hîp víi yªu cÇu in.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p

Thùc hµnh trùc tiÕp trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng

1.  æn ®Þnh (1’)

2.  KiÓm tra bµi cò (5’)

- Lµm c¸ch nµo ®Ó cã thÓ ®iÒu chØnh trang in hîp lý?


3. Bµi gi¶ng míi (35’)

	ho¹t ®éng cña gv-hs
	néi dung

	GV: Yªu cÇu HS  gâ b¶ng tÝnh B¶ng ®iÓm líp em.

HS: thùc hiÖn yªu cÇu

GV: yªu cÇu HS  sö dông c«ng cô Print Preview ®Ó xem tr­íc khi in

HS : thùc hµnh

GV: yªu cÇu HS sö dông nót lÖnh ng¾t trang

HS: thùc hµnh


	Bµi tËp 1. KiÓm tra trang tÝnh tr­íc khi in

a) Sö dông c«ng cô Print Preview ®Ó xem trang tÝnh tr­íc khi in.

Quan s¸t sù thay ®æi cña mµn h×nh vµ c¸c ®èi t­îng trªn mµn h×nh. Sö dông c¸c nót lÖnh thay ®æi cña mµn h×nh vµ c¸c ®èi t­îng trªn mµn h×nh. Sö dông c¸c nót lÖnh Next vµ Previous trªn thanh c«ng cô ®Ó xem c¸c trang in.

b) T×m hiÓu chøc n¨ng cña c¸c nót lÖnh kh¸c trªn thanh c«ng cô Print Preview


c) Sö dông nót lÖnh ®Ó xem c¸c dÊu ng¾t trang.

d) Ghi nhËn c¸c khiÕm khuyÕt vÒ ng¾t trang trªn c¸c trang in; liÖt kª nh÷ng h­íng kh¾c phôc khuyÕt ®iÓm ®ã.


4. Cñng cè (3’)

- Xem l¹i c¸c néi dung trong tiÕt võa thùc hµnh

5. H­íng dÉn vÒ nhµ (1’)

- Xem l¹i c¸c néi dung thùc hµnh trong SGK.

- Thùc hµnh l¹i ë nhµ nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 44

Bµi thùc hµnh 7

Danh s¸ch líp em
I - Môc tiªu

1. KiÕn thøc

- Häc sinh biÕt vËn dông lÖnh xem tr­íc khi in trang tÝnh, c¸c thao t¸c ®Þnh d¹ng trang in, giÊy in..

2. Kü N¨ng

- BiÕt kiÓm tra trang tÝnh tr­íc khi in.

- ThiÕt lËp lÒ vµ h­íng giÊy cho trang in

- BiÕt ®iÒu chØnh c¸c dÊu ng¾t trang phï hîp víi yªu cÇu in.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p

Thùc hµnh trùc tiÕp trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng

1.  æn ®Þnh (1’)

2.  KiÓm tra bµi cò (5’)

- Lµm thÕ nµo ®Ó cã thÓ thay ®æi h­íng cña giÊy in?


3. Bµi gi¶ng míi (35’)

	ho¹t ®éng cña gv-hs
	néi dung

	GV: Yªu cÇu HS tiÕp tôc sö dông b¶ng tÝnh B¶ng ®iÓm líp em. 

- ThiÕt ®Æt lÒ trang in, h­íng giÊy in vµ ng¾t trang in

HS: thùc hiÖn yªu cÇu

GV: yªu cÇu häc sinh lµm bµi tËp 3 thùc hiÖn c¸c yªu cÇu cña bµi

HS: thùc hiÖn yªu cÇu
	Bµi tËp 2. ThiÕt ®Æt lÒ trang in, h­íng giÊy vµ ®iÒu chØnh c¸c dÊu ng¾t trang.


Bµi tËp 3: §Þnh d¹ng vµ tr×nh bµy trang tÝnh.

a) Thùc hiÖn c¸c ®Þnh d¹ng cÇn thiÕt ®Ó cã trang tÝnh t­¬ng tù h×nh 81 ( sgk).

b) Xem tr­íc trang in, kiÓm tra c¸c dÊu ng¾t trang vµ thiÕt ®Æt h­íng trang n»m ngang ®Ó in hÕt c¸c cét trªn mét trang, thiÕt ®Æt lÒ thÝch hîp vµ lùa chän ®Ó in néi dung gi÷a trang giÊy theo chiÒu ngang.

c) L­u b¶ng tÝnh vµ thùc hiÖn lÖnh in.


4. Cñng cè (3’)

- Xem l¹i c¸c néi dung trong tiÕt võa thùc hµnh

5. H­íng dÉn vÒ nhµ (1’)

- Xem l¹i c¸c néi dung thùc hµnh trong SGK.

- Thùc hµnh l¹i ë nhµ nÕu cã ®iÒu kiÖn

V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 45

bµi 8: s¾p xÕp vµ läc d÷ liÖu
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh ®­îc trang bÞ kiÕn thøc vÒ s¾p xÕp vµ läc d÷ liÖu trang tÝnh..

2. Kü N¨ng

- BiÕt s¾p xÕp d÷ liÖu trong trang tÝnh.

- BiÕt läc d÷ liÖu theo yªu cÇu cô thÓ.

- Tõ viÖc s¾p xÕp d÷ liÖu, häc sinh cã thÓ so s¸nh d÷ liÖu trong cïng mét b¶ng tÝnh.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, phßng m¸y, tranh vÏ.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh -  vÊn ®¸p - Thùc hµnh.

IV -  TiÕn tr×nh bµi gi¶ng
1. æn ®Þnh líp (1’)

2.  KiÓm tra bµi cò (5’)

- Më mét b¶ng tÝnh bÊt kú. Thùc hiÖn thao t¸c thay ®æi h­íng cña giÊy in?


3. Bµi gi¶ng míi (35’)

	Ho¹t ®éng cña GV-hs
	néi dung

	GV: S¾p xÕp d÷ liÖu lµ ho¸n ®æi vÞ trÝ c¸c hµng ®Ó gi¸ trÞ d÷ liÖu trong mét hay nhiÒu cét ®­îc s¾p xÕp theo thø tù t¨ng dÇn hoÆc gi¶m dÇn.

HS: l¾ng nghe

GV: §­a vÝ dô vÏ b»ng tranh vµ cho HS quan s¸t.

HS: quan s¸t

GV: §Ó s¾p xÕp thø h¹ng cña HS theo ®iÓm Trung b×nh ta thùc hiÖn nh­ sau:

1. Nh¸y chuét chän mét « trong cét ®iÓm trung b×nh

2. Nh¸y nót      trªn thanh c«ng cô

Ta sÏ nhËn ®­îc kÕt qu¶ t­¬ng tù nh­ h×nh minh ho¹.

HS: quan s¸t, ghi l¹i
	1. S¾p xÕp d÷ liÖu

- Nh¸y chuét chän mét « trong cét cÇn s¾p xÕp d÷ liÖu

- Nh¸y nót      hay       trªn thanh c«ng cô ®Ó s¾p xÕp theo thø tù t¨ng dÇn hoÆc gi¶m dÇn.

VÝ dô: Trang tÝnh d­íi ®©y lµ kÕt qu¶ häc tËp cña  mét sè HS líp 7a.


Sau khi s¾p xÕp ®­îc kÕt qu¶:





4. Cñng cè (3’)

- Yªu cÇu: Tù lËp b¶ng tÝnh t­¬ng tù nh­ b¶ng tÝnh trªn vµ thùc hiÖn s¾p xÕp theo thø tù t¨ng dÇn vµ gi¶m dÇn.

5. H­íng dÉn vÒ nhµ (1’)

- Xem l¹i c¸c thao t¸c ®Ó s¾p xÕp d÷ liÖu trong b¶ng tÝnh.

- Thùc hµnh lại bài cũ.
V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 46

bµi 8: s¾p xÕp vµ läc d÷ liÖu
I - Môc tiªu
1. KiÕn thøc

- Häc sinh ®­îc trang bÞ kiÕn thøc vÒ s¾p xÕp vµ läc d÷ liÖu trang tÝnh..

2. Kü n¨ng

- BiÕt s¾p xÕp d÷ liÖu trong trang tÝnh.

- BiÕt läc d÷ liÖu theo yªu cÇu cô thÓ.

- Tõ viÖc s¾p xÕp d÷ liÖu, häc sinh cã thÓ so s¸nh d÷ liÖu trong cïng mét b¶ng tÝnh.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh - vÊn ®¸p - Thùc hµnh.

IV -  TiÕn tr×nh bµi gi¶ng
1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò (5’)

-Më b¶ng tÝnh B¶ng ®iÓm líp em. Thùc hiÖn thao t¸c s¾p xÕp d÷ liÖu t¨ng dÇn theo §iÓm trung b×nh.


3. Bµi gi¶ng míi (35‘)

	Ho¹t ®éng cña GV-hs
	néi dung

	GV: Läc d÷ liÖu lµ chän vµ chØ hiÖn thÞ c¸c hµng tho¶ m·n c¸c tiªu chuÈn nhÊt ®Þnh nµo ®ã.

-  VÝ dô: Läc ra c¸c häc sinh cã ®iÓm trung b×nh tµ 8.8 trë lªn (h×nh minh ho¹)


HS: quan s¸t, ghi nhí

GV: H­íng dÉn häc sinh thao t¸c trªn m¸y tÝnh.

HS: quan s¸t, thùc hµnh theo

GV: H­íng dÉn häc sinh c¸ch läc hµng cã gi¸ trÞ lín nhÊt hay nhá nhÊt.

HS: quan s¸t, ghi nhí


	2. Läc d÷ liÖu

Thùc hiÖn c¸c thao t¸c sau:

B­íc 1. ChuÈn bÞ:

- Nh¸y chuét chän 1 mét « trong vïng cã d÷ liÖu cÇn läc.

- Më b¶ng chän Data -> Filter( AutoFilter.

sÏ xuÊt hiÖn c¸c mòi tªn nh­ b¶ng sau:


B­íc 2. Läc:

- Chän tiªu ®Ò ®Ó läc
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 trªn hµng tiªu ®Ò cét. (h×nh vÏ).

\

- KÕt thóc läc: Chän Data ( Filter ( Show All (HiÓn thÞ tÊt c¶).

3. Läc c¸c hµng cã gi¸ trÞ lín nhÊt hay nhá nhÊt

- Khi nh¸y chuét ë mòi tªn trªn tiªu ®Ò cét cã c¸c lùa chän sau:

+ Top 10: Läc c¸c hµng cã gi¸ trÞ d÷ liÖu thuéc mé sè gi¸ trÞ.

VD: Chän 3 häc sinh cã §TB lín nhÊt: Chän Top 10 ( Chän « thø 2 cã gi¸ trÞ lµ 3 ( OK.




4.  Cñng cè (3’)

1. Tr¶ lêi c©u hái 2,3,4 sgk

2. Yªu cÇu: Tù lËp b¶ng tÝnh t­¬ng tù nh­ b¶ng tÝnh trªn vµ thùc hiÖn läc d÷ liÖu.

5. H­íng dÉn vÒ nhµ (1’)

- Xem l¹i c¸c thao t¸c ®Ó s¾p xÕp d÷ liÖu vµ läc d÷ liÑu trong b¶ng tÝnh

- Thùc hành bài cũ.
V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 47

Bµi thùc hµnh 8

ai lµ ng­êi häc giái
I - Môc tiªu
1. KiÕn thøc

-  BiÕt ®­îc c¸c thao t¸c s¾p xÕp d÷ liÖu.

-  BiÕt kh¸i niÖm läc d÷ liÖu.

2. Kü n¨ng

- Thùc hiÖn ®­îc thao t¸c s¾p xÕp d÷ liÖu trong trang tÝnh.

- BiÕt c¸ch läc d÷ liÖu theo yªu cÇu cô thÓ.

- Tõ viÖc s¾p xÕp d÷ liÖu, häc sinh cã thÓ so s¸nh d÷ liÖu trong cïng mét b¶ng tÝnh.

3. Th¸i ®é

- Nghiªm tóc häc tËp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh - vÊn ®¸p - Thùc hµnh.

IV -  TiÕn tr×nh bµi gi¶ng
1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40‘)

	ho¹t ®éng cña gv-hs
	néi dung

	GV : Yªu cÇu häc sinh khëi fféng ch­¬ng tr×nh b¶ng tÝnh Excel, më bµi Bang diem lop em vµ thùc hµnh theo yªu cÇu.

HS: thùc hiÖn yªu cÇu

GV : H­íng dÉn s¬ bé häc sinh c¸ch thùc hiÖn bµi.

HS: l¾ng nghe

GV : Giíi thiÖu bµi tËp 2 trang 77 SGK vµ ra yªu cÇu cña bµi.

HS: l¾ng nghe vµ thùc hiÖn

GV : H­íng dÉn häc sinh c¸ch lµm bµi.

HS: l¾ng nghe, quan s¸t vµ thùc hiÖn theo


	TiÕt 1

1. Bµi 1

a) Thùc hiÖn c¸c thao t¸c s¾p xÕp theo ®iÓm c¸c m«n häc vµ diÎm trung b×nh.

b) Thùc hiÖn c¸c thao t¸c läc d÷ liÖu ®Ó chän c¸c b¹n cã ®iÓm 10 m«n Tin häc.

c) Läc ra c¸c b¹n cã ®iÓm trung b×nh c¶ n¨m lµ hai ®iÓm thÊp nhÊt.

2. Bµi 2

a) Më b¶ng t×nh Cac nuoc DNA ®· cã trong Bµi thuc hanh 6.

b) H·y s¾p xÕp c¸c n­íc theo.

- DiÖn tÝch t¨ng dÇn hoÆc gi¶m dÇn.

- D©n sè t¨ng dÇn hÆc gi¶m dÇn.

- MËt ®é d©n sè t¨ng dÇn hÆc gi¶m dÇn.

- TØ lÖ d©n sè thµnh thÞ t¨ng dÇn hÆc gi¶m dÇn. 


4. Cñng cè (3’)

- C¸c thao t¸c c¬ b¶n víi x¾p xÕp vµ läc d÷ liÖu trªn trang tÝnh.

5. H­íng dÉn vÒ nhµ (1’)

- ¤n l¹i c¸c kiÕn thøc tõ bµi 6 ®Ó chuÈn bÞ cho kiÓm tra mét tiÕt.

V - Rót Kinh NghiÖm

Ngµy so¹n:









 TiÕt 48

Bµi thùc hµnh 8

ai lµ ng­êi häc giái
I - Môc tiªu
1. KiÕn thøc

-  BiÕt ®­îc c¸c thao t¸c s¾p xÕp d÷ liÖu.

-  BiÕt kh¸i niÖm läc d÷ liÖu.

2. Kü n¨ng

- Thùc hiÖn ®­îc thao t¸c s¾p xÕp d÷ liÖu trong trang tÝnh.

- BiÕt c¸ch läc d÷ liÖu theo yªu cÇu cô thÓ.

- Tõ viÖc s¾p xÕp d÷ liÖu, häc sinh cã thÓ so s¸nh d÷ liÖu trong cïng mét b¶ng tÝnh.

3. Th¸i ®é

- Nghiªm tóc häc tËp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ bµi ë nhµ. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh - vÊn ®¸p - Thùc hµnh.

IV -  TiÕn tr×nh bµi gi¶ng
1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40‘)

	ho¹t ®éng cña gv-hs
	néi dung

	GV: Nh¾c l¹i kiÕn thøc vÒ s¾p xÕp nh­ ®· thùc hµnh ë tiÕt tr­íc vµ ra tiÕp bµi yªu cÇu häc sinh thùc hµnh víi c«ng cô lµ läc d÷ liÖu. 

HS: thùc hµnh

GV: H­íng dÉn häc sinh quan s¸t bµi tËp 3 – SGK trang 78.

- §­a ra mét sè chØ dÉn ®Ó c¸c em hiÓu vµ cã kh¶ n¨ng thùc hµnh ®­îc bµi 

* Chó ý: Trong qu¸ tr×nh häc sinh lµm bµi gi¸o viªn ®i l¹i quan s¸t vµ cã thÓ gîi ý khi c¸c em gÆp v­íng m¾c.

HS: l¾ng nghe, thùc hµnh
	TiÕt 2

1. Bµi 2 (tiÕp)

c) Sö dông c«ng cô ®Ó läc

- Läc ra c¸c n­íc cã diÖn tÝch lµ n¨m diÖn tÝch lín nhÊt.

- Läc ra c¸c n­íc cã sè d©n lµ ba sè d©n Ýt nhÊt.

- Läc ra c¸c n­íc cã mËt ssé d©n sè la ban mËt ®é d©n sè cao nhÊt.

2. Bµi 3

T×m hiÓu thªm vÒ s¾p xÕp vµ läc s÷ liÖu

(SGK trang 78)


4. Cñng cè (3’)

- C¸c thao t¸c c¬ b¶n víi x¾p xÕp vµ läc d÷ liÖu trªn trang tÝnh.

5. H­íng dÉn vÒ nhµ (1’)

- ¤n l¹i c¸c kiÕn thøc tõ bµi 6 ®Ó chuÈn bÞ cho kiÓm tra mét tiÕt.

V - Rót Kinh NghiÖm

Ngµy so¹n: 




              




          TiÕt 49

KiÓm tra mét tiÕt

I - Môc tiªu

1. KiÕn thøc 

- KiÓm tra viÖc n¾m b¾t kiÕn thøc cña häc sinh vÒ ®Þnh d¹ng, tr×nh bµy, in Ên… ®Ó cã ph­¬ng ph¸p ®iÒu chØnh vÒ viÖc häc cña häc sinh còng nh­ viÖc d¹y cña gi¸o viªn.

2. Kü N¨ng

- Cã kü n¨ng lµm mét bµi kiÓm tra.

3. Th¸i ®é

- Nghiªm tóc, trung thùc khi lµm bµi.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, ®Ò kiÓm tra, ®¸p ¸n

2. Häc sinh: ChuÈn bÞ kiÕn thøc c¸c bµi 6, 7, 8.

III - Ph­¬ng ph¸p

- KiÓm tra viÕt

IV - TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp 

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (45’)

KiÓm tra 1 tiÕt

Gi¸o viªn ph¸t ®Ò bµi, gi¸m s¸t viÖc lµm bµi cña häc sinh.

§Ò bµi

PhÇn I (4 ®iÓm): Tr¾c nghiÖm

1. §Ó më b¶ng tÝnh ®· cã trong m¸y ta sö dông lÖnh nµo?

A. New

B. Save

C. Open

D. Close

2. C¸c nót lÖnh B I U n»m trªn thanh nµo?


A. Thanh tiªu ®Ò



B. Thanh c«ng thøc


C. Thanh b¶ng chän


D. Thanh c«ng cô

3. §Ó ng¾t trang tÝnh ta sö dông lÖnh nµo?


A. Page Break Preview


B. Print Preview


C. Print




D. C¶ A, B, C ®Òu sai

4. Nót lÖnh nµo dïng ®Ó s¾p xÕp theo thø tù gi¶m dÇn?


A. 
[image: image23.png]







B.     [image: image24.png]




C. 
[image: image25.png]







D. C¶ A, B, C ®Òu sai

5. §Ó läc d÷ liÖu ta sö dông lÖnh nµo?


A. Data -> Sort



B. Data -> Filter -> Auto Filter


C. C¶ A, B ®Òu ®óng


D. C¶ A, B ®Òu sai

6. Muèn ®Æt lÒ ph¶i cña b¶ng tÝnh ta chän:


A. Top

B. Bottom

C. Left

D. Right

7. §Ó gép c¸c « vµ c¨n chØnh néi dung vµo chÝnh gi÷a « gép ®ã ta sö dông nót lÖnh:


A. 
[image: image26.png]




B.
[image: image27.png]




C. [image: image28.png]





D.  [image: image29.png]



8. §Ó t¨ng ch÷ sè thËp ph©n ta sö dông lÖnh:


A.  [image: image30.png]




B. [image: image31.png]




C.  [image: image32.png]



D. C¶ A, B, C ®Òu sai

9. Muèn kiÓm tra néi dung ®­îc in ra tr­íc khi in em chän

A. Nh¸y chuét vµo nót lÖnh Preview 

B. Chän File, Print.

C. Chän File, page set up, page, print preview.

D. C©u A vµ B ®óng.

10. Khi läc d÷ liÖu em cã thÓ

A. S¾p xÕp l¹i d÷ liÖu t¨ng hoÆc gi¶m.

B. Cã thÓ tïy chän víi custom víi c¸c ®iÒu kiÖn or hoÆc and.

C. Kh«ng thÓ s¾p xÕp l¹i d÷ liÖu.

D. C©u A vµ B ®óng.

11.Nh÷ng c¸ch nµo trong c¸c c¸ch sau ®©y dïng ®Ó in trang b¶ng tÝnh?

A. NhÊn tæ hîp phÝm (Ctrl + P).

B. Nh¸y chuét chän File -> Print.

C. Nh¸y chuét chän File -> Exit.

D. C¶ A vµ B.

12. §Ó ®Æt lÒ vµ h­íng giÊy in cho mét trang b¶ng tÝnh ta ph¶i thùc hiÖn.

A. File -> New.



C. File -> Exit.

B. File -> Open.



D. File -> Page Setup. 

PhÇn II (6 ®iÓm): Tù luËn

C©u 1 (2 ®iÓm): Gi¶ sö « A1 cã nÒn mµu vµng vµ ch÷ mµu ®á. ¤ A3 cã nÒn mµu tr¾ng, ch÷ mµu ®en. Em h·y nªu c¸ch sao chÐp néi dung ë « A1 vµo « A3 vµ thö dù ®o¸n sau khi sao chÐp « A3 cã nÒn vµ ph«ng ch÷ mµu g×?

C©u 2 (4 ®iÓm): Cho b¶ng ®iÓm häc sinh

B¶ng ®iÓm líp 7A

	STT
	Hä vµ tªn
	To¸n
	V¨n
	Tin
	§TB

	1
	NguyÔn Hoµ An
	8
	7
	8
	7.7

	2
	Lª Th¸i Anh
	8
	5
	7
	6.7

	3
	TrÇn Quèc B×nh
	8
	9
	9
	8.7

	4
	Ph¹m Ngäc Mai
	9
	9
	10
	9.3

	5
	Bïi Thu Hµ
	7
	6
	8
	7.0


a) Nªu c¸ch s¾p xÕp cét §TB theo thø tù t¨ng dÇn.

b) Nªu c¸ch läc häc sinh cã §TB lµ 9.3.

c) Sau khi läc, ®Ó hiÓn thÞ tÊt c¶ b¶ng ®iÓm ta lµm thÕ nµo?

d) §Ó tho¸t khái chÕ ®é läc ta lµm thÕ nµo?

§¸p ¸n + BiÓu ®iÓm

	C©u
	§¸p ¸n
	BiÓu ®iÓm

	PhÇn I.     1

2

3

4

5

6

7
	C

D

A

B

B

D

C

A

A

D

D

D
	0.5

0.5

0.5

0.5

0.5

0.5

0.5

0.5

0.5

0.5

0.5

0.5

	8

9

10

11

12
	
	

	PhÇn II. 
	
	

	2
	a) Nh¸y chuét « trong cét  §TB, nh¸y nót lÖnh s¾p xÕp t¨ng dÇn.
	1

	
	b)  Data -> Filter -> AutoFilter -> Top 10 -> 1. Ok
	1

	
	c) Data -> Filter -> AutoFilter -> Show All.
	1

	
	d) Data -> Filter -> AutoFilter. 
	1


4. Cñng cè 
- Gi¸o viªn thu bµi khi hÕt giê, nhËn xÐt ý thøc lµm bµi cña häc sinh.

5. H­íng dÉn vÒ nhµ 
- H­íng dÉn häc sinh chuÈn bÞ bài: Học toán với toolkit math
.          V – Rót KinhNghiÖm

Ngµy so¹n: 
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häc to¸n víi toolkit math
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh ®­îc tiÕp cËn vµ lµm quen víi phÇn mÒm häc to¸n ®¬n gi¶n nh­ng h÷u Ých, ®Æc biÖt hç trî cho viÖc gi¶i b¶i tËp, tÝnh to¸n vµ vÏ ®å thÞ.

2. Kü N¨ng

- BiÕt khëi ®éng phÇn mÒm, nhËn d¹ng ®­îc mµn h×nh lµm viÖc cña phÇn mÒm.

- BiÕt tÝnh to¸n b»ng c¸c lÖnh ®¬n gi¶n vµ c¸c lÖnh phøc t¹p.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh giê d¹y – gi¸o dôc
1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV – HS
	Néi dung

	GV: Giíi thiÖu t¸c dông cña phÇn mÒm 

HS: l¾ng nghe, ghi l¹i

GV: H­íng dÉn häc sinh c¸c thao t¸c c¸ch khëi ®éng phÇn mÒm.

HS: quan s¸t, thùc hµnh theo

GV: Giíi thiÖu mµn h×nh lµm viÖc chÝnh cña phÇn mÒm 

- Thanh b¶ng chän

HS: l¾ng nghe, quan s¸t mµn h×nh

GV: giíi thiÖu cöa sæ dßng lÖnh

HS: quan s¸t trªn mµn h×nh

GV: giíi thiÖu cöa sæ lµm viÖc chÝnh

HS: quan s¸t trªn mµn h×nh

GV: giíi thiÖu cöa sæ vÏ ®å thÞ

HS: quan s¸t


	1. Giíi thiÖu phÇn mÒm (10’)

- PhÇn mÒm  ToolKit Math lµ lµ phÇn mÒm häc to¸n ®¬n gi¶n nh­ng h÷u Ých; lµ mét c«ng cô hç trî gi¶i bµi tËp, tÝnh to¸n, vÏ ®å thÞ..

2. Khëi ®éng phÇn mÒm (10’)

- Nh¸y ®óp chuét vµo biÓu t­îng trªn mµn h×nh.

- Nh¸y ®óp chuét vµo « c«ng cô ®¹i sè ®Ó b¾t ®Çu lµm viÖc víi phÇn mÒm.

3. Mµn h×nh lµm viÖc cña phÇn mÒm (20’)

a) Thanh b¶ng chän

Thùc hiÖn c¸c lÖnh chÝnh cña phÇn mÒm.

b) Cöa sæ dßng lÖnh

N»m ë phÝa d­íi cña mµn h×nh, ®­îc ng­êi dïng gâ c¸c dßng lÖnh vµ cho kÕt qu¶ trªn cöa sæ lµm viÖc chÝnh.

c) Cöa sæ lµm viÖc chÝnh

Thùc hiÖn tÊt c¶ c¸c lÖnh ®· thùc hiÖn cña phÇn mÒm.

d) Cöa sæ vÏ ®å thÞ

Lµ n¬i thÓ hiÖn kÕt qu¶ cña lÖnh vÏ ®å thÞ.

t¹i Expression to simplify -> OK.


4. Cñng cè (3’)

- Nh¾c l¹i c¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña phÇn mÒm

5. H­íng dÉn vÒ nhµ (1’)

- Thùc hµnh nÕu cã ®iÒu kiÖn, ®äc phÇn cßn l¹i cña bµi

V. Rót kinh nghiÖm

Ngµy so¹n:









         TiÕt 51
häc to¸n víi toolkit math
I. Môc tiªu
1. KiÕn thøc

- TiÕp cËn vµ lµm quen víi phÇn mÒm häc to¸n ®¬n gi¶n, h÷u Ých. Hç trî cho viÖc gi¶i b¶i tËp, tÝnh to¸n vµ vÏ ®å thÞ.

2. Kü N¨ng

- BiÕt tÝnh to¸n b»ng c¸c lÖnh ®¬n gi¶n vµ c¸c lÖnh phøc t¹p.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, SGK, Phßng m¸y.

2. Häc sinh: SGK, vë ghi. 

III. Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc
1. æn ®Þnh líp (1’)

2. KiÓm ra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV - hs
	Néi dung

	GV: §­a ra bµi tËp ®Ó HS thùc hiÖn phÐp tÝnh.

a) 1/5+3/4

b) 4.8+3.4+0.7

c) 2^4+(3/4)^2

HS: Thùc hiÖn tÝnh to¸n trªn phÇn mÒm

GV: §Ó thùc hiÖn c¸c phÐp to¸n nµy ta sö dông lÖnh nµo ®Ó tÝnh? Nªu c¸c thùc hiÖn?

HS: tr¶ lêi

GV: Yªu cÇu HS thùc hiÖn tÝnh to¸n theo 2 c¸ch vµ c¸c m¸y ®­a ra kÕt qu¶.

HS: thùc hiÖn tÝnh to¸n

GV: §Ó vÏ ®å thÞ hµm sè ta cã mÊy c¸ch?

HS: tr¶ lêi

GV:  Yªu cÇu HS vÏ c¸c ®å thÞ: 

a) y=3x+1

b) y=3x^2-3

GV: Gi¸m s¸t viÖc lµm bµi cña HS. H­íng dÉn HS khi cÇn thiÕt.
	4. C¸c lÖnh tÝnh to¸n ®¬n gi¶n

a) TÝnh to¸n c¸c biÓu thøc ®¬n gi¶n

- PhÇn mÒm cã kh¶ n¨ng tÝnh to¸n chÝnh x¸c c¸c biÓu thøc ®¹i sè chøa c¸c sè nghuyªn hoÆc c¸c ch÷ sè thËp ph©n.

- NhËp phÐp to¸n tõ cöa sæ dßng lÖnh.

- NhËp phÐp to¸n tõ thanh b¶ng chän: Algebra -> Simplify -> Gâ BT t¹i Expression to simplify -> OK.

b) VÏ ®å thÞ

-  §Ó vÏ ®å thÞ mét hµm sè ®¬n gi¶n ta dïng lÖnh Plot tõ cöa sæ dßng lÖnh.

Vd: Plot y=3x+1

-  §å thÞ hµm sè xuÊt hiÖn trªn cöa sæ vÏ ®å thÞ cña phÇn mÒm.




4. Cñng cè ( 3’ )

- Nh¾c l¹i vÒ c¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña phÇn mÒm. 

-  C¸c lÖnh tÝnh to¸n ®¬n gi¶n.

5. H­íng dÉn häc ë nhµ ( 1’ )

- Thực hành lại những phần đã học
V. Rót kinh nghiÖm

Ngµy so¹n: 
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häc to¸n víi toolkit math
I. Môc tiªu
1. KiÕn thøc

- Häc sinh thùc hiÖn vµ thao t¸c ®­îc víi c¸c lÖnh phøc t¹p h¬n.

- C¸c chøc n¨ng kh¸c cña phÇn mÒm.

- Thùc hiÖn ®­îc c¸ch ®Æt nÐt vÏ, mµu s¾c, c¸ch sö dông lÖnh xo¸ Clear.

2. Kü N¨ng

- H×nh thµnh kü n¨ng ham mª tÝnh to¸n, häc hái. T­ duy logic, s¸ng t¹o.

- Thµnh th¹o c¸c thao t¸c víi c¸c lÖnh tÝnh to¸n tõ ®¬n gi¶n ®Õn phøc t¹p.

3. Th¸i ®é

- TËp trung, nghiªm tóc, chó ý cao trong giê häc. 

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi. 

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò 
3. Bµi gi¶ng míi (40’)
	Ho¹t ®éng cña GV - hs
	Néi dung

	GV: LÖnh Simplify kh«ng nh÷ng cho phÐp tÝnh to¸n víi c¸c phÐp tÝnh ®¬n gi¶n mµ cßn cã thÓ th­c hiÖn nhiÒu phÐp tÝnh phøc t¹p víi c¸c lo¹i biÓu thøc ®¹i sè kh¸c nhau.

Vd:(((3/2)+(4/5))/((2/3)-  (1/5)))+17/20

HS: l¾ng nghe, ghi l¹i

GV: Giíi thiÖu lÖnh Expand vµ c¸ch thùc hiÖn lÖnh.

HS: l¾ng nghe, ghi l¹i

GV: Rót gän biÓu thøc ta lµm nh­ thÕ nµo? KÕt qu¶ sÏ xuÊt hiÖn ë ®©u?

HS: tr¶ lêi

GV: Giíi thiÖu lÖnh Solve.

HS: nghe, ghi l¹i

GV: Gäi HS lªn lµm.

HS: lµm bµi tËp

GV: Giíi thiÖu lÖnh Make.

HS: nghe, ghi l¹i

GV: Gäi HS lªn b¶ng thùc hiÖn phÐp to¸n.

HS: lªn lµm

GV: nhËn xÐt bµi lµm cña HS

HS: l¾ng nghe, ghi l¹i
	5. C¸c lÖnh tÝnh to¸n n©ng cao

a) BiÓu thøc ®¹i sè

-  Có ph¸p.

-  Simplify <BiÓu thøc>

Vd: 

Simplify (3/2+4/5)/(2/3-  1/5)+17/20

KÕt luËn: Ta cã thÓ thùc hiÖn ®­îc mäi tÝnh to¸n trªn c¸c biÓu thøc ®¹i sè víi ®é phøc t¹p bÊt kú.

b) TÝnh to¸n víi ®a thøc Expand

-  Có ph¸p: Expand <BiÓu thøc>

-  Algebra -> Expand -> NhËp BT -> OK.

Vd: Expand (2*x^2*y)*(9*x^3*y^2)

c) Gi¶i ph­¬ng tr×nh ®¹i sè

- Có ph¸p: Solve <Ph­¬ng tr×nh> <Tªn biÕn>.

Vd: Solve 3*x+1=0x

d) §Þnh nghÜa ®a thøc vµ ®å thÞ

-  Có ph¸p: Make <Tªn hµm> <§a thøc>

Vd: Make P(x) 3*x-  2


4.  Cñng cè (3’)

- Nh¾c l¹i c¸c kiÕn thøc ®· häc víi phÇn mÒm TIM.

5.   H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ «n bµi, luyÖn tËp vµ chuÈn bÞ cho bµi sau.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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häc to¸n víi toolkit math
I. Môc tiªu
1. KiÕn thøc

- Häc sinh thùc hiÖn vµ thao t¸c ®­îc víi c¸c lÖnh phøc t¹p h¬n.

- C¸c chøc n¨ng kh¸c cña phÇn mÒm.

- Thùc hiÖn ®­îc c¸ch ®Æt nÐt vÏ, mµu s¾c, c¸ch sö dông lÖnh xo¸ Clear.

2. Kü N¨ng

- H×nh thµnh kü n¨ng ham mª tÝnh to¸n, häc hái. T­ duy logic, s¸ng t¹o.

- Thµnh th¹o c¸c thao t¸c víi c¸c lÖnh tÝnh to¸n tõ ®¬n gi¶n ®Õn phøc t¹p.

3. Th¸i ®é

- TËp trung, nghiªm tóc, chó ý cao trong giê häc. 

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi. 

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò 
3. Bµi gi¶ng míi (40’)
	Ho¹t déng cña gv – hs
	Néi dung

	GV: Giíi thiÖu HS tham kh¶o SGK trang 117.

HS: l¾ng nghe, ghi l¹i

GV: Giíi thiÖu lÖnh xo¸ th«ng tin trªn cöa sæ vÏ ®å thÞ.

HS: nghe, ghi l¹i

GV: Giíi thiÖu c¸c lÖnh ®Æt nÐt vÏ vµ mµu s¾c trªn cöa ssæ vÏ ®å thÞ.

HS: quan s¸t, l¾ng nghe, ghi l¹i

GV: Gäi mét sè HS cñng cè l¹i c¸c kiÕn thøc lÝ thuyÕt c¬ b¶n vÒ phÇn mÒm TIM.

HS: tr¶ lêi

GV: Yªu cÇu HS khëi ®éng m¸y tÝnh vµ phÇn mÒm TIM thùc hiÖn c¸c bµi tËp trong SGK trang 118.

HS: thùc hiÖn yªu cÇu
	6. C¸c chøc n¨ng kh¸c

a) lµm viÖc trªn cöa sæ dßng lÖnh

b) LÖnh xo¸ th«ng tin trªn cöa sæ vÏ ®å thÞ

-  LÖnh Clear ®Ó xo¸ toµn bé th«ng tin hiÖn cã trªn cöa sæ vÏ ®å thÞ.

c) C¸c lÖnh ®Æt nÐt vÏ vµ mµu s¾c trªn cöa sæ vÏ ®å thÞ

-  C¸c lÖnh: 

Penwidth + ChØ sè ®é dµy.

Pencolor + Tªn mµu (Red, Blue, Black, yellow, magenta…).

7. Thùc hµnh

-  C¸c kiÕn thøc lÝ thuyÕt c¬ b¶n.

-  Bµi tËp trang 118 SGK.


4.  Cñng cè (3’)

- Nh¾c l¹i c¸c kiÕn thøc ®· häc víi phÇn mÒm TIM.

5.   H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ «n bµi, luyÖn tËp vµ chuÈn bÞ cho bµi sau.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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tr×nh bµy d÷ liÖu b»ng biÓu ®å
I. Môc tiªu
1. KiÕn thøc

- BiÕt môc ®Ých cña viÖc sö dông biÓu ®å.

- Mét sè d¹ng biÓu ®å th«ng th­êng.

-  C¸c b­íc cÇn thiÕt ®Ó t¹o mét biÓu ®å tõ b¶ng d÷ liÖu.

-  Thay ®æi d¹ng biÓu ®å ®· t¹o, xo¸, sao chÐp biÓu ®å vµo v¨n b¶n Word.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o c¸c thao t¸c víi biÓu ®å.

3. Th¸i ®é

- H×nh thµnh th¸i ®é ham mª häc hái, yªu thÝch m«n häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi 

III. Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. tiÕn tr×nh giê d¹y – gi¸o dôc


1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV - hs
	Néi dung

	GV: Theo em t¹i sao mét sè lo¹i d÷ liÖu l¹i ®­îc biÓu diÔn d­íi d¹ng biÓu ®å?

HS: tr¶ lêi

GV: Trong ch­¬ng tr×nh phæ th«ng em ®· ®­îc häc c¸c lo¹i biÓu ®å nµo? Em cã biÕt t¸c dông riªng cña mçi lo¹i biÓu ®å Êy kh«ng?

HS: tr¶ lêi

GV: Giíi thiÖu c¸ch t¹o biÓu ®å trªn ch­¬ng tr×nh b¶ng tÝnh Excel.

HS: l¾ng nghe, ghi l¹i


	1. Minh ho¹ sè liÖu b»ng biÓu ®å

-  Môc ®Ých cña viÖc sö dông biÓu ®å:

BiÓu diÔn d÷ liÖu trùc quan, dÔ hiÓu, dÔ so s¸nh, dù ®o¸n xu thÕ t¨ng-gi¶m cña d÷ liÖu.

2. Mét sè d¹ng biÓu ®å

- BiÓu ®å cét: So s¸nh d÷ liÖu cã trong nhiÒu cét.

-  BiÓu ®å ®­êng gÊp khóc: So s¸nh d÷ liÖu vµ dù ®o¸n xu thÕ t¨ng-gi¶m cña d÷ liÖu.

-  BiÓu ®å h×nh trßn: M« t¶ tØ lÖ cña gÝ trÞ d÷ liÖu so víi tæng thÓ.

3. T¹o biÓu ®å

- Nh¸y nót lÖnh Chart Wizard. XHHT Chart Wizard. 

- Nh¸y nót Next trªn c¸c hép tho¹i vµ nh¸y nót Finish ®Ó kÕt thóc.


4. Cñng cè (3’)

- Cñng cè l¹i c¸c kiÕn thøc c¬n b¶n cña viÖc sö dông biÓu ®å trong ch­¬ng tr×nh b¶ng tÝnh.

-  C¸ch chÌn biÓu ®å vµo v¨n b¶n Word.

5. H­íng dÉn vÒ nhµ (1’)

- ¤n l¹i toµn bé kiÕn thøc cña bµi häc.

- §äc tr­íc bµi Thùc hµnh sè 9.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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tr×nh bµy d÷ liÖu b»ng biÓu ®å
I. Môc tiªu
1. KiÕn thøc

- BiÕt môc ®Ých cña viÖc sö dông biÓu ®å.

- Mét sè d¹ng biÓu ®å th«ng th­êng.

-  C¸c b­íc cÇn thiÕt ®Ó t¹o mét biÓu ®å tõ b¶ng d÷ liÖu.

-  Thay ®æi d¹ng biÓu ®å ®· t¹o, xo¸, sao chÐp biÓu ®å vµo v¨n b¶n Word.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o c¸c thao t¸c víi biÓu ®å.

3. Th¸i ®é

- H×nh thµnh th¸i ®é ham mª häc hái, yªu thÝch m«n häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi 

III. Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. tiÕn tr×nh giê d¹y – gi¸o dôc


1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò (5’)

- Nªu c¸ch t¹o biÓu ®å?

3. Bµi gi¶ng míi (35’)

	Ho¹t ®éng cña gv – hs
	Néi dung

	GV: H­íng dÉn HS c¸ch chän biÓu ®å phï hîp víi néi dung d÷ liÖu.

HS: nghe, ghi l¹i

GV: H­íng dÉn HS c¸ch kiÓm tra miÒn d÷ liÖu.

HS: l¾ng nghe, thùc hµnh

GV: Gi¶i thÝch cho HS c¸c th«ng tin trong biÓu ®å khi t¹o.

HS: nghe, ghi l¹i

GV: Khi t¹o biÓu ®å c¸c em cÇn biÕt vÞ trÝ n¬i ®Æt cña biÓu ®å.

HS: nghe, ghi l¹i

GV: H­íng dÉn HS c¸c c¸ch chØnh söa biÓu ®å:

-  Thay ®æi vÞ trÝ.

-  Thay ®æi d¹ng biÓu ®å.

-  Xo¸ biÓu ®å.

- Sao chÐp biÓu ®å vµo v¨n b¶n Word.

HS: l¾ng nghe, ghi l¹i
	3. T¹o biÓu ®å (15’)

a. Chän d¹ng biÓu ®å

-  Chart Types: Chän nhãm biÓu ®å.

-  Chart Sub-types: Chän d¹ng biÓu ®å trong nhãm.

-  Nh¸y Next ®Ó sang b­íc 2.

b. X¸c ®Þnh miÒn d÷ liÖu 

-  Data Range: KiÓm tra miÒn d÷ liÖu vµ söa ®æi nÕu cÇn.

- Series in: Chän d·y d÷ liÖu cÇn minh ho¹ theo hµng hay cét.

-  Nh¸y Next ®Ó chuyÓn sang b­íc 3.

c. C¸c th«ng tin gi¶i thÝch biÓu ®å

-  Chart title: Tiªu ®Ò.

- Ctegory (X) axis: Chó gi¶i trôc ngang.

-  Value (Y) axis: Chó gi¶i trôc ®øng.

-  Nh¸y Next ®Ó sang b­íc 4.

d. VÞ trÝ ®Æt biÓu ®å

- As a new sheet: Trªn trang tÝnh míi.

-  As object in: Trªn trang chøa DL.

-  Nh¸y Finish ®Ó kÕt thóc.

4. ChØnh söa biÓu ®å (20’)

a) Thay ®æi vÞ trÝ cña biÓu ®å

-  Thùc hiÖn thao t¸c kÐo th¶ chuét.

b) Thay ®æi d¹ng biÓu ®å

-  Nh¸y mòi tªn ®Ó ë b¶ng chän B§.

-  Chän kiÓu biÓu ®å thÝch hîp.

c) Xo¸ biÓu ®å

-  Nh¸y chuét trªn biÓu ®å vµ nhÊn phÝm Delete.

d) Sao chÐp biÓu ®å vµo v¨n b¶n 

- Nh¸y chän biÓu ®å vµ nh¸y nót lÖnh Copy.

- Më v¨n b¶n Word vµ nh¸y chuét nót lÖnh Paste.


4. Cñng cè (3’)

- Cñng cè l¹i c¸c kiÕn thøc c¬n b¶n cña viÖc sö dông biÓu ®å trong ch­¬ng tr×nh b¶ng tÝnh.

-  C¸ch chÌn biÓu ®å vµo v¨n b¶n Word.

5. H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ «n bµi, ®äc tr­íc bµi thùc hµnh sè 9.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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Bµi thùc hµnh 9

t¹o biÓu ®å ®Ó minh ho¹
I. Môc tiªu
1. KiÕn thøc

- ¤n l¹i c¸ch nhËp c¸c c«ng thøc vµ hµm vµo « tÝnh.

- Thùc hiÖn ®­îc c¸c thao t¸c t¹o biÓu ®å ®¬n gi¶n.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o thao t¸c vÏ biÓu ®å, c¸c c¸ch tÝnh to¸n trong « tÝnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, chó ý trong thùc hµnh.

-  Cã ý thøc b¶o vÖ cña c«ng.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi.

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc


1. æn ®Þnh líp (1’)


2. KiÓm tra bµi cò (10’)


- Nªu c¸ch t¹o biÓu ®å vµ chØnh söa biÓu ®å


3. Bµi gi¶ng míi (30’)
	Ho¹t ®éng cña GV – hs 
	Néi dung

	GV: Yªu cÇu HS më m¸y, khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel, nhËp d÷ liÖu vµo trang tÝnh nh­ h×nh 113.

HS: thùc hiÖn yªu cÇu

GV: TÝnh cét Tæng céng ta lµm nh­ thÕ nµo?

HS: tr¶ lêi, thùc hµnh

GV: Yªu cÇu HS thùc hiÖn t¹o biÓu ®å víi khèi d÷ liÖu A4:D9.

HS: thùc hµnh

GV: §Ó cã ®­îc d÷ liÖu nh­ h×nh 114 ta lµm nh­ thÕ nµo?

GV: Yªu cÇu HS xo¸ cét Nam trong b¶ng d÷ liÖu.

HS: thùc hµnh

GV: Yªu cÇu tõng HS t¹o biÓu ®å víi d÷ liÖukhèi A4:A9 víi c¸c th«ng tin gi¶i thÝch trªn biÓu ®å.

HS: thùc hµnh
	1. Bµi tËp 1

a) NhËp d÷ liÖu

=SUM(B5,C5)

b) T¹o biÓu ®å víi d÷ liÖu khèi A:D9

c) Thùc hiÖn c¸c thao t¸c ®Ó cã trang tÝnh nh­ h×nh 114

d) T¹o biÓu ®å víi d÷ liÖu khèi A4:C9




4. Cñng cè (4’)

- Gi¸o viªn kiÓm tra viÖc lµm bµi cña tõng m¸y, söa lçi vµ nhËn xÐt ý thøc thùc hµnh, kÕt qu¶ cña mçi m¸y.

5. H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ «n bµi

V. Rót kinh nghiÖm

Ngµy so¹n: 
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Bµi thùc hµnh 9

t¹o biÓu ®å ®Ó minh ho¹
I. Môc tiªu
1. KiÕn thøc

- ¤n l¹i c¸ch nhËp c¸c c«ng thøc vµ hµm vµo « tÝnh.

- Thùc hiÖn ®­îc c¸c thao t¸c t¹o biÓu ®å ®¬n gi¶n.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o thao t¸c vÏ biÓu ®å, c¸c c¸ch tÝnh to¸n trong « tÝnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, chó ý trong thùc hµnh.

-  Cã ý thøc b¶o vÖ cña c«ng.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi.

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc


1. æn ®Þnh líp (1’)


2. KiÓm tra bµi cò (10’)


- Nªu c¸ch t¹o biÓu ®å vµ chØnh söa biÓu ®å


3. Bµi gi¶ng míi (30’)
	Ho¹t ®éng cña gv – hs 
	Néi dung

	GV: Yªu cÇu HS t¹o míi biÓu ®å ®­êng gÊp khóc víi khèi d÷ liÖu A4:C9.

HS: thùc hµnh

GV: Yªu cÇu HS ®æi biÓu ®å  môc d cña BT1 thµnh biÓu ®å ®­êng gÊp khóc.

HS: thùc hµnh

GV: Yªu cÇu HS so s¸nh kÕt qu¶ nhËn ®­îc ë môc a.

HS: tr¶ lêi

GV: §Ó thay ®æi d¹ng biÓu ®å ta lµm nh­ thÕ nµo?

HS: thùc hµnh

GV: §Ó xo¸ cét ta lµm nh­ thÕ nµo ?

- Yªu cÇu HS thùc hiÖn thao t¸c xo¸ cét ®Ó cã trang tÝnh nh­ h×nh 117.

HS : tr¶ lêi, thùc hµnh

GV : Yªu cÇu HS t¹o biÓu ®å h×nh trßn trªn c¬ së d÷ liÖu cña khèi A4:B9.

HS: thùc hµnh

GV: §Ó l­u b¶ng tÝnh ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Yªu cÇu HS më b¶ng tÝnh “B¶ng ®iÓm líp em” ®· l­u trong bµi thùc hµnh 7.

GV: Yªu cÇu HS tÝnh ®iÓm trung b×nh theo tõng m«n.

HS: thùc hµnh

GV: Yªu cÇu HS t¹o biÎu ®å cét ®Ó minh ho¹ §TB cña c¸c m«n häc.

HS: thùc hµnh

GV: §Ó sao chÐp biÓu ®å trªn trang tÝnh vµo Word ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Yªu cÇu HS thùc hiÖn thao t¸c sao chÐp sang Word.

HS: thùc hµnh
	2. Bµi tËp 2

a) T¹o biÓu ®å ®­êng gÊp khóc víi d÷ liÖu khèi A 4:C9

b) Thay ®æi d¹ng biÓu ®å

c) Thay ®æi d¹ng biÓu ®å

d) Xo¸ cét

e) T¹o biÓu ®å h×nh trßn

g) L­u b¶ng tÝnh

3. Bµi tËp 3

a) TÝnh §TB theo tõng m«n häc cña c¶ líp vµo hµng d­íi cïng cña danh s¸ch d÷ liÖu

b) T¹o biÓu ®å h×nh cét

c) Sao chÐp biÓu ®å ®­îc t¹o trªn trang tÝnh vµo v¨n b¶n Word


4. Cñng cè (4’)

- Gi¸o viªn kiÓm tra viÖc lµm bµi cña tõng m¸y, söa lçi vµ nhËn xÐt ý thøc thùc hµnh, kÕt qu¶ cña mçi m¸y.

5. H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ «n bµi, ®äc tr­íc bµi häc vÏ h×nh häc ®éng víi Geogebra.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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häc vÏ h×nh häc ®éng víi geogebra
I. Môc tiªu
1. KiÕn thøc

- Häc sinh biÕt vµ ph©n biÖt ®­îc c¸c thµnh phÇn chÝnh trªn mµn h×nh.

- BiÕt c¸ch khëi ®éng.

- BiÕt c¸c c«ng cô vµ ®iÒu khiÓn h×nh.

- BiÕt c¸ch më, ghi tÖp, tho¸t khái phÇn mÒm.

- VÏ ®­îc h×nh.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o thao t¸c trªn.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, chó ý trong giê häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh: SGK, vë ghi 

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc


1. æn ®Þnh líp (1’)


2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV – hs
	Néi dung

	GV: Giíi thiÖu phÇn mÒm Geogebra

HS: l¾ng nghe, ghi l¹i

GV: T­¬ng tù nh­ c¸c phÇn mÒm kh¸c em h·y thö nªu c¸ch khëi ®éng víi phÇn mÒm Geogebra?

HS: tr¶ lêi

GV: Sau khi khëi ®éng phÇn mÒn th× mµn h×nh lµm viÖc chÝnh gåm nh÷ng thµnh phÇn g×?

HS: tr¶ lêi

GV: Giíi thiÖu c¸c c«ng cô vÏ vµ ®iÒu khiÓn h×nh cã trong phÇn mÒm.

HS: l¾ng nghe, ghi l¹i

GV: §Ó chän mét c«ng cô ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Chóng ta ®· biÕt, víi Word cã phÇn më réng lµ .doc, Excel lµ .xls cßn víi Geogebra lµ .ggb. 

GV: C¸ch më vµ l­u víi tÖp Geogebra?

HS: tr¶ lêi

GV: §Ó tho¸t khái phÇn mÒm ta lµm nh­ thÕ nµo?

HS: tr¶ lêi
	1. Giíi thiÖu phÇn mÒm

- PhÇn mÒm Geoebra cho phÐp thiÕt kÕ c¸c h×nh ®Ó häc h×nh häc trong ch­¬ng tr×nh m«n To¸n ë phæ th«ng…

2. Lµm quen víi phÇn mÒm

a) Khëi ®éng

- Nh¸y ®óp chuét biÓu t­îng cña Geogebra.

b) Giíi thiÖu mµn h×nh

- Thanh b¶ng chän.

- Thanh c«ng cô.

- Khu vùc trung t©m.

c) C¸c c«ng cô vÏ vµ ®iÒu khiÓn mµn h×nh

d) Më vµ ghi tÖp vÏ h×nh

- Më tÖp: File -> Open. Chän tÖp cÇn më -> Open.

- Ghi tÖp: File -> Save. Gâ tªn ë « File name -> Save.

e) Tho¸t khái phÇn mÒm

File -> Exit.


4.  Cñng cè (3’)

- Gi¸o viªn kiÓm tra viÖc thùc hµnh vÏ ta gi¸c cña tõng m¸y, söa lçi vµ nhËn xÐt ý thøc thùc hµnh, kÕt qu¶ cña mçi m¸y.

5.  H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS ®äc tiÕp c¸c phÇn cßn l¹i bµi häc vÏ h×nh häc ®éng víi Geogebra.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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häc vÏ h×nh häc ®éng víi geogebra
I. Môc tiªu
1. KiÕn thøc

- Häc sinh biÕt vµ ph©n biÖt ®­îc c¸c thµnh phÇn chÝnh trªn mµn h×nh.

- BiÕt c¸ch khëi ®éng.

- BiÕt c¸c c«ng cô vµ ®iÒu khiÓn h×nh.

- BiÕt c¸ch më, ghi tÖp, tho¸t khái phÇn mÒm.

- VÏ ®­îc h×nh.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o thao t¸c trªn.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, chó ý trong giê häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh: SGK, vë ghi 

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc


1. æn ®Þnh líp (1’)


2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña gv – hs
	Néi dung

	GV: Yªu cÇu HS khëi ®éng phÇn mÒm Geo vµ tõng HS thùc hiÖn thao t¸c vÏ tam gi¸c trªn m¸y tÝnh.

HS: thùc hiÖn yªu cÇu

GV: Yªu cÇu HS thùc hiÖn di chuyÓn c¸c ®iÓm A, B, C.

HS: thùc hiÖn yªu cÇu

GV: Yªu cÇu HS l­u l¹i c¸c tÖp h×nh ®· vÏ.

HS: thùc hiÖn yªu cÇu

GV: Yªu cÇu HS më l¹i c¸c tÖp ®· l­u.

HS: thùc hiÖn yªu cÇu

GV: §Ó tho¸t khëi phÇn mÒm ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Yªu cÇu HS tho¸t khái phÇn mÒm Geo.

GV: Em h·y kÓ tªn c¸c quan hÖ gi÷a c¸c ®èi t­îng h×nh häc ®· häc trong m«m to¸n H×nh.

HS: tr¶ lêi

GV: Giíi thiÖu mét sè quan hÖ ®­îc thiÕt lËp trong phÇn mÒm

HS: l¾ng nghe, ghi l¹i
	3. VÏ h×nh ®Çu tiªn: Tam gi¸c ABC

- Nh¸y chuét chän c«ng cô ®o¹n th¼ng

- Nh¸y chuét t¹i vÞ trÝ trèng trªn mµn hinh di chuyÓn ®Õn vÞ trÝ thø hai vµ nh¸y chuét. Nh­ vËy ta ®· t¹o xong ®o¹n th¼ng AB

- Nh¸y chuét t¹i ®iÓm B di chuyÓn ®Õn vÞ trÝ míi vµ nh¸y chuét. Chóng ta võa t¹o xong ®o¹n th¼ng BC

- Nh¸y chuét t¹i ®iÓm C di chuyÓn ®Õn ®iÓm A vµ nh¸y chuét em sÏ vÏ ®­îc ®o¹n th¼ng AC. Nh­ vËy chóng ta võa t¹o xong tam gi¸c ABC

- L­u tÖp: tªn gäi lµ tamgiac.ggb
-  Më tÖp

-  Tho¸t khái phÇn mÒm

4. Quan hÖ gi÷a c¸c ®èi t­îng h×nh häc

- C¸c ®«i t­îng h×nh häc trong phÇn mÒm Geogebra cã c¸c quan hÖ to¸n häc chÆt chÏ.

- Mét ®Æc tÝnh quan träng cña phÇn mÒm lµ quan hÖ gi÷a c¸c ®èi t­îng h×nh häc ®· ®­îc thiÕt lËp th× sÏ kh«ng bao giê thay ®æi.

- §iÓm n»m trªn ®o¹n th¼ng, ®­êng th¼ng

- Giao ®iÓm cña hai ®­êng th¼ng

- Trung ®iÓm cña ®o¹n th¼ng

- §­êng th¼ng ®i qua mét ®iÓm vµ song song víi mét ®­êng th¼ng kh¸c

- §­êng th¼ng ®i qua mét ®iÓm vµ vu«ng gãc víi mét ®­êng th¼ng kh¸c

- §­êng ph©n gi¸c cña mét gãc


4.  Cñng cè (3’)

- Gi¸o viªn kiÓm tra viÖc thùc hµnh vÏ ta gi¸c cña tõng m¸y, söa lçi vµ nhËn xÐt ý thøc thùc hµnh, kÕt qu¶ cña mçi m¸y.

5.  H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS ®äc tiÕp c¸c phÇn cßn l¹i bµi häc vÏ h×nh häc ®éng víi Geogebra.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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häc vÏ h×nh häc ®éng víi geogebra
I. Môc tiªu
1. KiÕn thøc

- Häc sinh b­íc ®Çu hiÓu ®­îc c¸c ®èi t­îng h×nh häc c¬ b¶n cña phÇn mÒm vµ quan hÖ gi÷a chóng.

- Häc sinh biÕt vµ hiÓu c¸c øng dông cña phÇn mÒm trong viÖc vÏ vµ minh ho¹ h×nh häc trong ch­¬ng tr×nh m«n To¸n.

- Cñng cè l¹i c¸c c¸ch vÏ c¸c h×nh c¬ b¶n. T¹o ®­îc giao ®iÓm 3 ®­êng cao, 3 ®­êng trung tuyÕn, 3 ®­êng ph©n gi¸c... 

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o tÊt c¶ c¸c thao t¸c víi Geogebra.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. Thªm yªu thÝch m«n häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh: SGK, vë ghi

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y  -  gi¸o dôc
1. æn ®Þnh líp (1’)

2. KiÓm ra bµi cò (5’)

- Em h·y nªu c¸ch khëi ®éng phÇn mÒm vµ c¸c thµnh phÇn chÝnh cña mµn h×nh lµm viÖc víi phÇn mÒm Geogebra?

3. Bµi gi¶ng míi (35’)

	Ho¹t ®éng cña GV – hs
	Néi dung

	GV: Giíi thiÖu c¸c lÖnh th­êng dïng trong Geogebra.

GV: Giíi thiÖu thao t¸c di chuyÓn nh·n cña ®èi t­îng.

HS: l¾ng nghe, ghi l¹i

GV: Giíi thiÖu thao t¸c lµm Èn 1 ®èi t­îng h×nh.

HS: l¾ng nghe, ghi l¹i

GV: Giíi thiÖu thao t¸c lµm Èn/hiÖn nh·n 1 ®èi t­îng h×nh.

HS: l¾ng nghe, ghi l¹i

GV: Giíi thiÖu thao t¸c xo¸ 1 ®èi t­îng h×nh.

HS: l¾ng nghe, ghi l¹i

GV: Giíi thiÖu thao t¸c ®æi tªn, nh·n ®èi t­îng h×nh.

HS: nghe, ghi l¹i

GV: Giíi thiÖu thao t¸c phãng to, thu nhá ®èi t­îng h×nh.

HS: nghe, ghi l¹i

GV: Giíi thiÖu thao t¸c di chuyÓn ®èi t­îng h×nh.

HS: nghe, ghi l¹i

GV: Yªu cÇu häc sinh lÇn l­ît lµm l¹i tÊt c¶ c¸c thau t¸c ®· häc.

HS: thùc hiÖn yªu cÇu
	5. Mét sè lÖnh hay dïng

a) DÞch chuyÓn nh·n cña ®èi t­îng

-  Dïng c«ng cô chän vµ thùc hiÖn thao t¸c kÐo th¶ chuét xung quanh ®èi t­îng ®Õn vÞ trÝ míi. 

b) Lµm Èn mét ®èi t­îng h×nh häc

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Show Object.

c) Lµm Èn/hiÖn nh·n cña ®èi t­îng

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Show label.

d) Xo¸ mét ®èi t­îng

C1 : Nh¸y chän ®èi t­îng vµ nhÊn phÝm Delete.

C2: Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Delete.

e) Thay ®æi tªn, nh·n cña ®èi t­îng

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Rename. Gâ tªn míi -> Apply.

g) Phãng to, thu nhá c¸c ®èi t­îng trªn mµn h×nh

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Room. 
h) Di chuyÓn toµn bé c¸c ®èi t­îng h×nh häc trªn mµn h×nh

- Gi÷ Ctrl + Chuét tr¸i vµ thao t¸c kÐo th¶ chuét.




4. Cñng cè (3’)

- Gi¸o viªn nh¾c l¹i tÊt c¶ c¸c thao t¸c víi phÇn mÒm Geogebra.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

5. H­íng dÉn vÒ nhµ(1’)

- H­íng dÉn HS vÒ nhµ chuÈn bÞ cho bµi thùc hµnh

V. Rót kinh nghiÖm

Ngµy so¹n: 
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häc vÏ h×nh häc ®éng víi geogebra
I. Môc tiªu
1. KiÕn thøc

- Häc sinh b­íc ®Çu hiÓu ®­îc c¸c ®èi t­îng h×nh häc c¬ b¶n cña phÇn mÒm vµ quan hÖ gi÷a chóng.

- Häc sinh biÕt vµ hiÓu c¸c øng dông cña phÇn mÒm trong viÖc vÏ vµ minh ho¹ h×nh häc trong ch­¬ng tr×nh m«n To¸n.

- Cñng cè l¹i c¸c c¸ch vÏ c¸c h×nh c¬ b¶n. T¹o ®­îc giao ®iÓm 3 ®­êng cao, 3 ®­êng trung tuyÕn, 3 ®­êng ph©n gi¸c... 

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o tÊt c¶ c¸c thao t¸c víi Geogebra.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. Thªm yªu thÝch m«n häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh: SGK, vë ghi

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y  -  gi¸o dôc
1. æn ®Þnh líp (1’)

2. KiÓm ra bµi cò 

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña gv – hs
	Néi dung

	GV: Yªu cÇu häc sinh lµm c¸c bµi tËp SGK trang 125.

GV: yªu cÇu hs vÏ h×nh tam gi¸c ABC víi träng t©m G

HS: thùc hiÖn yªu cÇu

GV: yªu cÇu hs vÏ h×nh tam gi¸c ABC víi trùc t©m H

HS: thùc hiÖn yªu cÇu

GV: yªu cÇu hs vÏ tam gi¸c ABC víi ba ®­êng ph©n gi¸c c¾t nhau t¹i ®iÓm I

GV: yªu cÇu hs vÏ h×nh b×nh hµnh

HS: thùc hiÖn yªu cÇu

GV: Chó ý ®i xung quanh h­íng dÉn HS c¸c thao t¸c khã. 

- KiÓm tra viÖc thùc hµnh cña häc sinh. LÊy ®iÓm 15’


	6. Bµi tËp thùc hµnh

- VÏ tam gi¸c ABC víi träng t©m G vµ ba ®­êng trung tuyÕn
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- VÏ tam gi¸c ABC víi ba ®­êng cao vµ trùc t©m H
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- VÏ tam gi¸c ABC víi ba ®­êng ph©n gi¸c c¾t nhau t¹i ®iÓm I
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- VÏ h×nh b×nh hµnh ABCD
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4. Cñng cè (3’)

- Gi¸o viªn nh¾c l¹i tÊt c¶ c¸c thao t¸c víi phÇn mÒm Geogebra.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

5. H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp vµ ®äc tr­íc bµi thùc hµnh 10.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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Bµi thùc hµnh sè 10

bµi thùc hµnh tæng hîp
I. Môc tiªu
1. KiÕn thøc

- Cñng cè l¹i cho HS c¸ch lËp trang tÝnh, ®Þnh d¹ng, sö dông c«ng thøc, c¸c hµm vµ tr×nh bµy trang in.

- Sö dông nót lÖnh Print Preview ®Ó xem tr­íc khi in.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o c¸c thao t¸c trong trang tÝnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. 

-  B¶o vÖ cña c«ng, yªu thÝch m«n häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi. 

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò


3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña  GV – hs
	Néi dung

	GV: Yªu cÇu HS khëi ®éng Excel vµ nhËp d÷ liÖu vµo trang tÝnh nh­ h×nh 119.

GV: §Ó ®iÒu chØnh ®é réng cét, ®é cao hµng ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: §Ó c¨n chØnh tiªu ®Ò ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Nªu c¸c thao t¸c ®Ó kÎ khung cho « tÝnh?

HS: tr¶ lêi

GV: Nh¾c l¹i c¸c thao t¸c sao chÐp vµ chØnh söa d÷ liÖu trong « tÝnh.

HS: l¾ng nghe, ghi l¹i

GV: §Ó t¹o mµu nÒn, mµu ch÷ cho « tÝnh ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: §Ó tÝnh cét tæng céng ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Gi¸m s¸t viÖc thùc hµnh cña HS, h­íng dÉn HS khi cÇn.
	1. Bµi tËp 1

a) Khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel vµ nhËp d÷ liÖu vµo trang tÝnh

b) §iÒu chØnh hµng, cét vµ ®Þnh d¹ng

- §iÒu chØnh hµng, cét: 

+ §­a con trá vµo v¹ch ph©n c¸ch gi÷a hµng hay cét vµ thùc hiÖn thao t¸c kÐo th¶ chuét ®Ó t¨ng hay gi¶m ®é réng cét, ®é cao hµng.

- C¨n chØnh tiªu ®Ò

+ Chän c¸c « cÇn c¨n chØnh, nh¸y nót Merge and Center.

- KÎ khung

+ Chän c¸c « cÇn kÎ khung.

+ Nh¸y nót Border chän kiÓu vÏ ®­êng biªn.

c) Sao chÐp vµ chØnh söa d÷ liÖu

-  Sao chÐp

+ Chän « cÇn sao chÐp.

+ Nh¸y nót lÖnh Copy.

+ Trá tíi vÞ trÝ míi.

+ Nh¸y nót lÖnh Paste.

- T¹o mµu nÒn vµ mµu ch÷

Mµu nÒn

+ Chän « hoÆc c¸c « cÇn t¹o mµu nÒn.

+ Nh¸y nót Fill Colors.

Mµu ch÷

+ Chän « hoÆc c¸c « cÇn t¹o mµu ch÷.

+ Nh¸y nót Font Color.

d) LËp c«ng thøc ®Ó tÝnh tæng  sè hiÖn vËt

- Dïng c«ng thøc:

=D5+D14

-  Dïng hµm:

=SUM(D5,D14)


4.  Cñng cè (3’)

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ thùc hµnh cña HS.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

5.  H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp vµ ®äc tr­íc c¸c phÇn tiÕp theo.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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Bµi thùc hµnh sè 10

bµi thùc hµnh tæng hîp
I. Môc tiªu
1. KiÕn thøc

- Cñng cè l¹i cho HS c¸ch lËp trang tÝnh, ®Þnh d¹ng, sö dông c«ng thøc, c¸c hµm vµ tr×nh bµy trang in.

- Sö dông nót lÖnh Print Preview ®Ó xem tr­íc khi in.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o c¸c thao t¸c trong trang tÝnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. 

-  B¶o vÖ cña c«ng, yªu thÝch m«n häc.

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y.

2. Häc sinh: SGK, vë ghi. 

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc

2. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò


3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña gv – hs
	Néi dung

	GV: T¹i sao cÇn xem trang tÝnh tr­íc khi in?

HS: tr¶ lêi
GV: §Ó xem tr­íc khi in ta lµm nh­ thÕ nµo? 

HS: tr¶ lêi

GV: Yªu cÇu HS nhËp d÷ liÖu vµo trang tÝnh.

HS: thùc hiÖn yªu cÇu

GV: §Ó tÝnh cét tæng céng ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: §Ó tÝnh thu nhËp trung b×nh theo tõng ngµnh ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Yªu cÇu HS l­u l¹i b¶ng tÝnh víi tªn Baitap2.

HS: thùc hiÖn yªu cÇu
	2. Bµi tËp 2

Xem tr­íc khi in

- §Ó xem tr­íc khi in em nh¸y nót Print Preview trªn thanh c«ng cô.

a) Khëi ®éng Excel vµ nhËp d÷ liÖu vµo trang tÝnh

b) Sö dông c¸c hµm ®Ó tÝnh to¸n

-  TÝnh trung b×nh céng: sö dông hµm Average

-  Tæng thu nhËp trung b×nh cña vïng.

- NhÊn nót Save trªn thanh c«ng cô


4.  Cñng cè (3’)

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ thùc hµnh cña HS.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

5.  H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp vµ ®äc tr­íc c¸c phÇn tiÕp theo.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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Ngày giảng:

Bµi thùc hµnh sè 10

bµi thùc hµnh tæng hîp
I. Môc tiªu
1. KiÕn thøc

- Cñng cè l¹i cho HS c¸ch chØnh söa, chÐn thªm hµng, ®Þnh d¹ng v¨n b¶n, s¾p xÕp vµ läc d÷ liÖu.

- Cñng cè c¸ch t¹o biÓu ®å, tr×nh bµy trang in, sao chÐp vïng d÷ liÖu vµ di chuyÓn biÓu ®å.

2. Kü N¨ng

- Thùc hµnh thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. 

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh: SGK, vë ghi

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40’)
	Ho¹t ®éng cña gv – hs
	Néi dung

	GV: Yªu cÇu HS më m¸y tÝnh, khëi ®éng Excel vµ më b¶ng tÝnh Baitap2.

GV: §Ó cho tiªu ®Ò cña b¶ng “Thu nhËp b×nh qu©n theo ®Çu ng­êi” ra gi÷a ta lµm nh­ thÕ nµo?

GV: §Ó chän mµu cho ch÷ ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV:Nªu thao t¸c chÌn thªm 1 hµng.

HS: tr¶ lêi

GV: Yªu cÇu HS tr×nh bµy gièng mÉu h×nh 123.

GV: §Ó s¾p xÕp tªn x· víi thø tù a, b, c ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: §Ó s¾p xÕp thu nhËp b×nh qu©n vÒ n«ng nghiÖp víi thø tù gi¶m dÇn ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV : §Ó läc d÷ liÖu trong trang tÝnh ta lµm nh­ thÕ nµo?

GV: Em h·y thùc hiÖn thao t¸c läc d÷ liÖu lÊy 3 x· thu nhËp b×nh qu©n vÒ n«ng nghiÖp cao nhÊt.

HS : thùc hiÖn yªu cÇu

GV: §Ó tho¸t khái chÕ ®é läc ta lµm nh­ thÕ nµo?

HS : tr¶ lêi

GV : Yªu cÇu HS l­u l¹i trang tÝnh víi tªn Thongke.

HS: thùc hiÖn yªu cÇu
	c) ChØnh söa vµ chÌn thªm hµng

-   ChØnh söa: 

+ Nh¸y nót lÖnh Merge and Center

+ Chän « cÇn ®Þnh d¹ng 

+ Nh¸y vµo nót Font Color

-  ChÌn hµng

+ Chän vÞ trÝ cÇn chÌn hµng

+ Nh¸y chuét phµi chän Insert

d) S¾p xÕp c¸c x· 

- Theo tªn x· víi thø tù a, b, c.

- S¾p xÕp gi¶m dÇn.

e) Läc d÷ liÖu

Data -> Filter -> AutoFilter -> Chän Top 10. XHHT, chän Top 3 -> OK.

Tho¸t chÕ ®é läc ta thùc hiÖn nh­ sau:

- Data -> Filter -> AutoFilter




4.  Cñng cè (3’)

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

5.  H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ lµm tiÕp bµi tËp cßn l¹i

V. Rót kinh nghiÖm

Ngµy so¹n: 
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Bµi thùc hµnh sè 10

bµi thùc hµnh tæng hîp
I. Môc tiªu
1. KiÕn thøc

- Cñng cè l¹i cho HS c¸ch chØnh söa, chÐn thªm hµng, ®Þnh d¹ng v¨n b¶n, s¾p xÕp vµ läc d÷ liÖu.

- Cñng cè c¸ch t¹o biÓu ®å, tr×nh bµy trang in, sao chÐp vïng d÷ liÖu vµ di chuyÓn biÓu ®å.

2. Kü N¨ng

- Thùc hµnh thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. 

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh: SGK, vë ghi

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV. TiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò
3.Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV - hs
	Néi dung

	GV: Yªu cÇu HS më Baitap2 ®· l­u trong m¸y.

GV: §Ó sao chÐp cét B vµ cét D sang vïng kh¸c ta lµm nh­ thÕ nµo?

HS : tr¶ lêi

GV: §Ó vÏ biÓu ®å ta sö dông nót lÖnh nµo?

HS: tr¶ lêi

GV: Em h·y thùc hiÖn thao t¸c sao chÐp hµng d÷ liÖu sang vïng kh¸c.

HS : thùc hiÖn yªu cÇu

GV: yªu cÇu HS vÏ biÓu ®å nh­ mÉu h×nh 125.

HS : thùc hiÖn yªu cÇu

GV: §Ó di chuyÓn biÓu ®å ta lµm nh­ thÕ nµo?

HS : tr¶ lêi

GV : Yªu cÇu HS di chuyÓn biÓu ®å.

HS: thùc hiÖn yªu cÇu

GV: §Ó xem tr­íc khi in ta lµm nh­ thÕ nµo ?

GV : Gi¸m s¸t viÖc thùc hµnh cña HS, h­íng dÉn c¸c em khi cÇn thiÕt.
	3. Bµi tËp 3

T¹o biÓu ®å vµ tr×nh bµy trang in.

a) Sao chÐp cét vµ vÏ biÓu ®å

b) Sao chÐp hµng vµ vÏ biÓu ®å

c) Di chuyÓn biÓu ®å vµ tr×nh bµy trang in

d) Xem tr­íc khi in


4.  Cñng cè (3’)

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ thùc hµnh cña HS.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

4.  H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp chuÈn bÞ cho bµi kiÓm tra thùc hµnh.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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kiÓm tra thùc hµnh
I. Môc tiªu
1. KiÕn thøc

- KiÓm tra viÖc n¾m b¾t kiÕn thøc thùc hµnh cña häc sinh vÒ tr×nh bµy trang tÝnh, ®Þnh d¹ng, sö dông c«ng thøc tÝnh to¸n, s¾p xÕp vµ läc d÷ liÖu.

2. Kü N¨ng

- Cã kÜ n¨ng t­ duy, vËn dông kiÕn thøc vµo thùc hµnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, trung thùc khi lµm bµi. 

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o ¸n, ®Ò kiÓm tra, ®¸p ¸n, phßng m¸y

2. Häc sinh: KiÕn thøc ®· häc. 

III. Ph­¬ng ph¸p
- KiÓm tra thùc hµnh trªn m¸y

IV. tiÕn tr×nh giê d¹y – gi¸o dôc

1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò
3. Bµi gi¶ng míi (40’)
KIỂM TRA THỰC HÀNH

Môn tin học 7

Cho bảng điểm sau:
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Yêu cầu:

1. Nhập dữ liệu cho trang tính theo mẫu trên.

2. Định dạng kí tự: cỡ chữ (tiêu đề :20, nội dung:14), đóng khung nội dung trang tính và tiêu đề căn giữa nội dung các ô.

3. Trình bày trang văn bản:


- Lề trên (top) 1,5 cm

- Lề dưới (Bottom) 1,5 cm

- Lề trái (Left) 2 cm

- Lề phải (Right) 1,5 cm.

4. Sử dụng hàm hoặc công thức thích hợp để tính  ĐTB của từng em.

5. Lọc ra danh sách học sinh có điểm trung bình là 3 vị trí cao nhất, và sao chép danh sách sang Sheet2.

6. Sắp xếp điểm TIN HỌC tăng dần.

7. Lưu trang tính theo đường dẫn sau: E:\họ tên-lớp 

H­íng dÉn chÊm bµi thùc hµnh

	C©u
	§¸p ¸n
	BiÓu ®iÓm

	
	1. Nhập dữ liệu cho trang tính theo mẫu trên. 

2. Định dạng kí tự: cỡ chữ (tiêu đề :20, nội dung:14), đóng khung nội dung trang tính và tiêu đề căn giữa nội dung các ô.

3. Trình bày trang văn bản: 


- Lề trên (top) 1,5 cm

- Lề dưới (Bottom) 1,5 cm

- Lề trái (Left) 2 cm

- Lề phải (Right) 1,5 cm.

4. Sử dụng hàm hoặc công thức thích hợp để tính  ĐTB của từng em. 

5. Lọc ra danh sách học sinh có điểm trung bình là 3 vị trí cao nhất, và sao chép danh sách sang Sheet2.

6. Sắp xếp điểm TIN HỌC tăng dần.

7. Lưu trang tính theo đường dẫn sau: E:\họ tên-lớp 

Vd: pham van a-7a
	2 ®

2 ®

1®

2 ®

1.5 ®

1 ®

0.5 ®


  4. Cñng cè ( 3’ )

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ kiÓm tra cña HS.

- NhËn xÐt giê kiÓm tra, ý thøc lµm bµi, kÕt qu¶ bµi lµm vµ cho ®iÓm. 

5. H­íng dÉn vÒ nhµ (1’)
- H­íng dÉn HS vÒ nhµ chuÈn bÞ cho bµi «n tËp cuèi n¨m.

V. Rót kinh nghiÖm

Ngµy so¹n: 
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«n tËp
I. Môc tiªu
1. KiÕn thøc

- Tæng hîp kiÕn thøc vÒ ®Þnh d¹ng trang tÝnh, tr×nh bµy vµ in trang tÝnh.

2. Kü N¨ng

- H×nh thµnh kÜ n¨ng t­ duy tæng hîp, thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng h¸i ph¸t biÓu ý kiÕn x©y dùng bµi. 

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh. SGK, vë ghi

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vÊn ®¸p thùc hµnh

IV. TiÕn tr×nh giê d¹y – gi¸o dôc
1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña GV - hs
	Néi dung

	GV: §Ó thay ®æi ph«ng ch÷ ta lµm nh­ thÕ nµo?

HS: tr¶ lêi, thùc hµnh

GV: §Ó thay ®æi cì ch÷ ta lµm nh­ thÕ nµo?

HS: tr¶ lêi, thùc hµnh

GV: §Ó thay ®æi kiªu ch÷ ta lµm nh­ thÕ nµo?

HS: tr¶ lêi

GV: Nªu c¸ch chän mµu cho ph«ng?

HS: tr¶ lêi

GV: C¸ch c¨n lÒ trong « tÝnh?

HS: tr¶ lêi

GV: nªu c¸ch t¨ng, gi¶m sè ch÷ sè thËp ph©n?

HS: tr¶ lêi

GV: Tr×nh bµy c¸ch t« mµu nÒn vµ kÎ ®­êng biªn trong trang tÝnh.

HS: tr¶ lêi

GV: Tr×nh bµy c¸ch ®Æt lÒ h­íng giÊy in.

HS: tr×nh bµy

GV: ®Ó in trang tÝnh ta lµm nh­ thÕ nµo?

HS: tr¶ lêi
	1. §Þnh d¹ng trang tÝnh (25’)

a) Thay ®æi ph«ng ch÷

-  §¸nh dÊu «.

-  Nh¸y mòi tªn ë « Font vµ chän ph«ng thÝch hîp.

b) Thay ®æi cì ch÷

-  §¸nh dÊu «.

-  Nh¸y mòi tªn ë « cì ch÷ vµ chän cì thÝch hîp.

c) Thay ®æi kiÓu ch÷

-  §¸nh dÊu «.

-   Nh¸y vµo B, I, U

d) Chän mµu ph«ng

-  §¸nh dÊu «.

-  Nh¸y mòi tªn ë nót ch÷ A

e) C¨n lÒ trong « tÝnh

- §¸nh dÊu «.

- Nh¸y chän c¸c nót lÖnh c¨n lÒ.

f) T¨ng, gi¶m sè ch÷ sè thËp ph©n

- Nh¸y chän «.

- Sö dông hai nót lÖnh t¨ng, gi¶m ch÷ sè thËp ph©n.

g) T« mµu nÒn vµ kÎ ®­êng biªn

 T« mµu nÒn

- Nh¸y chän «.

- Sö dông nót lÖnh Fill Color.

KÎ ®­êng biªn

- Chän «.

- Sö dông nót Border.

2. Tr×nh bµy vµ in trang tÝnh (15’)

- §Æt lÒ h­íng giÊy in

File -> Page Setup. XHHT, lùa chän h­íng giÊy vµ lÒ giÊy -> Ok.

-  In trang tÝnh

File -> Print.


4. Cñng cè (3’)
- Nh¾c l¹i tÊt c¶ c¸c thao t¸c ®· häc.

5. H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp bµi cßn l¹i chuÈn bÞ cho tiÕt «n tËp tiÕp

V. Rót kinh nghiÖm

Ngµy so¹n: 









        TiÕt 68

«n tËp
I. Môc tiªu
1. KiÕn thøc

- Tæng hîp kiÕn thøc vÒ ®Þnh d¹ng trang tÝnh, tr×nh bµy vµ in trang tÝnh.

- Cñng cè c¸ch s¾p xÕp vµ läc d÷ liÖu, c¸ch t¹o biÓu ®å minh ho¹ d÷ liÖu.

2. Kü N¨ng

- H×nh thµnh kÜ n¨ng t­ duy tæng hîp, thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng h¸i ph¸t biÓu ý kiÕn x©y dùng bµi. 

II. ChuÈn bÞ

1. Gi¸o viªn: SGK, gi¸o ¸n, phßng m¸y

2. Häc sinh. SGK, vë ghi

III. Ph­¬ng ph¸p
- ThuyÕt tr×nh vÊn ®¸p thùc hµnh

IV. TiÕn tr×nh giê d¹y – gi¸o dôc
1. æn ®Þnh líp (1’)

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi (40’)

	Ho¹t ®éng cña gv – hs
	Néi dung

	GV: Tr×nh bµy c¸ch s¾p xÕp d÷ liÖu trong trang tÝnh?

HS: tr¶ lêi, thùc hµnh

GV: §Ó läc d÷ liÖu trong trang tÝnh ta lµm nh­ thÕ nµo?

HS : tr¶ lêi

GV: Sau khi läc ®Ó hiÓn thÞ l¹i d÷ liÖu ta lµm nh­ thÕ nµo?

HS : tr¶ lêi

GV: Nªu c¸ch tho¸t khái chÕ ®ä läc?

HS : tr¶ lêi

GV: Em h·y tr×nh bµy c¸ch vÏ biÓu ®å biÓu diÔn d÷ liÖu trªn trang tÝnh ?

HS : tr¶ lêi

GV : Cho HS thùc hµnh l¹i tÊt c¶ c¸c thao t¸c ®· häc.

HS: Thùc hµnh trªn m¸y
	3. S¾p xÕp vµ läc d÷ liÖu

a) S¾p xÕp d÷ liÖu

-  Chän « trong cét cÇn s¾p xÕp.

-  Nh¸y nót lÖnh s¾p xÕp t¨ng (hoÆc gi¶m).

b) Läc d÷ liÖu

- Chän « trong vïng cÇn läc.

- Data -> Filter -> AutoFilter

HiÓn thÞ l¹i d÷ liÖu

-  Data -> Filter -> Show All

Tho¸t khái chÕ ®é läc

-  Data -> Filter -> AutoFilter.

4. Tr×nh bµy d÷ liÖu b»ng biÓu ®å

-  Chän « trong vïng d÷ liÖu

-  Nh¸y nót Chart Wizard.

-  Nh¸y Next liªn tiÕp.

-  Nh¸y Finish khi Next mê ®i.

5. LuyÖn tËp

(¤n tËp c¸c thao t¸c ®· häc)


4. Cñng cè (3’)
- Nh¾c l¹i tÊt c¶ c¸c thao t¸c ®· häc.

5. H­íng dÉn vÒ nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp chuÈn bÞ cho bµi kiÓm tra häc k×

V. Rót kinh nghiÖm

Ngµy so¹n:
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kiÓm tra häc kú ii 

 phÇn lý thuyÕt  
I. Môc tiªu.
1. KiÕn thøc

- KiÓm ta viÖc n¾m b¾t kiÕn thøc lý thuyÕt cña HS vÒ tÊt c¶ c¸c phÇn ®· häc cña häc kú II.

2. Kü N¨ng

- RÌn cho häc sinh kü n¨ng trong suy nghÜ, t­ duy, lµm chñ t×nh huèng.
3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, trung thùc trong giê kiÓn tra.

II. ChuÈn bÞ.

1. Gi¸o viªn: §Ò bµi, ®¸p ¸n.

2. Häc sinh: Häc bµi ë nhµ.

III. Ph­¬ng ph¸p.
- KiÓm tra trªn giÊy

IV. TiÕn tr×nh giê d¹y – gi¸o dôc.
1. æn ®Þnh líp 

2. KiÓm tra bµi cò

3. Bµi gi¶ng míi 

KIỂM TRA HỌC KÌ II

I: PHẦN TRẮC NGHIỆM. Chọn câu trả lời đúng
Câu 1: Các nút lệnh [image: image38.png]


 nằm trên thanh nào?

A. Thanh tiêu đề                                    
 B. Thanh thực đơn

C. Thanh công cụ

                          D. Thanh trạng thái

Câu 2: Để lưu trang tính ta phải sử dụng lệnh?

     A. File -> New
B. File -> Exit

     C. File -> Open
D. File -> Save

Câu 3: Để ngắt trang tính ta sử dụng lệnh nào?

     A. Print Preview
B. Page Break Preview

     C. Print
D. Cả A, B, C đều sai

Câu 4: Muốn đặt lề trên của trang tính thì trong hộp thoại PageSetup chọn ô?

     A. Top
B. Left

     C. Bottom
D. Right

Câu 5: Nút lệnh nào dùng để sắp xếp theo thứ tự tăng dần?

     A. [image: image39.png]



B. [image: image40.png]%l




     C. [image: image41.png]



D. Cả A, B, C đều sai.

Câu 6. Để giảm chữ số thập phân ta sử dụng lệnh nào?

     A. [image: image42.png]



B. [image: image43.png]



     C. [image: image44.png]



D. Cả A, B, C đều sai.

Câu 7: Biểu đồ cột dùng để?

A. So sánh dữ liệu và dự đoán xu thế của tăng hay giảm của dữ liệu.

B. Mô tả tỉ lệ của dữ liệu so với tổng thể.

C. So sánh dữ liệu trong nhiều cột.

D. Cả A, B, C đều sai.

Câu 8: Để lọc dữ liệu ta sử dụng lệnh?

     A. Data -> Filter -> AutoFilter.
B. Data -> Filter -> Show All.

     C. Data -> Sort.
D. Cả A, B, C đều sai.

Câu 9: Để vẽ biểu đồ ta dùng nút lệnh?

     A. [image: image45.png]



B. [image: image46.png]



      C. [image: image47.png]



D. [image: image48.png]



Câu 10: Để in trang tính ta sử dụng nút lệnh?

     A. [image: image49.png]



B. [image: image50.png]



     C. [image: image51.png]



D. [image: image52.png]



II: PHẦN TỰ LUẬN. 

Câu 1: Giả sử ô A1 có nền màu xanh và chữ màu đỏ. Ô A3 có nền màu trắng và chữ màu đen. Em hãy nêu cách sao chép nội dung ô A1 vào ô A3 và thử dự đoán xem sau khi sao chép ô A3 có nền và phông chữ màu gì?

Câu 2: Em hãy nêu các thao tác định dạng trang tính?

ĐÁP ÁN BIỂU ĐIỂM MÔN TIN HỌC 7

	Câu
	Đáp án
	Biểu điểm

	TRẮC NGHIỆM
	1 – C

2 – D

3 – B

4 – A

5 – C

6 – B

7 – C

8 – A

9 – D

10 - B
	o.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

	TỰ LUẬN
	1. - Chọn ô A1 nháy nút lệnh Copy

   - Chọn tới ô A3 nháy nút lệnh Paste

  - Ô A3 có nền màu xanh, phông chữ màu đỏ

2. Các thao tác dịnh dạng trang tính

  - Định dạng phông chữ, cỡ chữ, kiểu chữ

  - Chọn màu phông

  - Căn lề trong ô tính

  - Tăng hoặc giảm số chữ thập phân của dữ liệu số

 - Tô màu nền và kẻ đường biên của các ô tính
	0.5 đ

0.5 đ

1.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ

0.5 đ


4. Cñng cè

-  NhËn xÐt vÒ ý thøc lµm bµi cña häc sinh.

5. H­íng dÉn häc ë nhµ

- H­íng dÉn HS «n tËp chuÈn bÞ cho bµi kiÓm tra thùc hµnh cuèi n¨m.
v. rót kinh nghiÖm.

Ngµy so¹n: 









         TiÕt 70

kiÓm tra häc kú ii  

phÇn thùc hµnh  
I. Môc tiªu.
1. KiÕn thøc

- KiÓm ta viÖc n¾m b¾t kiÕn thøc thùc hµnh cña HS vÒ ®Þnh d¹ng trang tÝnh, tr×nh bµy trang in, s¾p xÕp vµ läc d÷ liÖu, vÏ biÓu ®å.

2. Kü N¨ng

- Thµnh th¹o c¸c thao t¸c trªn.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, trung thùc trong giê kiÓm tra.

II. ChuÈn bÞ.

1. Gi¸o viªn: §Ò bµi, ®¸p ¸n h­íng dÉn chÊm, phßng m¸y.

2. Häc sinh. Häc bµi ë nhµ.

III. Ph­¬ng ph¸p.
- Thùc hµnh trªn m¸y tÝnh

IV. TiÕn tr×nh giê d¹y – gi¸o dôc.
1. æn ®Þnh líp (1’)

2. KiÓm ra bµi cò

3. Bµi gi¶ng míi (40’)

Môn tin học 7

Cho bảng điểm học sinh:
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a. Khởi động chương trình bảng tính Excel và Vietkey rồi nhập đúng nội dung bảng trên.

b. Tính cột ĐTB của các môn học.

c. Sắp xếp lại cột ĐTB theo thứ tự tăng dần.

d. Dùng hàm Max tìm ra học sinh có ĐTB cao nhất.

e. Lọc ra học sinh có ĐTB là 8.0.

f. Tạo và nhập vào bảng hệ thống dưới xong vẽ đồ thị thích hợp để mô tả tỉ lệ lực học của học sinh so với tổng thể.

	HỌC LỰC
	SỐ HS

	Giỏi
	

	Khá
	

	Trung bình
	

	Yếu
	


ĐÁP ÁN BIỂU ĐIỂM MÔN TIN HỌC 7

	Câu
	Đáp án
	Biểu điểm

	a

b

c

d

e

f
	- Khởi động Excel và Vietkey, nhập đúng dữ liệu

- Sử dụng hàm tính AVERAGE tính cột ĐTB

- Chọn cột ĐTB và nháy nút lệnh sắp xếp tăng dần trên thanh công cụ

- Sử dụng hàm MAX (G3:G14)

- Chọn cột ĐTB, Data -> Filter -> AutoFilter. Chọn 8.0

- Tạo được bảng tổng hợp

- Vẽ đúng biểu đồ thích hợp
	2 đ

3 đ

1đ

1 đ

1 đ

1 đ

1 đ


4. Cñng cè (3’)

-  NhËn xÐt vÒ ý thøc lµm bµi cña häc sinh vµ cho ®iÓm.

5. H­íng dÉn häc ë nhµ (1’)

v. rót kinh nghiÖm.

KiÓm tra mét tiÕt

I - Môc tiªu

1. KiÕn thøc 

- KiÓm tra viÖc n¾m b¾t kiÕn thøc cña häc sinh vÒ ®Þnh d¹ng, tr×nh bµy, in Ên… ®Ó cã ph­¬ng ph¸p ®iÒu chØnh vÒ viÖc häc cña häc sinh còng nh­ viÖc d¹y cña gi¸o viªn.

2. Kü N¨ng

- Cã kü n¨ng lµm mét bµi kiÓm tra.

3. Th¸i ®é

- Nghiªm tóc, trung thùc khi lµm bµi.

II. ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, ®Ò bµi.

2. Häc sinh: ChuÈn bÞ kiÕn thøc c¸c bµi 6, 7, 8.

III - Ph­¬ng ph¸p

- Ho¹t ®éng c¸ nh©n.

IV - TiÕn tr×nh bµi gi¶ng

A - æn ®Þnh ( 1’ )

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: ®ñ


B - KiÓm tra bµi cò

C - Néi dung bµi kiÓm tra

Gi¸o viªn ph¸t ®Ò bµi, gi¸m s¸t viÖc lµm bµi cña häc sinh.

§Ò bµi

PhÇn I (4 ®iÓm): Tr¾c nghiÖm

1. §Ó më b¶ng tÝnh ®· cã trong m¸y ta sö dông lÖnh nµo?

A. New

B. Save

C. Open

D. Close

2. C¸c nót lÖnh B I U n»m trªn thanh nµo?


A. Thanh tiªu ®Ò



B. Thanh c«ng thøc


C. Thanh b¶ng chän


D. Thanh c«ng cô

3. §Ó ng¾t trang tÝnh ta sö dông lÖnh nµo?


A. Page Break Preview


B. Print Preview


C. Print




D. C¶ A, B, C ®Òu sai

4. Nót lÖnh nµo dïng ®Ó s¾p xÕp theo thø tù gi¶m dÇn?


A. 
[image: image54.png]







B.     [image: image55.png]




C. 
[image: image56.png]







D. C¶ A, B, C ®Òu sai

5. §Ó läc d÷ liÖu ta sö dông lÖnh nµo?


A. Data -> Sort



B. Data -> Filter -> Auto Filter


C. C¶ A, B ®Òu ®óng


D. C¶ A, B ®Òu sai

6. Muèn ®Æt lÒ ph¶i cña b¶ng tÝnh ta chän:


A. Top

B. Bottom

C. Left

D. Right

7. §Ó gép c¸c « vµ c¨n chØnh néi dung vµo chÝnh gi÷a « gép ®ã ta sö dông nót lÖnh:


A. 
[image: image57.png]




B.
[image: image58.png]




C. [image: image59.png]





D.  [image: image60.png]



8. §Ó t¨ng ch÷ sè thËp ph©n ta sö dông lÖnh:


A.  [image: image61.png]




B. [image: image62.png]




C.  [image: image63.png]



D. C¶ A, B, C ®Òu sai

PhÇn II (6 ®iÓm): Tù luËn

C©u 1 (2 ®iÓm): Gi¶ sö « A1 cã nÒn mµu vµng vµ ch÷ mµu ®á. ¤ A3 cã nÒn mµu tr¾ng, ch÷ mµu ®en. Em h·y nªu c¸ch sao chÐp néi dung ë « A1 vµo « A3 vµ thö dù ®o¸n sau khi sao chÐp « A3 cã nÒn vµ ph«ng ch÷ mµu g×?

C©u 2 (4 ®iÓm): Cho b¶ng ®iÓm häc sinh

B¶ng ®iÓm líp 7A

	STT
	Hä vµ tªn
	To¸n
	V¨n
	Tin
	§TB

	1
	NguyÔn Hoµ An
	8
	7
	8
	7.7

	2
	Lª Th¸i Anh
	8
	5
	7
	6.7

	3
	TrÇn Quèc B×nh
	8
	9
	9
	8.7

	4
	Ph¹m Ngäc Mai
	9
	9
	10
	9.3

	5
	Bïi Thu Hµ
	7
	6
	8
	7.0


e) Nªu c¸ch s¾p xÕp cét §TB theo thø tù t¨ng dÇn.

f) Nªu c¸ch läc häc sinh cã §TB lµ 9.3.

g) Sau khi läc, ®Ó hiÓn thÞ tÊt c¶ b¶ng ®iÓm ta lµm thÕ nµo?

h) §Ó tho¸t khái chÕ ®é läc ta lµm thÕ nµo?

i) Nªu c¸ch s¾p xÕp cét §TB theo thø tù t¨ng dÇn.

j) Nªu c¸ch läc häc sinh cã §TB lµ 9.3.

k) Sau khi läc, ®Ó hiÓn thÞ tÊt c¶ b¶ng ®iÓm ta lµm thÕ nµo?

l) §Ó tho¸t khái chÕ ®é läc ta lµm thÕ nµo?

§¸p ¸n + BiÓu ®iÓm

	C©u
	§¸p ¸n
	BiÓu ®iÓm

	PhÇn I.  1
	C
	0.5

	2
	D
	0.5

	3
	A
	0.5

	4
	B
	0.5

	5
	B
	0.5

	6
	D
	0.5

	7
	C
	0.5

	8
	A
	0.5

	PhÇn II. 1 
	- NhÊp chuét « A1, nh¸y nót lÖnh Copy.

- NhÊp chuét « A3, nh¸y nót Paste.

- NÒn vµng, ch÷ ®á.
	0.5

0.5

1

	2
	a) Nh¸y chuét « trong cét §TB, nh¸y nót lÖnh s¾p xÕp t¨ng dÇn.
	1

	
	b)  Data -> Filter -> AutoFilter -> Top 10 -> 1. Ok
	1

	
	c) Data -> Filter -> AutoFilter -> Show All.
	1

	
	d) Data -> Filter -> AutoFilter. 
	1


D - Cñng cè
- Gi¸o viªn thu bµi khi hÕt giê, nhËn xÐt ý thøc lµm bµi cña häc sinh.

E - H­íng dÉn vÒ nhµ
- H­íng dÉn häc sinh chuÈn bÞ bµi sau.

* KÕt qu¶

	Líp
	Giái
	Kh¸
	TB
	YÕu

	7A
	
	
	
	

	7B
	
	
	
	

	7C
	
	
	
	

	7D
	
	
	
	


V - Rót KinhNghiÖm

- Hs nghiªm tóc lµm bµi vµ lµm ®­îc bµi tèt.

- §Ò kiÓm tra phï hîp víi nhËn thøc cña häc sinh

	Ngµy so¹n:
	23.2.2008
	
	
	TiÕt 50

	Ngµy gi¶ng:
	7A:  25. 2
	7B:  27.2
	7C:  27 . 2
	7D:  25 . 2


häc to¸n víi toolkit math
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh ®­îc tiÕp cËn vµ lµm quen víi phÇn mÒm häc to¸n ®¬n gi¶n nh­ng h÷u Ých, ®Æc biÖt hç trî cho viÖc gi¶i b¶i tËp, tÝnh to¸n vµ vÏ ®å thÞ.

2. Kü N¨ng

- BiÕt khëi ®éng phÇn mÒm, nhËn d¹ng ®­îc mµn h×nh lµm viÖc cña phÇn mÒm.

- BiÕt tÝnh to¸n b»ng c¸c lÖnh ®¬n gi¶n vµ c¸c lÖnh phøc t¹p.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ tr­íc c¸c yªu cÇu cña gi¸o viªn. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh ( 1’ )

	7A: v4
	7b: ®ñ
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò ( kh«ng kiÓm trA )

C. Bµi míi ( 40’ )

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: Giíi thiÖu t¸c dông cña phÇn mÒm nh­ néi dung SGK.

GV: H­íng dÉn häc sinh c¸c thao t¸c c¸ch khëi ®éng phÇn mÒm.

GV: H­íng dÉn thao t¸c më giao diÖn phÇn mÒm.

GV: Giíi thiÖu lÇn l­ît c¸c phÇn a, b, c, d nh­ néi dung SGK.


	HS: Nghe vµ ghi chÐp néi dung.

HS: L¾ng nghe h­íng dÉn vµ thùc hiÖn.

HS: Tù thao t¸c khëi ®éng trªn m¸y tÝnh c¸ nh©n.

HS: Më giao diÖn vµ quan s¸t, t×m hiÓu mµn h×nh lµm viÖc cña phÇn mÒm.


	1. Giíi thiÖu phÇn mÒm

- PhÇn mÒm  ToolKit Math lµ lµ phÇn mÒm häc to¸n ®¬n gi¶n nh­ng h÷u Ých; lµ mét c«ng cô hç trî gi¶i bµi tËp, tÝnh to¸n, vÏ ®å thÞ..

2. Khëi ®éng phÇn mÒm

- Nh¸y ®óp chuét vµo biÓu t­îng trªn mµn h×nh.

- Nh¸y ®óp chuét vµo « c«ng cô ®¹i sè ®Ó b¾t ®Çu lµm viÖc víi phÇn mÒm.

3. Mµn h×nh lµm viÖc cña phÇn mÒm

a) Thanh b¶ng chän

Thùc hiÖn c¸c lÖnh chÝnh cña phÇn mÒm.

b) Cöa sæ dßng lÖnh

N»m ë phÝa d­íi cña mµn h×nh, ®­îc ng­êi dïng gâ c¸c dßng lÖnh vµ cho kÕt qu¶ trªn cöa sæ lµm viÖc chÝnh.

c) Cöa sæ lµm viÖc chÝnh

Thùc hiÖn tÊt c¶ c¸c lÖnh ®· thùc hiÖn cña phÇn mÒm.

d) Cöa sæ vÏ ®å thÞ

Lµ n¬i thÓ hiÖn kÕt qu¶ cña lÖnh vÏ ®å thÞ.

t¹i Expression to simplify -> OK.


D -  Cñng cè ( 3’ ) 

- Thao t¸c khëi ®éng phÇn mÒm.

- Nh¾c l¹i vÒ c¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña phÇn mÒm. 

E -  H­íng dÉn häc ë nhµ ( 1’ )

- Häc bµi theo yªu cÇu SGK.

- Thùc hµnh nÕu cã ®iÒu kiÖn.

V. Rót Kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

	Ngµy so¹n:
	23.2.2008
	
	
	TiÕt 51

	Ngµy gi¶ng:
	7A:  25. 2
	7B:  27.2
	7C:  27 . 2
	7D:  25 . 2


häc to¸n víi toolkit math
I -  Môc tiªu
1. KiÕn thøc

- TiÕp cËn vµ lµm quen víi phÇn mÒm häc to¸n ®¬n gi¶n, h÷u Ých. Hç trî cho viÖc gi¶i b¶i tËp, tÝnh to¸n vµ vÏ ®å thÞ.

2. Kü N¨ng

- BiÕt tÝnh to¸n b»ng c¸c lÖnh ®¬n gi¶n vµ c¸c lÖnh phøc t¹p.

3. Th¸i ®é

- Nghiªm tóc ghi chÐp, cÈn thËn trong qu¸ tr×nh thùc hµnh phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ tr­íc c¸c yªu cÇu cña gi¸o viªn. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh ( 1’ )

	7A: v4
	7b: ®ñ
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò ( Kh«ng kiÓm tra )

C. Bµi míi ( 40’ )

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: §­a ra bµi tËp ®Ó HS thùc hiÖn ph¸p tÝnh.

d) 1/5+3/4

e) 4.8+3.4+0.7

f) 2^4+(3/4)^2

? §Ó thùc hiÖn c¸c phÐp to¸n nµy ta sö dông lÖnh nµo ®Ó tÝnh? Nªu c¸c thùc hiÖn?

GV: Yªu cÇu HS thùc hiÖn tÝnh to¸n theo 2 c¸ch vµ c¸c m¸y ®­a ra kÕt qu¶.

? §Ó vÏ ®å thÞ hµm sè ta cã mÊy c¸ch?

- Yªu cÇu HS vÏ c¸c ®å thÞ: 

a) y=3x+1

b) y=3x^2-3

GV: Gi¸m s¸t viÖc lµm bµi cña HS. H­íng dÉn HS khi cÇn thiÕt.
	HS: Ghi chÐp ®Ò bµi.

-  Sö dông lÖnh Simplify.

-  Algebra -> Simplify.

- Tõng HS lÇn l­ît thùc hiÖn vµ ®­a ra kÕt qu¶.

HS: Suy nghÜ tr¶ lêi.

- Ghi l¹i yªu cÇu bµi tËp vµ tiÕn hµnh lµm bµi trùc tiÕp trªn m¸y.
	4. C¸c lÖnh tÝnh to¸n ®¬n gi¶n

a) TÝnh to¸n c¸c biÓu thøc ®¬n gi¶n

- PhÇn mÒm cã kh¶ n¨ng tÝnh to¸n chÝnh x¸c c¸c biÓu thøc ®¹i sè chøa c¸c sè nghuyªn hoÆc c¸c ch÷ sè thËp ph©n.

- NhËp phÐp to¸n tõ cöa sæ dßng lÖnh.

- NhËp phÐp to¸n tõ thanh b¶ng chän: Algebra -> Simplify -> Gâ BT t¹i Expression to simplify -> OK.

b) VÏ ®å thÞ

-  §Ó vÏ ®å thÞ mét hµm sè ®¬n gi¶n ta dïng lÖnh Plot tõ cöa sæ dßng lÖnh.

Vd: Plot y=3x+1

-  §å thÞ hµm sè xuÊt hiÖn trªn cöa sæ vÏ ®å thÞ cña phÇn mÒm.




D -  Cñng cè ( 3’ )

- Nh¾c l¹i vÒ c¸c thµnh phÇn trªn mµn h×nh lµm viÖc cña phÇn mÒm. 

-  C¸c lÖnh tÝnh to¸n ®¬n gi¶n.

E -  H­íng dÉn häc ë nhµ ( 1’ )

- Häc bµi theo yªu cÇu SGK.

- Thùc hµnh nÕu cã ®iÒu kiÖn.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

	Ngµy so¹n:
	23.2.2008
	
	
	TiÕt 52 + 53
	

	Ngµy gi¶ng:
	7A:  3 . 3 
	7B:  5 . 3
	7C:  5 . 3 
	7D:  3 . 3 
	


häc to¸n víi toolkit math
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh thùc hiÖn vµ thao t¸c ®­îc víi c¸c lÖnh phøc t¹p h¬n.

- C¸c chøc n¨ng kh¸c cña phÇn mÒm.

- Thùc hiÖn ®­îc c¸ch ®Æt nÐt vÏ, mµu s¾c, c¸ch sö dông lÖnh xo¸ Clear.

2. Kü N¨ng

- H×nh thµnh kü n¨ng ham mª tÝnh to¸n, häc hái. T­ duy logic, s¸ng t¹o.

- Thµnh th¹o c¸c thao t¸c víi c¸c lÖnh tÝnh to¸n tõ ®¬n gi¶n ®Õn phøc t¹p.

3. Th¸i ®é

- TËp trung, nghiªm tóc, chó ý cao trong giê häc. Cã ý thøc b¶o vÖ tµi s¶n phßng m¸y.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: ChuÈn bÞ tr­íc c¸c yªu cÇu cña gi¸o viªn. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh ( 1’ )

	7A: ®ñ
	7b: v3
	7C: ®ñ
	7®: ®ñ


B. KiÓm ra bµi cò ( kh«ng kiÓm tra )

C. Bµi míi ( 40’ )

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: LÖnh Simplify kh«ng nh÷ng cho phÐp tÝnh to¸n víi c¸c phÐp tÝnh ®¬n gi¶n mµ cßn cã thÓ th­c hiÖn nhiÒu phÐp tÝnh phøc t¹p víi c¸c lo¹i biÓu thøc ®¹i sè kh¸c nhau.

Vd: (((3/2)+(4/5))/((2/3)-  (1/5)))+17/20

GV; Giíi thiÖu lÖnh Expand vµ c¸ch thùc hiÖn lÖnh.

? Rót gän biÓu thøc ta lµm ntn?

? KÕt qu¶ sÏ xuÊt hiÖn ë ®©u?

GV: Giíi thiÖu lÖnh Solve.

-  Gäi HS lªn lµm.

GV: Giíi thiÖu lÖnh Make.

-  Gäi HS lªn b¶ng thùc hiÖn phÐp to¸n.

GV: Giíi thiÖu HS tham kh¶o SGK trang 117.

GV: Giíi thiÖu lÖnh xo¸ th«ng tin trªn cöa sæ vÏ ®å thÞ.

GV: Giíi thiÖu c¸c lÖnh ®Æt nÐt vÏ vµ mµu s¾c trªn cöa ssæ vÏ ®å thÞ.

GV: Gäi mét sè HS cñng cè l¹i c¸c kiÕn thøc lÝ thuyÕt c¬ b¶n vÒ phÇn mÒm TIM.

-  Yªu cÇu HS khëi ®éng m¸y tÝnh vµ phÇn mÒm TIM thùc hiÖn c¸c bµi tËp trong SGK trang 118.
	HS: Chó ý l¾ng nghe.

HS: Nghe vµ ghi nhí kiÕn thøc.

HS: Suy nghÜ tr¶ lêi.

HS: Chó ý quan s¸t vµ lµm theo yªu cÇu cña GV.

HS: Quan s¸t, ghi chÐp vµ thùc hµnh.

HS: §äc s¸ch.

HS: Chó ý l¾ng nghe, quan s¸t vµ ghi chÐp.

HS: Nhí vµ nh¾c l¹i c¸c kiÕn thøc c¬ b¶n ®· ®­îc häc víi TIM vµ vËn dông thùc hµnh lµm c¸c bµi tËp GV yªu cÇu.
	5. C¸c lÖnh tÝnh to¸n n©ng cao

a) BiÓu thøc ®¹i sè

-  Có ph¸p.

-  Simplify <BiÓu thøc>

Vd: 

Simplify (3/2+4/5)/(2/3-  1/5)+17/20

KÕt luËn: Ta cã thÓ thùc hiÖn ®­îc mäi tÝnh to¸n trªn c¸c biÓu thøc ®¹i sè víi ®é phøc t¹p bÊt kú.

b) TÝnh to¸n víi ®a thøc Expand

-  Có ph¸p: Expand <BiÓu thøc>

-  Algebra -> Expand -> NhËp BT -> OK.

Vd: Expand (2*x^2*y)*(9*x^3*y^2)

c) Gi¶i ph­¬ng tr×nh ®¹i sè

- Có ph¸p: Solve <Ph­¬ng tr×nh> <Tªn biÕn>.

Vd: Solve 3*x+1=0x

d) §Þnh nghÜa ®a thøc vµ ®å thÞ

-  Có ph¸p: Make <Tªn hµm> <§a thøc>

Vd: Make P(x) 3*x-  2

6. C¸c chøc n¨ng kh¸c

a) lµm viÖc trªn cöa sæ dßng lÖnh

b) LÖnh xo¸ th«ng tin trªn cöa sæ vÏ ®å thÞ

-  LÖnh Clear ®Ó xo¸ toµn bé th«ng tin hiÖn cã trªn cöa sæ vÏ ®å thÞ.

c) C¸c lÖnh ®Æt nÐt vÏ vµ mµu s¾c trªn cöa sæ vÏ ®å thÞ

-  C¸c lÖnh: 

Penwidth + ChØ sè ®é dµy.

Pencolor + Tªn mµu (Red, Blue, Black, yellow, magenta…).

7. Thùc hµnh

-  C¸c kiÕn thøc lÝ thuyÕt c¬ b¶n.

-  Bµi tËp trang 118 SGK.


D -  Cñng cè ( 3’ )

- GV sö dông b¶ng phô tãm t¾t c¸c kiÕn thøc ®· häc víi phÇn mÒm TIM.

E -  H­íng dÉn häc ë nhµ (1’ )

- H­íng dÉn HS vÒ «n bµi, luyÖn tËp vµ chuÈn bÞ cho bµi sau.

V - Rót kinh nghiÖm

- Bµi so¹n phï hîp víi tiÕt d¹y

- Häc sinh thùc hµnh tèt vµ n¾m ch¾c kiÕn thøc

- Thêi gian ®¶m b¶o

- Hoµn thµnh néi dung gi¸o ¸n.

	Ngµy so¹n:
	4. 3 . 2008
	
	
	TiÕt 54-55

	Ngµy gi¶ng:
	7A: 14 . 3
	7B:  5 . 3 
	7C:  12 . 3
	7D:  10 . 3


tr×nh bµy d÷ liÖu b»ng biÓu ®å
I -  Môc tiªu
1. KiÕn thøc

- BiÕt môc ®Ých cña viÖc sö dông biÓu ®å.

- Mét sè d¹ng biÓu ®å th«ng th­êng.

-  C¸c b­íc cÇn thiÕt ®Ó t¹o mét biÓu ®å tõ b¶ng d÷ liÖu.

-  Thay ®æi d¹ng biÓu ®å ®· t¹o, xo¸, sao chÐp biÓu ®å vµo v¨n b¶n Word.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o c¸c thao t¸c víi biÓu ®å.

3. Th¸i ®é

- H×nh thµnh th¸i ®é ham mª häc hái, yªu thÝch m«n häc.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: Nghiªn cøu tr­íc bµi häc ë nhµ. 

III -  Ph­¬ng ph¸p
ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh ( 1’ )

	7A: v1
	7b: v2
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò ( kh«ng kiÓm tra )

C. Bµi míi ( 40’)

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: Theo em t¹i sao mét sè lo¹i d÷ liÖu l¹i ®­îc biÓu diÔn d­íi d¹ng biÓu ®å?

? Trong ch­¬ng tr×nh phæ th«ng em ®· ®­îc häc c¸c lo¹i biÓu ®å nµo? Em cã biÕt t¸c dông riªng cña mçi lo¹i biÓu ®å Êy kh«ng?

GV: Giíi thiÖu c¸ch t¹o biÓu ®å trªn ch­¬ng tr×nh b¶ng tÝnh Excel.

GV: H­íng dÉn HS c¸ch chän biÓu ®å phï hîp víi néi dung d÷ liÖu.

- H­íng dÉn HS c¸ch kiÓn tra miÒn d÷ liÖu.

GV: Gi¶i thÝch cho HS c¸c th«ng tin trong biÓu ®å khi t¹o.

GV: Khi t¹o biÓu ®å c¸c em cÇn biÕt vÞ trÝ n¬i ®Æt cña biÓu ®å.

GV: H­íng dÉn HS c¸c c¸ch chØnh söa biÓu ®å:

-  Thay ®æi vÞ trÝ.

-  Thay ®æi d¹ng biÓu ®å.

-  Xo¸ biÓu ®å.

- Sao chÐp biÓu ®å vµo v¨n b¶n Word.
	HS: Suy nghÜ tr¶ lêi.

HS: Nhí l¹i vµ tr¶ lêi.

HS: Quan s¸t vµ ghi chÐp.

- Chó ý quan s¸t.

- Quan s¸t vµ thùc hiÖn.

HS: Chó ý l¾ng nghe vµ ghi chÐp.

HS: Quan s¸t vµ ghi chÐp néi dung cÇn thiÕt.

-  Th­c hµnh l¹i c¸c thao t¸c d­íi sù h­íng dÉn cña GV.
	1. Minh ho¹ sè liÖu b»ng biÓu ®å

-  Môc ®Ých cña viÖc sö dông biÓu ®å:

BiÓu diÔn d÷ liÖu trùc quan, dÔ hiÓu, dÔ so s¸nh, dù ®o¸n xu thÕ t¨ng-gi¶m cña d÷ liÖu.

2. Mét sè d¹ng biÓu ®å

- BiÓu ®å cét: So s¸nh d÷ liÖu cã trong nhiÒu cét.

-  BiÓu ®å ®­êng gÊp khóc: So s¸nh d÷ liÖu vµ dù ®o¸n xu thÕ t¨ng-gi¶m cña d÷ liÖu.

-  BiÓu ®å h×nh trßn: M« t¶ tØ lÖ cña gÝ trÞ d÷ liÖu so víi tæng thÓ.

3. T¹o biÓu ®å

- Nh¸y nót lÖnh Chart Wizard. XHHT Chart Wizard. 

- Nh¸y nót Next trªn c¸c hép tho¹i vµ nh¸y nót Finish ®Ó kÕt thóc.

a) Chän d¹ng biÓu ®å

-  Chart Types: Chän nhãm biÓu ®å.

-  Chart Sub-types: Chän d¹ng biÓu ®å trong nhãm.

-  Nh¸y Next ®Ó sang b­íc 2.

b) X¸c ®Þnh miÒn d÷ liÖu 

-  Data Range: KiÓm tra miÒn d÷ liÖu vµ söa ®æi nÕu cÇn.

- Series in: Chän d·y d÷ liÖu cÇn minh ho¹ theo hµng hay cét.

-  Nh¸y Next ®Ó chuyÓn sang b­íc 3.

c) C¸c th«ng tin gi¶i thÝch biÓu ®å

-  Chart title: Tiªu ®Ò.

- Ctegory (X) axis: Chó gi¶i trôc ngang.

-  Value (Y) axis: Chó gi¶i trôc ®øng.

-  Nh¸y Next ®Ó sang b­íc 4.

d. VÞ trÝ ®Æt biÓu ®å

- As a new sheet: Trªn trang tÝnh míi.

-  As object in: Trªn trang chøa DL.

-  Nh¸y Finish ®Ó kÕt thóc.

4. ChØnh söa biÓu ®å

a) Thay ®æi vÞ trÝ cña biÓu ®å

-  Thùc hiÖn thao t¸c kÐo th¶ chuét.

b) Thay ®æi d¹ng biÓu ®å

-  Nh¸y mòi tªn ®Ó ë b¶ng chän B§.

-  Chän kiÓu biÓu ®å thÝch hîp.

c) Xo¸ biÓu ®å

-  Nh¸y chuét trªn biÓu ®å vµ nhÊn phÝm Delete.

d) Sao chÐp biÓu ®å vµo v¨n b¶n 

- Nh¸y chän biÓu ®å vµ nh¸y nót lÖnh Copy.

- Më v¨n b¶n Word vµ nh¸y chuét nót lÖnh Paste.


D -  Cñng cè (3’)

- Cñng cè l¹i c¸c kiÕn thøc c¬n b¶n cña viÖc sö dông biÓu ®å trong ch­¬ng tr×nh b¶ng tÝnh.

-  C¸ch chÌn biÓu ®å vµo v¨n b¶n Word.

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ «n bµi, ®äc tr­íc bµi thùc hµnh sè 9.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

	Ngµy so¹n:
	15 . 3 .2008
	
	
	TiÕt 56-57

	Ngµy gi¶ng:
	7A:  21 . 3 + 28/3
	7B:  12 . 3+ 19/3
	7C:  19 . 3 
	7D: 17 . 3 + 24/3


Bµi thùc hµnh 9

t¹o biÓu ®å ®Ó minh ho¹
I -  Môc tiªu
1. KiÕn thøc

- ¤n l¹i c¸ch nhËp c¸c c«ng thøc vµ hµm vµo « tÝnh.

- Thùc hiÖn ®­îc c¸c thao t¸c t¹o biÓu ®å ®¬n gi¶n.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o thao t¸c vÏ biÓu ®å, c¸c c¸ch tÝnh to¸n trong « tÝnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, chó ý trong thùc hµnh.

-  Cã ý thøc b¶o vÖ cña c«ng.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: Nghiªn cøu tr­íc bµi häc ë nhµ. 

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’)

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò 

- KÕt hîp trong giê thùc hµnh.

C. Bµi míi (40’)

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: Yªu cÇu HS më m¸y, khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel, nhËp d÷ liÖu vµo trang tÝnh nh­ h×nh 113.

? TÝnh cét Tæng céng ta lµm ntn? 

GV: Yªu cÇu HS thùc hiÖn t¹o biÓu ®å víi khèi d÷ liÖu A4:D9.

? §Ó cã ®­îc d÷ liÖu nh­ h×nh 114 ta lµm ntn?

GV: Yªu cÇu HS xo¸ cét Nam trong b¶ng d÷ liÖu.

- Yªu cÇu tõng HS t¹o biÓu ®å víi d÷ liÖukhèi A4:A9 víi c¸c th«ng tin gi¶i thÝch trªn biÓu ®å.

- Yªu cÇu HS t¹o míi biÓu ®å ®­êng gÊp khóc víi khèi d÷ liÖu A4:C9.

- Yªu cÇu HS ®æi biÓu ®å  môc d cña BT1 thµnh biÓu ®å ®­êng gÊp khóc.

- Yªu cÇu HS so s¸nh kÕt qu¶ nhËn ®­îc ë môc a.

? §Ó thay ®æi d¹ng biÓu ®å ta lµm ntn?

- Yªu cÇu HS thay ®æi d¹g biÓu ®å nh­ h×nh 116.

? §Ó xo¸ cét ta lµm ntn?

- Yªu cÇu HS thùc hiÖn thao t¸c xo¸ cét ®Ó cã trang tÝnh nh­ h×nh 117.

GV : Yªu cÇu HS t¹o biÓu ®å h×nh trßn trªn c¬ së d÷ liÖu cña khèi A4:B9.

- Yªu cÇu HS ®æi biÓu ®å nhËn ®­îc thµnh biÓu ® ®­êng gÊp khóc vµ biÓu ®å cét.

? §Ó l­u b¶ng tÝnh ta lµm ntn?

GV: Yªu cÇu HS më b¶ng tÝnh “B¶ng ®iÓm líp em” ®· l­u trong bµi thùc hµnh 7.

GV: Yªu cÇu HS tÝnh ®iÓm trung b×nh theo tõng m«n.

- Yªu cÇu HS t¹o biÎu ®å cét ®Ó minh ho¹ §TB cña c¸c m«n häc.

? §Ó sao chÐp biÓu ®å trªn trang tÝnh vµo Word ta lµm ntn?

- Yªu cÇu HS thùc hiÖn thao t¸c sao chÐp sang Word.
	HS: Më m¸y tÝnh, khëi ®éng Excel vµ nhËp d÷ liÖu vµo trang tÝnh.

=SUM(B5,C5)

HS: Thùc hµnh theo yªu cÇu cña gi¸o viªn.

HS: Tr¶ lêi.

HS: Thùc hiÖn thao t¸c xo¸ cét.

HS: T¹o míi biÓu ®å ®­êng gÊp khóc.

- §æi biÓu ®å môc d bµi tËp 1 thµnh biÓu ®å ®­êng gÊp khóc.

HS: Quan s¸t so s¸nh vµ nhËn xÐt.

HS: Tr¶ lêi.

HS: Thùc hiÖn theo yªu cÇu.

HS: Tr¶ lêi.

HS: Lµm theo yªu cÇu cña GV.

HS: Thùc hiÖn thao t¸c ®æi biÓu ®å.

HS: Tr¶ lêi.

HS: Lµm theo yªu cÇu.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Thùc hµnh theo yªu cÇu cña GV.
	1. Bµi tËp 1

a) NhËp d÷ liÖu

=SUM(B5,C5)

b) T¹o biÓu ®å víi d÷ liÖu khèi A:D9

c) Thùc hiÖn c¸c thao t¸c ®Ó cã trang tÝnh nh­ h×nh 114

d) T¹o biÓu ®å víi d÷ liÖu khèi A4:C9

2. Bµi tËp 2

a) T¹o biÓu ®å ®­êng gÊp khóc víi d÷ liÖu khèi A 4:C9

b) Thay ®æi d¹ng biÓu ®å

c) Thay ®æi d¹ng biÓu ®å

d) Xo¸ cét

e) T¹o biÓu ®å h×nh trßn

g) L­u b¶ng tÝnh

3. Bµi tËp 3

a) TÝnh §TB theo tõng m«n häc cña c¶ líp vµo hµng d­íi cïng cña danh s¸ch d÷ liÖu

b) T¹o biÓu ®å h×nh cét

c) Sao chÐp biÓu ®å ®­îc t¹o trªn trang tÝnh vµo v¨n b¶n Word


D -  Cñng cè (3’)

- Gi¸o viªn kiÓm tra viÖc lµm bµi cña tõng m¸y, söa lçi vµ nhËn xÐt ý thøc thùc hµnh, kÕt qu¶ cña mçi m¸y.

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ «n bµi, ®äc tr­íc bµi häc vÏ h×nh häc ®éng víi Geogebra.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

	Ngµy so¹n:
	15.3.2008
	
	
	TiÕt 58-59

	Ngµy gi¶ng:
	7A:  28/3
	7B:  19/3+26/3
	7C: 26/3
	7D: 24/3


häc vÏ h×nh häc ®éng víi geogebra
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh biÕt vµ ph©n biÖt ®­îc c¸c thµnh phÇn chÝnh trªn mµn h×nh.

- BiÕt c¸ch khëi ®éng.

- BiÕt c¸c c«ng cô vµ ®iÒu khiÓn h×nh.

- BiÕt c¸ch më, ghi tÖp, tho¸t khái phÇn mÒm.

- VÏ ®­îc h×nh.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o thao t¸c trªn.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, chó ý trong giê häc.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: Nghiªn cøu tr­íc bµi häc ë nhµ. 

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh ( 1’)

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: ®ñ


B. KiÓm ra bµi cò

- KÕt hîp trong giê häc.

C. Bµi míi (40’)

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: PhÇn mÒm Geoebra cho phÐp thiÕt kÕ c¸c h×nh ®Ó häc h×nh häc trong ch­¬ng tr×nh m«n To¸n ë phæ th«ng…

GV: T­¬ng tù nh­ c¸c phÇn mÒm kh¸c em h·y thö nªu c¸ch khëi ®éng víi phÇn mÒm Geogebra?

-  Sau khi khëi ®éng phÇn mÒn th× mµn h×nh lµm viÖc chÝnh gåm nh÷ng thµnh phÇn g×?

GV: Treo b¶ng phô giíi thiÖu c¸c thµnh phÇn chÝnh cña phÇn mÒm Geogebra.

GV: Giíi thiÖu c¸c c«ng cô vÏ vµ ®iÒu khiÓn h×nh cã trong phÇn mÒm.

? §Ó chän mét c«ng cô ta lµm ntn?

GV: Chóng ta ®· biÕt, víi Word cã phÇn më réng lµ .doc, Excel lµ .xls cßn víi Geogebra lµ .ggb. 

? C¸ch më vµ l­u víi tÖp Geogebra?

GV: §Ó tho¸t khái phÇn mÒm ta lµm ntn?

GV: Treo b¶ng phô h­íng dÉn HS c¸ch vÏ tam gi¸c ABC.

GV: Yªu cÇu HS khëi ®éng phÇn mÒm Geo vµ tõng HS thùc hiÖn thao t¸c vÏ tam gi¸c trªn m¸y tÝnh.

? §Ó thùc hiÖn thao t¸c di chuyÓn ta sö dông nót lÖnh nµo?

GV: Yªu cÇu HS thùc hiÖn di chuyÓn c¸c ®iÓm A, B, C.

GV: Yªu cÇu HS l­u l¹i c¸c tÖp h×nh ®· vÏ.

GV: Yªu cÇu HS më l¹i c¸c tÖp ®· l­u.

? §Ó tho¸t khëi phÇn mÒm ta lµm ntn?

GV: Yªu cÇu HS tho¸t khái phÇn mÒm Geo.
	HS: Chó ý l¾ng nghe.

HS: Suy nghÜ tr¶ lêi. (Nh¸y ®óp chuét vµo biÓu t­îng cña phÇn mÒm).

HS: Quan s¸t vµ tr¶ lêi.

HS: Ghi chÐp.

HS : Quan s¸t vµ ghi chÐp.

HS : Tr¶ lêi.

HS : Ghi chÐp.

HS: Suy nghÜ tr¶ lêi. 

HS : Suy nghÜ tr¶ lêi.

HS : Chó ý quan s¸t vµ nghe gi¶ng.

HS: Thùc hµnh vÏ theu yªu cÇu cña GV.

HS: Suy nghÜ tr¶ lêi.

HS: Thùc hiÖn di chuyÓn ®iÓm.

HS: Thùc hiÖn l­u tÖp.

HS: Thùc hiÖn më tÖp ®· cã.

HS: Tr¶ lêi vµ tiÕn hµnh thao t¸c tho¸t khái phÇn mÒm.
	1. Giíi thiÖu phÇn mÒm

2. Lµm quen víi phÇn mÒm

a) Khëi ®éng

- Nh¸y ®óp chuét biÓu t­îng cña Geogebra.

b) Giíi thiÖu mµn h×nh

- Thanh b¶ng chän.

- Thanh c«ng cô.

- Khu vùc trung t©m.

c) C¸c c«ng cô vÏ vµ ®iÒu khiÓn mµn h×nh

d) Më vµ ghi tÖp vÏ h×nh

- Më tÖp: File -> Open. Chän tÖp cÇn më -> Open.

- Ghi tÖp: File -> Save. Gâ tªn ë « File name -> Save.

e) Tho¸t khái phÇn mÒm

File -> Exit.

3. VÏ h×nh ®Çu tiªn: Tam gi¸c ABC

a) L­u tÖp

b) Më tÖp

c) Tho¸t khái phÇn mÒm




D -  Cñng cè (3’)

- Gi¸o viªn kiÓm tra viÖc thùc hµnh vÏ ta gi¸c cña tõng m¸y, söa lçi vµ nhËn xÐt ý thøc thùc hµnh, kÕt qu¶ cña mçi m¸y.

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS ®äc tiÕp c¸c phÇn cßn l¹i bµi häc vÏ h×nh häc ®éng víi Geogebra.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

- Hoµn thµnh néi dung bµi gi¶ng.

	Ngµy so¹n:
	15/3/2008
	
	
	TiÕt 60-61

	Ngµy gi¶ng:
	7A:  4/4
	7B: 2/4
	7C: 2/4
	7D: 31/3


häc vÏ h×nh häc ®éng víi geogebra
I -  Môc tiªu
1. KiÕn thøc

- Häc sinh b­íc ®Çu hiÓu ®­îc c¸c ®èi t­îng h×nh häc c¬ b¶n cña phÇn mÒm vµ quan hÖ gi÷a chóng.

- Häc sinh biÕt vµ hiÓu c¸c øng dông cña phÇn mÒm trong viÖc vÏ vµ minh ho¹ h×nh häc trong ch­¬ng tr×nh m«n To¸n.

- Cñng cè l¹i c¸c c¸ch vÏ c¸c h×nh c¬ b¶n. T¹o ®­îc giao ®iÓm 3 ®­êng cao, 3 ®­êng trung tuyÕn, 3 ®­êng ph©n gi¸c... 

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o tÊt c¶ c¸c thao t¸c víi Geogebra.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. Thªm yªu thÝch m«n häc.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: Nghiªn cøu tr­íc bµi häc ë nhµ. 

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’)

	7A: v1
	7b: v3
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò (5’)

? Em h·y nªu c¸ch khëi ®éng phÇn mÒm vµ c¸c thµnh phÇn chÝnh cña mµn h×nh lµm viÖc víi phÇn mÒm Geogebra. 

§A: - Nh¸y ®óp chuét trªn biÓu t­îng cña phÇn mÒm.

       
- Thanh b¶ng chän.

- Thanh c«ng cô.

- Khu vùc trung t©m.

C. Bµi míi ( 35’)

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: Em h·y kÓ tªn c¸c quan hÖ gi÷a c¸c ®èi t­îng h×nh häc ®· häc trong m«m to¸n H×nh.

GV: Treo b¶ng phô giíi thiÖu mét sè quan hÖ vµ c¸ch thiÕt lËp trong phÇn mÒm.

GV: Giíi thiÖu c¸c lÖnh th­êng dïng trong Geogebra.

GV: Giíi thiÖu thao t¸c di chuyÓn nh·n cña ®èi t­îng.

GV: Giíi thiÖu thao t¸c lµm Èn 1 ®èi t­îng h×nh.

GV: Giíi thiÖu thao t¸c lµm Èn/hiÖn nh·n 1 ®èi t­îng h×nh.

GV: Giíi thiÖu thao t¸c xo¸ 1 ®èi t­îng h×nh.

GV: Giíi thiÖu thao t¸c ®æi tªn, nh·n ®èi t­îng h×nh.

GV: Giíi thiÖu thao t¸c phãng to, thu nhá ®èi t­îng h×nh.

GV: Giíi thiÖu thao t¸c di chuyÓn ®èi t­îng h×nh.

GV: Yªu cÇu häc sinh lÇn l­ît lµm l¹i tÊt c¶ c¸c thau t¸c ®· häc.

GV: Yªu cÇu häc sinh lµm c¸c bµi tËp SGK trang 125.

GV: Chó ý ®i xung quanh h­íng dÉn HS c¸c thao t¸c khã. 

- KiÓm tra viÖc thùc hµnh cña häc sinh. Söa sai vµ cho ®iÓm.
	HS: Suy nghÜ tr¶ lêi.

HS: Quan s¸t, chó ý l¾ng nghe vµ ghi chÐp.

HS: Chó ý l¾ng nghe vµ ghi chÐp.

HS: Chó ý quan s¸t.

HS: Chó ý quan s¸t.

HS: Chó ý quan s¸t.

HS: Quan s¸t vµ ghi chÐp.

HS: Quan s¸t vµ ghi chÐp.

HS: Quan s¸t vµ ghi chÐp.

HS: Thùc hiÖn l¹i c¸c thao t¸c.

HS: Lµm bµi tËp thùc hµnh.


	4. Quan hÖ gi÷a c¸c ®èi t­îng h×nh häc

(HS nghiªn cøu thªm SGK)

5. Mét sè lÖnh hay dïng

a) DÞch chuyÓn nh·n cña ®èi t­îng

-  Dïng c«ng cô chän vµ thùc hiÖn thao t¸c kÐo th¶ chuét xung quanh ®èi t­îng ®Õn vÞ trÝ míi. 

b) Lµm Èn mét ®èi t­îng h×nh häc

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Show Object.

c) Lµm Èn/hiÖn nh·n cña ®èi t­îng

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Show label.

d) Xo¸ mét ®èi t­îng

C1 : Nh¸y chän ®èi t­îng vµ nhÊn phÝm Delete.

C2: Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Delete.

e) Thay ®æi tªn, nh·n cña ®èi t­îng

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Rename. Gâ tªn míi -> Apply.

g) Phãng to, thu nhá c¸c ®èi t­îng trªn mµn h×nh

- Nh¸y chuét ph¶i lªn ®èi t­îng vµ chän Room. 
h) Di chuyÓn toµn bé c¸c ®èi t­îng h×nh häc trªn mµn h×nh

- Gi÷ Ctrl + Chuét tr¸i vµ thao t¸c kÐo th¶ chuét.

6. Bµi tËp thùc hµnh

(Trang 125 SGK)


D -  Cñng cè (3’)

- Gi¸o viªn nh¾c l¹i tÊt c¶ c¸c thao t¸c víi phÇn mÒm Geogebra.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp vµ ®äc tr­íc bµi thùc hµnh 10.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

- Gv cÇn quan s¸t häc sinh thùc hµnh ®Ó cã thÓ ®iÒu chØnh hîp lý

	Ngµy so¹n:
	
	
	
	TiÕt 62-63

	Ngµy gi¶ng:
	7A: 
	7B: 
	7C: 
	7D: 


Bµi thùc hµnh sè 10

bµi thùc hµnh tæng hîp
I -  Môc tiªu
1. KiÕn thøc

- Cñng cè l¹i cho HS c¸ch lËp trang tÝnh, ®Þnh d¹ng, sö dông c«ng thøc, c¸c hµm vµ tr×nh bµy trang in.

- Sö dông nót lÖnh Print Preview ®Ó xem tr­íc khi in.

2. Kü N¨ng

- Thùc hiÖn thµnh th¹o c¸c thao t¸c trong trang tÝnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. 

-  B¶o vÖ cña c«ng, yªu thÝch m«n häc.

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: Nghiªn cøu tr­íc bµi häc ë nhµ. 

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’)

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: ®ñ


B. KiÓm ra bµi cò

- KÕt hîp trong giê thùc hµnh. 

C. Bµi míi (40’)

	Ho¹t ®éng cña  GV
	H§ cña HS
	Ghi b¶ng

	GV: Yªu cÇu HS khëi ®éng Excel vµ nhËp d÷ liÖu vµo trang tÝnh nh­ h×nh 119.

? §Ó ®iÒu chØnh ®é réng cét, ®é cao hµng ta lµm ntn?

? §Ó c¨n chØnh tiªu ®Ò ta lµm ntn?

? Nªu c¸c thao t¸c ®Ó kÎ khong cho « tÝnh?

? Nh¾c l¹i c¸c thao t¸c sao chÐp vµ chØnh söa d÷ liÖu trong « tÝnh.

? §Ó t¹o mµu nÒn cho « tÝnh ta lµm ntn?

? §Ó t¹o mµu ch÷ cho « tÝnh ta lµm ntn?

GV: Yªu cÇu HS më b¶ng tÝnh Bµi tËp 1 ®· l­u.

? §Ó tÝnh cét tæng céng ta lµm ntn?

? T¹i sao cÇn xem trang tÝnh tr­íc khi in?

? §Ó xem tr­íc khi in ta lµm ntn? 

GV: Yªu cÇu HS nhËp d÷ liÖu vµo trang tÝnh.

? §Ó tÝnh cét tæng céng ta lµm ntn?

? §Ó tÝnh thu nhËp trung b×nh theo tõng ngµnh ta lµm ntn?

GV: Yªu cÇu HS l­u l¹i b¶ng tÝnh víi tªn Baitap2.

GV: Gi¸m s¸t viÖc thùc hµnh cña HS, h­íng dÉn HS khi cÇn.
	HS: Më m¸y, khëi ®éng Excel vµ nhËp d÷ liÖu.

HS: Suy nghÜ tr¶ lêi.

HS: Suy nghÜ tr¶ lêi.

HS: Suy nghÜ tr¶ lêi.

HS: Suy nghÜ tr¶ lêi.

HS: Suy nghÜ tr¶ lêi.

HS: Suy nghÜ tr¶ lêi.

HS: Thùc hiÖn theo yªu cÇu cña GV vµ tr¶ lêi c©u hái.

HS: Tr¶ lêi.

HS: Thùc hiÖn thao t¸c.

HS: NhËp d÷ liÖu.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Thùc hiÖn thao t¸c l­u l¹i trang tÝnh theo yªu cÇu GV.


	1. Bµi tËp 1

a) Khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel vµ nhËp d÷ liÖu vµo trang tÝnh

b) §iÒu chØnh hµng, cét vµ ®Þnh d¹ng

- §iÒu chØnh hµng, cét: 

+ §­a con trá vµo v¹ch ph©n c¸ch gi÷a hµng hay cét vµ thùc hiÖn thao t¸c kÐo th¶ chuét ®Ó t¨ng hay gi¶m ®é réng cét, ®é cao hµng.

- C¨n chØnh tiªu ®Ò

+ Chän c¸c « cÇn c¨n chØnh, nh¸y nót Merge and Center.

- KÎ khung

+ Chän c¸c « cÇn kÎ khung.

+ Nh¸y nót Border chän kiÓu vÏ ®­êng biªn.

c) Sao chÐp vµ chØnh söa d÷ liÖu

-  Sao chÐp

+ Chän « cÇn sao chÐp.

+ Nh¸y nót lÖnh Copy.

+ Trá tíi vÞ trÝ míi.

+ Nh¸y nót lÖnh Paste.

- T¹o mµu nÒn vµ mµu ch÷

Mµu nÒn

+ Chän « hoÆc c¸c « cÇn t¹o mµu nÒn.

+ Nh¸y nót Fill Colors.

Mµu ch÷

+ Chän « hoÆc c¸c « cÇn t¹o mµu ch÷.

+ Nh¸y nót Font Color.

d) LËp c«ng thøc ®Ó rÝnh tægn sè hiÖn vËt

- Dïng c«ng thøc:

=D5+D14

-  Dïng hµm:

=SUM(D5,D14)

2. Bµi tËp 2

Xem tr­íc trang in

a) Khëi ®éng Excel vµ nhËp d÷ liÖu vµo trang tÝnh

b) Sö dông c¸c hµm ®Ó tÝnh to¸n

-  TÝnh trung b×nh céng.

-  Tæng thu nhËp trung b×nh cña vïng.


D -  Cñng cè (3’)

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ thùc hµnh cña HS.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp vµ ®äc tr­íc c¸c phÇn tiÕp theo.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

	Ngµy so¹n:
	
	
	
	TiÕt 64-65

	Ngµy gi¶ng:
	7A: 
	7B: 
	7C: 
	7D: 


Bµi thùc hµnh sè 10

bµi thùc hµnh tæng hîp
I -  Môc tiªu
1. KiÕn thøc

- Cñng cè l¹i cho HS c¸ch chØnh söa, chÐn thªm hµng, ®Þnh d¹ng v¨n b¶n, s¾p xÕp vµ läc d÷ liÖu.

- Cñng cè c¸ch t¹o biÓu ®å, tr×nh bµy trang in, sao chÐp vïng d÷ liÖu vµ di chuyÓn biÓu ®å.

2. Kü N¨ng

- Thùc hµnh thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng say häc hái. 

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh: Nghiªn cøu tr­íc bµi häc ë nhµ. 

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’)

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò

- KÕt hîp trong giê thùc hµnh. 

C. Bµi míi (40’)

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	GV: Yªu cÇu HS më m¸y tÝnh, khëi ®éng Excel vµ më b¶ng tÝnh Baitap2.

? §Ó cho tiªu ®Ò cña b¶ng “Thu nhËp b×nh qu©n theo ®Çu ng­êi” ra gi÷a ta lµm ntn?

? §Ó chän mµu cho ch÷ ta lµm ntn?

? Nªu thao t¸c chÌn thªm 1 hµng.

GV: Yªu cÇu HS tr×nh bµy gièng mÉu h×nh 123.

? §Ó s¾p xÕp tªn x· víi thø tù a, b, c ta lµm ntn?

? §Ó s¾p xÕp thu nhËp b×nh qu©n vÒ n«ng nghiÖp víi thø tù gi¶m dÇn ta lµm ntn?

? §Ó läc d÷ liÖu trong trang tÝnh ta lµm ntn?

? Em h·y thùc hiÖn thao t¸c läc d÷ liÖu lÊy 3 x· thu nhËp b×nh qu©n vÒ n«ng nghiÖp cao nhÊt.

? §Ó tho¸t khái chÕ ®é läc ta lµm ntn?

GV : Yªu cÇu HS l­u l¹i trang tÝnh víi tªn Thongke.

GV: Yªu cÇu HS më Baitap2 ®· l­u trong m¸y.

? §Ó sao chÐp cét B vµ cét D sang vïng kh¸c ta lµm ntn?

? §Ó vÏ biÓu ®å ta sö dông nót lÖnh nµo ?

? Em h·y thùc hiÖn thao t¸c sao chÐp hµng d÷ liÖu sang vïng kh¸c.

GV: yªu cÇu HS vÏ biÓu ®å nh­ mÉu h×nh 125.

? §Ó di chuyÓn biÓu ®å ta lµm ntn?

GV : Yªu cÇu HS di chuyÓn biÓu ®å.

? §Ó xem tr­íc khi in ta lµm ntn ?

GV : Gi¸m s¸t viÖc thùc hµnh cña HS, h­íng dÉn c¸c em khi cÇn thiÕt.
	HS: Më m¸y, khëi ®éng Excel vµ më b¶ng tÝnh Baitap2. 

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Nhí l¹i kiÕm thøc lý thuyÕt vµ tr¶ lêi.

HS: Suy nghÜ tr¶ lêi.

HS: Tr¶ lêi.

HS: Thùc hµnh theo yªu cÇu cña GV.

HS: Tr¶ lêi.

HS: Thùc hiÖn thao t¸c l­u trang tÝnh.

HS: Më b¶ng tÝnh Baitap2.

HS: Tr¶ lêi.

HS: Tr¶ lêi. (Chart Wizard).

HS: Thùc hiÖn thao t¸c.

HS: Thùc hiÖn thao t¸c vÏ biÓu ®å.

HS: Tr¶ lêi.

HS: Thùc hiÖn di chuyÓn biÓu ®å theo yªu cÇu.

HS: Sö dông Print Preview.

HS: Thùc hµnh.
	c) ChØnh söa vµ chÌn thªm hµng

-   ChØnh söa

-  ChÌn hµng

d) S¾p xÕp c¸c x· 

- Theo tªn x· víi thø tù a, b, c.

- S¾p xÕp gi¶m dÇn.

e) Läc d÷ liÖu

Data -> Filter -> AutoFilter -> Chän Top 10. XHHT, chän Top 3 -> OK.

3. Bµi tËp 3

T¹o biÓu ®å vµ tr×nh bµy trang in.

a) Sao chÐp cét vµ vÏ biÓu ®å

b) Sao chÐp hµng vµ vÏ biÓu ®å

c) Di chuyÓn biÓu ®å vµ tr×nh bµy trang in

d) Xem tr­íc khi in


D -  Cñng cè (3’)

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ thùc hµnh cña HS.

- NhËn xÐt giê häc, ý thøc lµm bµi vµ kÕt qu¶ bµi lµm cña HS. 

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp chuÈn bÞ cho bµi kiÓm tra thùc hµnh.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

- Gi¸o viªn cÇn qu¶n lý qu¸ tr×nh thùc hµnh m¸y cña häc sinh.

	Ngµy so¹n:
	
	
	
	TiÕt 66

	Ngµy gi¶ng:
	7A: 
	7B: 
	7C: 
	7D: 


kiÓm tra thùc hµnh
I -  Môc tiªu
1. KiÕn thøc

- KiÓm tr viÖc n¾m b¾t kiÕn thøc thùc hµnh cña häc sinh vÒ tr×nh bµy, ®Þnh d¹ng, s dông c«ng thøc tÝnh to¸n, vÏ biÓu då, s¾p xÕp vµ läc d÷ liÖu.

2. Kü N¨ng

- Cã kÜ n¨ng t­ duy, vËn dông kiÕn thøc vµo thùc hµnh.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, trung thùc khi lµm bµi. 

II -  ChuÈn bÞ

1. Gi¸o viªn: §Ò bµi kiÓm tra, Phßng m¸y.

2. Häc sinh: KiÕn thøc ®· häc. 

III -  Ph­¬ng ph¸p
- Ho¹t ®éng c¸ nh©n.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’ )

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: ®ñ


B. KiÓm ra bµi cò ( kiÓm tra thùc hµnh )

C. Bµi míi (40’)

Cho b¶ng tÝnh

	Stt
	A
	B
	C
	D
	E
	F

	1
	Líp
	Gái
	Kh¸
	T.b×nh
	YÕu
	KÐm

	2
	6A
	5
	15
	9
	0
	?

	3
	6B
	4
	11
	5
	0
	?

	4
	6C
	6
	16
	5
	0
	?

	5
	6D
	9
	20
	4
	0
	?

	6
	6E
	5
	16
	8
	0
	?

	7
	7A
	4
	19
	8
	3
	?

	8
	7B
	2
	18
	10
	5
	?

	9
	7C
	1
	14
	15
	1
	?

	10
	7D
	10
	20
	4
	0
	?

	11
	7E
	15
	21
	6
	0
	?


Yªu cÇu

1. Khëi ®éng Excel, nhËp d÷ liÖu vµ tr×nh bµy theo mÉu trªn.

2. Sö dông hµm ®Ó tÝnh cét Tæng céng.

3. T¹o biÓu ®å cét trªn c¬ së d÷ liÖu cña khèi A2:E12.

4. Läc ra líp cã sè häc sinh giái nhiÒu nhÊt.

§¸p ¸n + BiÓu ®iÓm

	C©u
	§¸p ¸n
	BiÓu ®iÓm

	1
	Khëi ®éng Excel, nhËp d÷ liÖu vµ tr×nh bµy theo mÉu 
	2

	2
	Trong cét F nhËp c«ng thøc
	5

	
	=SUM(B2:E2)
	0.5

	
	=SUM(B3:E3)
	0.5

	
	=SUM(B4:E4)
	0.5

	
	=SUM(B5:E5)
	0.5

	
	=SUM(B6:E6)
	0.5

	
	=SUM(B7:E7)
	0.5

	
	=SUM(B8:E8)
	0.5

	
	=SUM(B9:E9)
	0.5

	
	=SUM(B10:E10)
	0.5

	
	=SUM(B11:E11)
	0.5

	3
	T¹o biÓu ®å ®óng (Cã gi¶i thÝch trôc ®øng, trôc ngang)
	1

	4
	- Läc ®­îc líp cã sè häc sinh giái nhiÒu nhÊt
	1

	
	- Tr×nh bµy ®Ñp, chÝnh x¸c, nhanh
	1


D -  Cñng cè ( 3’ )

- Gi¸o viªn ®Õn tõng m¸y kiÓm tra kÕt qu¶ kiÓm tra cña HS.

- NhËn xÐt giê kiÓm tra, ý thøc lµm bµi, kÕt qu¶ bµi lµm vµ cho ®iÓm. 

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ nhµ chuÈn bÞ cho bµi «n tËp cuèi n¨m.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m bµi tèt.

- Thêi gian ®¶m b¶o

- Häc sinh thùc hµnh nghiªm tóc vµ thùc hµnh tèt trªn m¸y tÝnh

- Mét sè häc sinh ch­a thùc sù chó träng trong viÖc tr×nh bµy.

	Ngµy so¹n:
	
	
	
	TiÕt 67-68

	Ngµy gi¶ng:
	7A: 
	7B: 
	7C: 
	7D: 


«n tËp
I -  Môc tiªu
1. KiÕn thøc

- Tæng hîp kiÕn thøc vÒ ®Þnh d¹ng trang tÝnh, tr×nh bµy vµ in trang tÝnh.

- Cñng cè c¸ch s¾p xÕp vµ läc d÷ liÖu, c¸ch t¹o biÓu ®å minh ho¹ d÷ liÖu.

2. Kü N¨ng

- H×nh thµnh kÜ n¨ng t­ duy tæng hîp, thµnh th¹o c¸c thao t¸c.

3. Th¸i ®é

- H×nh thµnh th¸i ®é häc tËp nghiªm tóc, h¨ng h¸i ph¸t biÓu ý kiÕn x©y dùng bµi. 

II -  ChuÈn bÞ

1. Gi¸o viªn: Gi¸o tr×nh, Phßng m¸y.

2. Häc sinh. C¸c kiÕn thøc ®· häc.

III -  Ph­¬ng ph¸p
- ThuyÕt tr×nh vµ thùc hµnh trªn m¸y.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’)

	7A: ®ñ
	7b: ®ñ
	7C: ®ñ
	7®: v1


B. KiÓm ra bµi cò

- KÕt hîp trong giê «n tËp. 

C. Bµi míi (40’)

	Ho¹t ®éng cña GV
	H§ cña HS
	Ghi b¶ng

	? §Ó thay ®æi ph«ng ch÷ ta lµm ntn?

? §Ó thay ®æi cì ch÷ ta lµm ntn?

? §Ó thay ®æi kiªu ch÷ ta lµm ntn?

? Nªu c¸ch chän mµu cho ph«ng?

? C¸ch c¨n lÒ trong « tÝnh?

? §Ó t¨ng, gi¶m sè ch÷ sè thËp ph©n ta lµm ntn?

? Tr×nh bµy c¸ch t« mµu nÒn vµ ket ®­êng biªn trong trang tÝnh.

? Tr×nh bµy c¸ch ®Æt lÒ h­íng giÊy in.

? §Ó in trang tÝnh ta lµm ntn?

? Tr×nh bµy c¸ch s¾p xÕp d÷ liÖu trong trang tÝnh?

? §Ó läc d÷ liÖu trong trang tÝnh ta lµm ntn?

? Sau khi läc ®Ó hiÓn thÞ l¹i d÷ liÖu ta lµm ntn?

? Nªu c¸ch tho¸t khái chÕ ®ä läc?

? Em h·y tr×nh bµy c¸ch vÏ biÓu ®å biÓu diÔn d÷ liÖu trªn trang tÝnh ?

GV : Cho HS thùc hµnh l¹i tÊt c¶ c¸c thao t¸c ®· häc. 
	HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.

HS: Tr¶ lêi.
	1. §Þnh d¹ng trang tÝnh

a) Thay ®æi ph«ng ch÷

-  §¸nh dÊu «.

-  Nh¸y mòi tªn ë « Font vµ chän ph«ng thÝch hîp.

b) Thay ®æi cì ch÷

-  §¸nh dÊu «.

-  Nh¸y mòi tªn ë « cì ch÷ vµ chän cì thÝch hîp.

c) Thay ®æi kiÓu ch÷

-  §¸nh dÊu «.

-   Nh¸y vµo B, I, U

d) Chän mµu ph«ng

-  §¸nh dÊu «.

-  Nh¸y mòi tªn ë nót ch÷ A

e) C¨n lÒ trong « tÝnh

- §¸nh dÊu «.

- Nh¸y chän c¸c nót lÖnh c¨n lÒ.

f) T¨ng, gi¶m sè ch÷ sè thËp ph©n

- Nh¸y chän «.

- Sö dông hai nót lÖnh t¨ng, gi¶m ch÷ sè thËp ph©n.

g) T« mµu nÒn vµ kÎ ®­êng biªn

 T« mµu nÒn

- Nh¸y chän «.

- Sö dông nót lÖnh Fill Color.

KÎ ®­êng biªn

- Chän «.

- Sö dông nót Border.

2. Tr×nh bµy vµ in trang tÝnh

- §Æt lÒ h­íng giÊy in

File -> Page Setup. XHHT, lùa chän h­íng giÊy vµ lÒ giÊy -> Ok.

-  In trang tÝnh

File -> Print.

3. S¾p xÕp vµ läc d÷ liÖu

a) S¾p xÕp d÷ liÖu

-  Chän « trong cét cÇn s¾p xÕp.

-  Nh¸y nót lÖnh s¾p xÕp t¨ng (hoÆc gi¶m).

b) Läc d÷ liÖu

- Chän « trong vïng cÇn läc.

- Data -> Filter -> AutoFilter

HiÓn thÞ l¹i d÷ liÖu

-  Data -> Filter -> Show All

Tho¸t khái chÕ ®é läc

-  Data -> Filter -> AutoFilter.

4. Tr×nh bµy d÷ liÖu b»ng biÓu ®å

-  Chän « trong vïng d÷ liÖu

-  Nh¸y nót Chart Wizard.

-  Nh¸y Next liªn tiÕp.

-  Nh¸y Finish khi Next mê ®i.

5. LuyÖn tËp

(¤n tËp c¸c thao t¸c ®· häc)


D -  Cñng cè (3’)

- Nh¾c l¹i tÊt c¶ c¸c thao t¸c ®· häc.

E -  H­íng dÉn häc ë nhµ (1’)

- H­íng dÉn HS vÒ nhµ «n tËp chuÈn bÞ cho bµi kiÓm tra cuèi n¨m.

V - Rót kinh nghiÖm

- Häc sinh c¬ b¶n n¾m ch¾c kiÕn thøc

- Mét sè häc sinh ch­a thËt sù chó ý trong qu¸ tr×nh «n tËp

- Thêi gian ®¶m b¶o

- Hs h¨ng h¸i ph¸t biÓu vµ x©y dùng bµi.

	Ngµy so¹n:
	17/4/2008
	
	
	TiÕt 69+ 70

	Ngµy gi¶ng:
	7A:  21/4
	7B:  21/4
	7C: 23/4
	7D: 23/4


kiÓm tra häc kú ii - phÇn thùc hµnh  
I -  Môc tiªu
1. KiÕn thøc

- KiÓm ta viÖc n¾m b¾t kiÕn thøc thùc hµnh cña HS vÒ ®Þnh d¹ng trang tÝnh, tr×nh bµy trang in, s¾p xÕp vµ läc d÷ liÖu, vÏ biÓu ®å.

2. Kü N¨ng

- Thµnh th¹o c¸c thao t¸c trªn.

3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, trung thùc trong giê kiÓm tra.

II -  ChuÈn bÞ

1. Gi¸o viªn: §Ò bµi, Phßng m¸y.

2. Häc sinh. C¸c kiÕn thøc ®· häc.

III -  Ph­¬ng ph¸p
- Thùc hµnh, ho¹t ®éng c¸ nh©n.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh (1’)

B. KiÓm ra bµi cò

C. Bµi míi

§Ò bµi

Cho b¶ng ®iÓm häc sinh:

B¶ng ®iÓm líp 7A

	STT
	Hä vµ tªn
	To¸n
	Ng÷ V¨n
	Tin Häc
	VËt LÝ
	§TB

	1
	NguyÔn Hoµ An
	8
	7
	8
	7
	?

	2
	Lª Th¸i Anh
	8
	5
	7
	8
	?

	3
	TrÇn Quèc B×nh
	8
	9
	9
	8
	?

	4
	Ph¹m Ngäc Mai
	9
	9
	10
	8
	?

	5
	Bïi Thu Hµ
	7
	6
	8
	5
	?

	6
	Chu ThÞ H­¬ng
	8
	8
	6
	8
	?

	7
	Bïi Mü Linh
	8
	9
	8
	7
	?

	8
	Vò ThÞ Mai
	7
	5
	5
	7
	?

	9
	Lª V¨n Quang
	3
	4
	6
	5
	?

	10
	TrÇn Thu Ph­¬ng
	5
	6
	7
	7
	?

	11
	Hµ Thanh Th­
	8
	7
	6
	8
	?

	12
	Ph¹m H¶i YÕn
	10
	8
	10
	9
	?


m) Khëi ®éng ch­¬ng tr×nh b¶ng tÝnh Excel vµ  Vietkey råi nhËp ®óng néi dung b¶ng trªn.            (1 ®iÓm)

n) TÝnh c¸c « trong cét §TB b»ng ®iÓm trung b×nh cña c¸c m«n häc.             (2 ®iÓm)

o) S¾p xÕp l¹i cét §TB theo thø tù ®iÓm t¨ng  dÇn.                                          (1 ®iÓm)

p) Dïng hµm Max t×m ra häc sinh cã §TB cao nhÊt.                                       (2 ®iÓm)

q) Läc ra häc sinh cã §TB lµ 8.0.                                                                     (2 ®iÓm)

r) NhËp l¹i b¶ng hÖ thèng d­íi vµ vÏ ®å thÞ thÝch hîp ®Ó m« t¶ tØ lÖ lùc häc cña tõng lo¹i häc sinh so víi tæng thÓ.                                                                         (2 ®iÓm)

	Lùc häc
	Tæng céng

	Giái
	4

	Kh¸
	5

	Trung b×nh
	2

	YÕu
	1


§¸p ¸n + BiÓu ®iÓm

	C©u
	§¸p ¸n
	BiÓu ®iÓm

	a
	Khëi ®éng Excel vµ Vietkey, nhËp ®óng d÷ liÖu
	2

	b
	TÝnh c¸c « trong cét §TB
	

	
	G2 = AVERAGE(C2:F2)
	0.25

	
	G3 = AVERAGE(C3:F3)
	0.25

	
	G4 = AVERAGE(C4:F4)
	0.25

	
	G5 = AVERAGE(C5:F5)
	0.25

	
	G6 = AVERAGE(C6:F6)
	0.25

	
	G7 = AVERAGE(C7:F7)
	0.25

	
	G8 = AVERAGE(C8:F8)
	0.25

	
	G9 = AVERAGE(C9:F9)
	0.25

	
	G10 = AVERAGE(C10:F10)
	0.25

	
	G11 = AVERAGE(C11:F11)
	0.25

	
	G12 = AVERAGE(C12:F12)
	0.25

	
	G13 = AVERAGE(C13:F13)
	0.25

	c
	Nh¸y 1 « trong cét §TB vµ nh¸y nót s¾p xÕp t¨ng dÇn
	1

	d
	=MAX(G2:G13)
	1

	e
	Chän «, Data -> Filter -> AutoFilter. Chän 8.0
	1

	f
	VÏ ®óng biÓu ®å thÝch hîp
	1


D -  Cñng cè

- §Õn tõng m¸y nhËn xÐt ­, nh­îc ®iÓm, söa sai cho c¸c em.

-  NhËn xÐt vÒ ý thøc lµm bµi cña häc sinh vµ cho ®iÓm.

E -  H­íng dÉn häc ë nhµ

- H­íng dÉn HS «n tËp chuÈn bÞ cho bµi kiÓm tra lý thuyÕt cuèi n¨m.

TiÕt 70

kiÓm tra häc kú ii - phÇn lý thuyÕt  
I -  Môc tiªu
1. KiÕn thøc

- KiÓm ta viÖc n¾m b¾t kiÕn thøc lý thuyÕt cña HS vÒ tÊt c¶ c¸c phÇn ®· häc cña häc kú II.

2. Kü N¨ng

- RÌn cho häc sinh kü n¨ng trong suy nghÜ, t­ duy, lµm chñ t×nh huèng.
3. Th¸i ®é

- H×nh thµnh th¸i ®é nghiªm tóc, trung thùc trong giê kiÓn tra.

II -  ChuÈn bÞ

1. Gi¸o viªn: §Ò bµi.

2. Häc sinh. C¸c kiÕn thøc ®· häc.

III -  Ph­¬ng ph¸p
- ViÕt trªn giÊy. Ho¹t ®éng c¸ nh©n.

IV -  TiÕn tr×nh bµi gi¶ng
A. æn ®Þnh

B. KiÓm ra bµi cò

C. Bµi míi

§Ò bµi

PhÇn I: Tr¾c nghiÖm: Chän c©u tr¶ lêi ®óng trong c¸c c©u sau ®©y:

C©u 1: c¸c nót lÖnh  [image: image64.png]


 n»m trªn thanh nµo ?

a.Thanh tiªu ®Ò

b.Thanh thùc ®¬n

c.Thanh c«ng cô

d.Thanh tr¹nh th¸i

C©u 2: §Ó l­u trang tÝnh ta ph¶i sö dông lÖnh

a.File -> New

b.File ->  Exit

c.Fle -> Open

d.File -> Save

C©u 3: §Ó ng¾t trang tinh ta sö dung lÖnh

a.Frint PreView

b.Page Break Preview

c.Print

d.C¶ a, b, c ®Òu sai

C©u 4: Muèn ®Æt lÒ trªn cña trang tÝnh th× trong hép tho¹i PageSetup chän «

a.Top

b.Left

c.Bottom

d.Right

C©u 5: Nót lÖnh nµo dïng ®Ó s¾p xÕp theo thø tô t¨ng dÇn ?

a.[image: image65.png]




b.[image: image66.png]%l




c.[image: image67.png]




d.c¶ a, b, c ®Òu sai

C©u 6: §Ó gi¶m ch÷ sè thËp ph©nta sö dông lÖnh:

a.[image: image68.png]




b.[image: image69.png]



c.[image: image70.png]




d.c¶ a, b, c ®Òu sai

C©u 7: BiÓu ®å cét dïng ®Ó:

a.So S¸nh d÷ liÖu vµ dù ®o¸n xu thÕ cña t¨ng hay gi¶m cña d÷ liÖu.

b.M« t¶ tØ lÖ cña d÷ liÖu so víi tæng tæng thÓ.

c.So s¸nh d÷ liÖu trong nhiÒu cét.

d.C¶ a, b, c ®Òu sai.

C©u 8: ®Ó läc d÷ liÖu ta sö dông lÖnh

a.Data -> Filter -> AutoFilter

b.Data -> Filter -> Show All

c.Data -> Sort

d.C¶ a, b, c ®Òu sai

C©u 9: ®Ó vÏ biÓu ®å ta dïng nót lÖnh:

a.[image: image71.png]




b.[image: image72.png]



c.[image: image73.png]




d.[image: image74.png]



C©u 10: §Ó in trang tÝnh ta sö dông nót lÖnh

a.[image: image75.png]




b.[image: image76.png]



c.[image: image77.png]
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PhÇn II : Tù LuËn ( 5 ®iÓm )

C©u 1( 2,5 ®iÓm). Gi¶ Sö « A1 cã nÒn mµu xanh vµ ch÷ mµu ®á. ¤ A3 cã nÒn mµu tr¾ng vµ ch÷ mµu ®en. em h·y nªu c¸ch sao chÐp néi dung « A1 vµo i« A3 vµ thö dù ®o¸n xem sau khi sao chÐp « A3 cã nÒn vµ ph«ng ch÷ mµu g× ?

C©u 2 (2.5 ®iÓm). Em h·y nªu c¸c thao t¸c ®Þnh d¹ng trang tÝnh?

§¸p ¸n + BiÓu ®iÓm

	C©u
	§¸p ¸n
	BiÓu ®iÓm

	Tr¾c nghiÖm

	1
	C
	0,5

	2
	D
	0,5

	3
	B
	0,5

	4
	A
	0,5

	5
	C
	0,5

	6
	B
	0,5

	7
	C
	0,5

	8
	A
	0,5

	9
	D
	0,5

	10
	B
	0,5

	Tù luËn

	1
	- Sö dông 2 nót lÖnh Copy vµ Paste 

- ¤ A3 cã nÒn xanh, ch÷ ®á
	1,5

1

	2
	· §Þnh d¹ng ph«ng ch÷, cì ch÷ vµ kiÓu ch÷

· Chon mµu ph«ng

· C¨n lÒ trong « tÝnh

· T¨ng hoÆc gi¶m sè ch÷ s« thËp ph©n

· T« mµu nÒn vµ kÎ ®­êng biªn cña c¸c « tÝnh
	0,5

0,5

0,5

0,5

0,5


D -  Cñng cè

- §Õn tõng m¸y nhËn xÐt ­u, nh­îc ®iÓm, söa sai cho c¸c em.

-  NhËn xÐt vÒ ý thøc lµm bµi cña häc sinh vµ cho ®iÓm.

E -  H­íng dÉn häc ë nhµ

- H­íng dÉn HS «n tËp chuÈn bÞ cho bµi kiÓm tra lý thuyÕt cuèi n¨m.
* KÕt qu¶

	Líp
	Giái
	Kh¸
	TB
	YÕu

	7A
	
	
	
	

	7B
	
	
	
	

	7C
	
	
	
	

	7D
	
	
	
	


-----------------------------------------------------------------------------------
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